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1
Product Overview

Introduction
The Xerox® Versant® 80 Press is a full color/black and white, auto-duplex copier/printer
that operates at a speed of 80 prints per minute (when printing on 8.5 x 11 inch/A4
paper).

Base Configuration

The system base system configuration consists of the following components:

1. Bypass Tray

Other optional feeding devices are available.

2. Color Press
3. Offset Catch Tray

Other optional finishing devices are available.
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4. Print Server (not shown)

Choice of one of three print servers is available.

Print Server Overview
The print server networked with your press accepts, processes, and manages document
files for job submission to the press.

One of the following print servers may be used with your press:

• Xerox® FreeFlow® Print Server
• Xerox® EX 80 Print Server, Powered by Fiery®

• Xerox® EX-P 80 Print Server, Powered by Fiery®

Note
For detailed information on your specific print server, refer to the customer
documentation that was delivered with it. Documentation may also be downloaded
from www.xerox.com by searching for the press and selecting the Support link.

Press Components

Press Components

1 Bypass Tray

The Bypass Tray is also called Tray 5 or Multisheet Inserter; the tray accommodates
all types of stock in various sizes and weight ranges.

Note
The mounting location for the Bypass tray varies when optional feeding devices are
added to the machine configuration.
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2 User Interface (UI)

The User Interface (UI) consists of the touch screen and control panel with the buttons
and keypad.

3 Duplex Automatic Document Feeder (DADF)

Automatically feeds 1- and 2-sided original documents. A maximum of 250 two-sided
documents can be scanned at one time.

4 Offset Catch Tray (OCT)

This tray receives the completed print job. Output print sheets can be offset for easy
separation. The maximum capacity of the OCT is determined by the tray sensor as well
as stock weight, but is approximately 500 sheets of 24 lb. (90 gsm) paper.

Note
Offsetting per set in the stack continues up to the point when the tray reaches the
maximum height or weight allowed.

5 Dry Ink/Toner Waste Bottle Door

Open this door to access the waste bottle when replacement of the bottle is required.

6 Trays 1-3

Trays 1, 2, and 3 accommodate a variety of paper sizes and weights; refer to the
Technical Specifications chapter for detailed information.

7 Front Door

Open this door to clear paper jams and to replace various Customer Replaceable Units
(CRUs).

8 Dry Ink/Toner Cover

Open this cover to access and replace the dry ink/toner cartridges.

Locating the Press Serial Number

The press serial number can be accessed from either the press User Interface or from
the serial number plate which is located on the inside frame of Tray 1.
1. Press the Machine Status button on the User Interface.
2. From the Machine Status screen, ensure that the Device Information tab is displayed.

The press serial number is displayed under Device Serial Information near the bottom
of the screen.

3. If there is a loss of power and it is not possible to access the Machine Status screen,
the press serial number can also be found on the inside frame of the press near the
Paper Tray 1 drawer:
a) At the press, fully open Tray 1.
b) At the left of the tray, on the press frame, locate the plate with the serial number

(SER#).
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User Interface (UI)

1 Touch Screen

Directly touch the screen to select and set features. Displays instructional and
informational messages, fault clearance procedures and general press information.

2 Home button

Press this button to display the main window. Provides access to features such as Copy,
E-Mail, and Network Scanning, just to name a few features. Other features may be
available depending on your marketplace.

3 Services

This button lights when the main power is on.

4 Job Status button

Use to check the progress of active jobs and detailed information about completed
jobs or pending jobs. This area also allows you to delete a job (cancel printing or copying)
and pause jobs.

5 Machine Status button

Use to access the Tools feature, check the press configuration, the software version,
the press billing meters and counter information, and to access and print job history
or error reports.

6 Log In/Out button

Use to log in and out of Administrator mode or Authentication mode with user ID and
password.
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7 Energy / Power Saver button

Use this button if the press has been inactive and the touch screen is dark (system is
in Energy Saver mode). This button manually exits the system from Energy Saver mode;
it does not place the press in Energy Save mode.

8 Clear All button

Use this button to return all selections to the same state as when the press was powered
on. Press once to clear a current entry. Press twice to return to default settings.

9 Stop button

Press to stop and pause the print or copy job in progress.

10 Start button

Use this button to perform certain functions, such as scanning/copying a document or
printing a selected report from the print engine. This button is also used by the Customer
Service Engineer (CSE) during diagnostic routine procedures.

11 Interrupt button

Use this button to suspend a copy or print job in progress and have the machine stop
to process another job. During the Interrupt mode, the Interrupt button lights. Pressing
the Interrupt button again exits the Interrupt mode and resumes the suspended job.

12 Numeric Keypad

Use to enter alphanumeric characters. The C (Cancel) Entry cancels the previous entry
made on the numeric keypad.

13 Language button

Use to select a different language for the touch screen options.

14 Help button

Displays the Help System; this feature may not be available in all marketplaces.

Features

Logon

There are two logon levels:

• Guest/Operator: This is the default logon user. You are automatically logged on as
Guest.
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• Administrator: This logon level is required to customize the system and network
defaults for your press and to customize particular print jobs by setting, or changing
parameters for certain features. Press the Guest button (or the Log in button on the
Control Panel) to access the Login screen.

Note
Refer to the System Administration Guide for more information on the Administrator
features.

Language

Language Feature
Note
The number of languages available on your system depends on what was installed during
the initial installation process.

Selecting a particular Language button immediately changes the language. No
confirmation is required.

Changing the Language
1. Press the Language button on the press User Interface

The Language window displays on the touch screen.

2. Choose one of the following:

• Select the desired language from the list, and select Save. The language on the
screen changes to the new language and closes the Language window.

• Select the Cancel button to return to the main screen.
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Energy (Power) Saver Mode

Energy (Power) Saver Mode Overview

The Energy (Power) Saver feature allows the press to enter a reduced power consumption
mode when all print jobs have completed and there are no jobs currently processing.
There are two energy saving modes: Low Power and Sleep.

By default, the press automatically enters the Low Power mode after 1 minute of
inactivity. After 1 minute of inactivity, the press then enters Sleep mode. These time
intervals for both modes can be changed by the system administrator.

Here are two examples:

• If Low Power Mode is set to 15 minutes and Sleep Mode is set to 60 minutes, Sleep
Mode activates after 60 minutes of total inactivity, not 60 minutes after Low Power
Mode begins. In other words, Sleep Mode activates 45 minutes after the Low Power
Mode begins.

• If Low Power Mode is set to 15 minutes and Sleep Mode is set to 20 minutes, Sleep
Mode activates 5 minutes after Low Power Mode begins.

Low Power Mode

In this mode, the power to the User Interface (UI) and fuser unit is lowered to save
power. The display goes out and the Energy Saver button on the UI lights. To use the
press, press the Energy Saver button. The Energy Saver button is no longer lit, indicating
that the Energy Saver feature is canceled.

Sleep Mode

In this mode, the power is lowered more than in the Low Power mode. The display goes
out and the Energy Saver button on the UI lights. To use the press, press the Energy
Saver button. The Energy Saver button is no longer lit, indicating that the Energy Saver
feature is canceled.

Exiting Energy (Power) Saver Mode

The press exits Energy (Power) Saver mode by doing one of the following:

• Pressing the Power / Energy Saver button on the press UI,
• Receiving print data for an incoming job to be printed, or
• Programming and performing a copy or scan job.
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Power On/Off

The Power Switches

There are three power switches involved with the press:

• The Breaker switch located at the rear of the press. Initially check to make sure this
switch is set to On when the press is shipped.

• The Main Power switch located inside the Front Door. This switch is used mainly by
the Xerox Service Representative when servicing the press. In rare problem solving
cases, you may be directed to power off the press with this switch.

• The Power On/Off button located on the top of the press near the Document Feeder.
This button is the primary way for you to switch on or off the press. It is used by the
operator as workflow requires.

Use the Power On/Off button to power ON or power OFF the press.

Important
Always use the Power On/Off button first, and then power off the Main Power Switch.

Power On/Off the Press

Power On the Press
1. Check that the Main Power switch behind the Front Door is On.
2. Press the Power On/Off button on top of the press to the ON position.
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The Ready Indicator light displays green.
A screen message advises of a short wait while the fuser warms up and the press runs
a system check. You can set features for a job during this time and the printing process
will start automatically when the press is ready.

Power Off the Press
Important
Always power off the Power Switch first and then power off the Main Power Switch.

1. Press the Power On/Off button on the top of the press to Off.
Wait until the lights on UI stop blinking, as this allows the fuser to begin cooling.

2. Switch Off the Main Power switch behind the Front Door.

Note
Allow the press to remain off for a minimum of 10 seconds before switching on the
power again.

Optional Feeding and Finishing Devices

Feeding and Finishing Devices

Available with your press is a variety of optional feeding and finishing devices. These
devices are briefly introduced on the following pages. Refer to the sections at the end
of this guide for specific information on each feeder or finisher.

Feeding Devices

High Capacity Feeder (HCF), 1 Tray

The 1-tray High Capacity Feeder (HCF), also known as Tray 6, provides a 2,000-sheet,
letter-size (8.5 x 11 in./A4) paper source.

Note
Only letter-size (8.5 x 11 in.)/A4 paper, Long Edge Feed (LEF) can be used in this tray.
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Oversized High Capacity Feeder (OHCF), 1 or 2 Trays

The Oversized High Capacity Feeder (OHCF) is available in a 1-tray or 2-tray option;
the OHCF is also known as Trays 6 and 7. The OHCF feeds a variety of stock sizes,
including standard and oversized stock up to 13 x 19.2 in./330.2 x 488 mm and weighing
between 52 gsm and 350 gsm. Each tray holds 2,000 sheets.

• 1-tray OHCF (with storage cabinet above the tray; shown with Bypass Tray installed)

• 2-tray OHCF (shown with Bypass Tray installed)
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Finishing Devices

Optional Cooling Fan Kit for the Offset Catch Tray (OCT)

When attached to the OCT, the Cooling Fan prevents blocking (sticking together) of
the printed/copied output.

The OCT Cooling Fan can be adjusted for the following paper weights:

1. OFF for all paper types weighing 60-105 gsm.
2. One-quarter turn for Coated paper weighing 106-135 gsm.
3. Mid/halfway position turn for Coated paper weighing 136-186 gsm.
4. ON 100% for Coated paper weighing 221-300 gsm.

1-11Xerox® Versant® 80 Press
User Guide

Product Overview



Interface Module

The Interface Module provides communication, an aligned paper path between the
print engine and the attached finishing device, and the decurling of the paper as it
exits the print engine.

Important
The Interface Module is required with many of the finishing devices; this depends on
the system configuration and which finishing devices are attached.

Interface Cooling Module

The Interface Cooling Module provides the same functions as the Interface Module.
In additional to these functions, the Interface Cooling Module also provides the added
feature of cooling the printed media as it passes through the paper path by using
additional fans and associated duct work. The module is also equipped with an internal
spectrophotometer.

Important
The Interface Cooling Module is required with many of the finishing devices; this
depends on the system configuration and which finishing devices are attached.

The following finishing devices require either the Interface Module or the Interface
Cooling Module:

• GBC® AdvancedPunch™

• High Capacity Stacker (HCS)
• Standard Finisher
• Booklet Maker Finisher
• Standard Finisher Plus
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Business Ready (BR) Finisher (with or without Booklet Maker)

The Business Ready (BR) Finisher adds several professional-level finishing options to
the press while requiring minimal additional space for the finisher. The finisher is
available with or without an optional booklet maker.

• BR Finisher without Booklet Maker

• BR Finisher with the optional Booklet Maker

Tip
The BR Finisher (with or without Booklet Maker) attaches directly to the press and does
not require the Interface Module/Interface Cooling Module.
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GBC® AdvancedPunch™

The GBC AdvancedPunch may be attached to a variety of optional finishing accessories.
It provides another level of finishing by allowing you to punch holes in 8.5 x 11 in./A4
documents that support a variety of binding styles. Punch types include 19-hole to a
maximum of 32-hole for 8.5 x 11 in. media. A4 media supports punch types 21-hole
to a maximum of 47-hole.

Information on this device can be found on the customer documentation CD that came
with the accessory, or documentation can be downloaded from www.xerox.com.

High Capacity Stacker (HCS)

The High Capacity Stacker (HCS) is an optional finishing device that provides production
stacking and offsetting capabilities of up to 5,000 sheets to a cart in the Stacker
Tray/Cart. Shorter runs of up to 500 sheets can be sent to the stacker Top Tray.
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Standard Finisher (with or without optional C/Z Folder)

This finisher provides a wide range of finishing/folding options. It includes a basic inline
punch, stapler, built-in decurler, and a post-process inserter/interposer (Tray 8/T1). An
optional C/Z Folder also is available.

Booklet Maker Finisher (with or without optional C/Z Folder)

This finisher provides the same finishing/folding capabilities as the Standard Finisher.
Additionally, this finisher includes a booklet unit with saddle-stitching and bifold finishing
capabilities. An optional C/Z Folder also is available.

Standard Finisher Plus (with or without optional C/Z Folder)

The Standard Finisher Plus includes the same features and functions as the Standard
Finisher but also serves as an interface to transfer paper between the print engine and
any third-party, Document Finishing Architecture (DFA) device attached to the press.
An optional C/Z Folder also is available.

Third-party Finishing Devices

Additional third-party, Document Finishing Architecture (DFA) devices are also available
for your press. Information on these DFA devices can be obtained by contacting your
Xerox sales representative.
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2
Where to Find Help

Help on the Xerox Web Site
For technical product support, Xerox supplies, customer documentation, and answers to
frequently-asked questions, go to www.xerox.com. You will find the latest documentation
and the knowledge base under Support & Drivers. Use the Contact link for specific
contact information/telephone numbers in your area.

Note
Be sure to periodically check this website for the latest information on your product.

It may be helpful to know your press serial number before calling for support. The press
serial number is shown on the Device Information tab: Machine Status  > Device
Information .

Print Server Customer Documentation
• The FreeFlow Print Server features are documented in the Online Help system from

the Help menu shown on the main print server window. Additional FreeFlow Print
Server user documentation can be found at www.xerox.com.

• The EFI Print Server Help menu on the Command WorkStation window is designed
to provide information on specific work flows when using the Command WorkStation.
Additional user documentation supplied by EFI is available to you from www.xerox.com
under the Support and Drivers link.
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3
Paper and Media

Overview
Before loading paper, consider the following:

• The press supports the ability to pull different stock sizes and paper types from various
trays and assemble them as part of a single job. To select multiple paper trays and
insert different papers within one job, program this custom job at the print server
using features such as special pages.

• The press supports Automatic Tray Switching, which allows a job to switch
automatically from an empty tray to a full tray containing the same size paper,
orientation and stock type. Refer to the System Administrator Guide for how to enable
this feature and prioritize the order of trays to search on and use.

Loading Media in Trays 1, 2, and 3

Information About Loading Media in Trays 1, 2, and 3

Trays 1, 2, and 3 are identical. Each tray has a capacity of 550 sheets of 20 lb./75 gsm
paper. Stock can be Long Edge Feed (LEF) or Short Edge Feed (SEF), landscape or portrait.

Note
Each feeder tray has a stock loading label. When loading media into the tray, refer to
the labels on the inside panel of the feeder tray for the correct orientation of that stock
type.

3-1Xerox® Versant® 80 Press
User Guide



Loading Paper in Trays 1, 2, and 3
Note
A paper jam may occur if a tray is opened while it is being used to feed stock.

1. Select the appropriate paper stock for your print or copy job.
2. Pull out the tray slowly until it stops.
3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
5. Load and align the edge of the paper against the left edge of the tray.

Paper can be loaded either in the LEF/portrait or SEF/landscape direction.

6. Adjust the paper guides by pressing in the guide release and carefully moving the
Edge Guide until it lightly touches the edge of the material in the tray.

Do not load materials above the MAX line located on the rear Edge Guide.

7. Gently push in the tray until it comes to a stop.
If enabled by your System Administrator, the Paper Tray settings/Tray Properties
window may be displayed on the UI. You can view and set stock attributes and verify
trays are assigned with the correct stock.

8. From the Paper Tray settings/Tray Properties window, choose one of the following:

• No changes were made to the paper tray; select Confirm to close the window.
• Changes were made to the paper tray; go to the next step.

9. Select the Change Settings button.
a) Make the desired selections for Paper Type/Paper Weight, Paper Size, and Paper

Color.
b) If necessary, make the desired changes to paper curl and alignment adjustment.
c) Select Save until you are returned to the Paper Tray settings/Tray Properties

window.
d) Select Confirm or OK to save the information and close the Paper Tray

settings/Tray Properties window.
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Loading Tab Stock in Trays 1, 2, and 3

Refer to the following tips before loading tab stock in the tray:

• You can load either single straight collated or single reverse collated tab stock.
• For network print jobs, refer to your print server customer documentation for

instructions on loading tab stock into a tray.
• If a jam occurs while running tabbed sets, cancel the job and start again.

1. Pull out the tray slowly until it stops.
2. Fan the tab stock before loading into the tray.
3. Load the tab stock LEF (portrait) and align the straight edge of the tab stock against

the left edge of the tray (tabs to the right or trailing edge). For single straight collated
tabs, the first blank tab cutout in the stack will be toward the rear of the tray. For
single reverse collated tabs, the first blank tab cutout in the stack will be toward the
front of the tray.

Note
Tab stock is loaded so the straight edge of the stock is in the feed direction. Also, you
can only load the tab stock LEF.

4. Adjust the paper guides by pressing in the guide release and carefully moving the
Edge Guide until it lightly touches the edge of the stock in the tray.

Do not load materials above the MAX line located on the rear Edge Guide.

5. Gently push in the tray until it comes to a stop.
6. If the Paper Tray settings/Tray Properties window displays on the UI, confirm the

correct tray to which it is printing and other information, including size, type (precut
tab), and, if necessary, paper curl and/or alignment option.

7. Select Confirm or OK to save the information and close the Paper Tray settings/Tray
Properties window.

Loading Transparencies in Trays 1, 2, and 3

Read these tips before using transparencies:

• Do not use transparencies with the white side strip (either permanent or removable).
• Do not mix paper and transparencies in a tray. Jams may occur.
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• Do not load more than 100 transparencies in a paper tray at one time.
• Load 8.5 x 11 in (A4) transparencies long edge feed only (landscape).

1. Select the appropriate paper stock for your print job.
2. Pull out the tray slowly until it stops.
3. Fan the transparencies to stop them from sticking together before loading into the

tray.
4. Load a small stack of paper into the tray first. The paper must be the same size as

the transparencies.
5. Load the transparencies LEF on top of this paper stack. Align the edge of the

transparencies against the left edge of the tray, with the side to be printed on facing
down.

6. Adjust the paper guides by pressing in the guide release and carefully moving the
Edge Guide until it lightly touches the edge of the material in the tray.
Do not load materials above the MAX line located on the rear Edge Guide.

7. Gently push in the tray until it comes to a stop.
If enabled by your System Administrator, the Paper Tray settings/Tray Properties
window displays on the UI.

8. From the Paper Tray settings/Tray Properties window, enter the correct paper
information, including size, type, weight and, if necessary, paper curl and/or alignment
option.

9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray
Properties window.

Loading Pre-drilled Stock in Trays 1, 2, and 3

Pre-drilled paper is defined as having two or more holes along one edge for use in ring
binders and notebooks. To prevent jams or damage, make sure that any plugs (pieces
cut out of the paper to create the holes) do not remain in the stack.
1. Select the appropriate paper stock for your print job.
2. Pull out the tray slowly until it stops.
3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
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5. Load and align the edge of the pre-drilled paper with the holes against the left edge
of the tray.

Paper can be loaded either in the LEF/portrait or SEF/landscape direction.

6. Adjust the paper guides by pressing in the guide release and carefully moving the
Edge Guide until it lightly touches the edge of the material in the tray.
Do not load materials above the MAX line located on the rear Edge Guide.

7. Gently push in the tray until it comes to a stop.
If enabled by your System Administrator, the Paper Tray settings/Tray Properties
window displays on the UI.

8. From the Paper Tray settings/Tray Properties window, enter the correct paper
information, including size, type, weight and, if necessary, paper curl and/or alignment
option.

9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray
Properties window.

Loading Media in the Bypass (Tray 5)

Information About Loading Media in the Bypass (Tray 5)

This tray is used primarily when using a small quantity and special media (such as
envelopes). Review the following tips when using the Bypass (Tray 5):

• Verify the stock loaded in the tray with the Paper Tray settings/Tray Properties window
on the UI

• Load a maximum of 280 sheets of 20 lb/75 gsm paper
• Do not load mixed-size paper into the Bypass Tray
• Do not load materials above the MAX line as indicated on the tray
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Loading Paper in the Bypass (Tray 5)
Note
If any optional feeding devices are attached, the Bypass/Tray 5 is attached above or
on top of that feeding device. The following prodecure shows the Bypass/Tray 5 located
on top of the OHCF.

1. Gently extend the Bypass tray (Tray 5) as necessary to accommodate the paper.

2. Hold the center of the paper guides and slide them to the desired paper size.

3. Select the appropriate paper stock for your print/copy job.
4. Open the ream of paper with the seam side facing up.
5. Fan the sheets before loading them into the tray.
6. Insert the paper or media into the tray until it stops.
7. Adjust the paper guides so that they touch the edges of the stack.

If enabled by your System Administrator, the Paper Tray settings/Tray Properties
window may be displayed on the UI.

8. If the Paper Tray settings/Tray Properties window displays on the UI, confirm the
correct tray to which it is printing and other information, including size, type (precut
tab), and, if necessary, paper curl and/or alignment option.

9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray
Properties window.
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Loading Tab Stock in the Bypass (Tray 5)

Refer to the following tips before loading tab stock in the tray:

• You can load either single straight collated or single reverse collated tab stock.
• For network print jobs, refer to your print server customer documentation for

instructions on loading tab stock into a tray.
• If a jam occurs while running tabbed sets, cancel the job and start again.

1. Gently extend the Bypass tray (Tray 5) as necessary to accommodate the tab stock.
2. Hold the center of the paper guides and slide them to the desired stock size.
3. Fan the tab paper before inserting into the tray.
4. Insert the tab stock into the tray so the straight edge of the stock is in the feed

direction (lead edge) and the tabs are to the left (trail edge).
5. Continue to insert the tab stock into the tray until it stops.
6. Adjust the paper guides so that they touch the edges of the stack.
7. If the Paper Tray settings/Tray Properties window displays on the UI, confirm the

correct tray to which it is printing and other information, including size, type (precut
tab), and, if necessary, paper curl and/or alignment option.

8. Select Confirm or OK to save the information and close the Paper Tray settings/Tray
Properties window.

Loading Transparencies in the Bypass (Tray 5)
Note
Do not use transparencies with a white side strip (either permanent or removable).

1. Gently extend the Bypass tray (Tray 5) as necessary to accommodate the paper.
2. Hold the center of the paper guides and slide them to the desired paper size.
3. Select the appropriate paper stock for your print/copy job.
4. Fan the transparencies to stop them from sticking together before loading into the

tray.
5. Insert the transparencies LEF into the tray with the side to be printed on face up and

with the removable stripe to the right.
6. Continue to insert the paper or media into the tray until it stops.
7. Adjust the paper guides so that they touch the edges of the stack.
8. From the Paper Tray settings/Tray Properties window, enter the correct paper

information, including size, type, weight and, if necessary, paper curl and/or alignment
option.

9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray
Properties window.

Loading Pre-drilled Stock in the Bypass (Tray 5)
1. Gently extend the Bypass tray (Tray 5) as necessary to accommodate the paper.
2. Hold the center of the paper guides and slide them to the desired paper size.
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3. Select the appropriate paper stock for your print/copy job.
4. Fan the sheets before loading them into the tray.
5. Insert the pre-drilled stock into the tray in the LEF direction with the holes to the

right.
6. Continue to insert the paper or media into the tray until it stops.
7. Adjust the paper guides so that they touch the edges of the stack.
8. From the Paper Tray settings/Tray Properties window, enter the correct paper

information, including size, type, weight and, if necessary, paper curl and/or alignment
option.

9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray
Properties window.

Loading Envelopes in the Bypass (Tray 5)

Note
It is recommended that you print envelopes from the Bypass/Tray 5 only. Optional Trays
6 and 7 (OHCF) can be used if the Postcard Bracket is mounted and the stack height is
limited to no more than 200 envelopes.

When setting up your print job, follow the steps below to define the custom paper settings
at the Paper Tray settings/Tray Properties window and assign this stock to Tray 5. With
the flap closed, measure the height and width of the envelope.

The following envelope sizes are supported. Other sizes can be used but performance is
not guaranteed.

• C4 (229 x 324 mm) Short Edge Feed or Long Edge Feed
• C5 (162 x 229 mm) Short Edge Feed or Long Edge Feed
• #10 (4.125 x 9.5 inches) Short Edge Feed

1. Always load envelopes with the flaps closed.
Do not use padded envelopes.

2. When loading in the SEF direction, place the flaps facing the back of the press. When
loading in the LEF direction, place the flaps facing the lead edge.

3. When submitting your network print file, select Custom Paper as the Paper Type.
Enter the dimensions of the envelope.
The width is measured from the lead edge to the trail edge of the envelope. For
example, if you are loading SEF, enter the long dimension of the envelope as the
width. If you are loading the envelope LEF, enter the short dimension of the envelope
as the width.

4. Enter a heavy paper weight value, such as 220 gsm, in the Paper Weight field.
5. Select the Bypass Tray as the Paper Source.
6. Store unused envelopes in their original packaging to avoid the excess moisture or

dryness that can affect print quality and cause wrinkling. Excessive moisture can
cause the envelopes to seal before or during printing.
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Some wrinkling or embossing may occur when printing on envelopes. Successful envelope
printing depends on the quality and construction of the envelopes. Try another envelope
brand if problems occur.

Loading Paper in the 1-Tray High Capacity
Feeder (HCF / Tray 6)
Tips about the 1-tray HCF (Tray 6):

• This tray accommodates only 8.5 x 11 in./A4 Long Edge Feed (LEF) stock
• Stock weights between 18 lb./64gsm bond to 80 lb./220 gsm cover may be used in

this tray
• It holds a maximum of 2000 sheets of 20lb./75 gsm paper
• Stock must be loaded only in LEF direction
• Do not load materials above the MAX line

1. Select the appropriate paper stock for your job.
2. Pull out the tray slowly until it stops.

3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
5. Load the paper in the tray.

a) Align the edge of the paper against the RIGHT edge of the tray.
b) Move the paper guides to just touch the edges of the paper stack.
Do not load materials above the MAX line.

6. Gently push in the tray until it comes to a stop.
If enabled by your System Administrator, the Paper Tray settings screen may be
displayed on the UI.
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7. If changes have been made to the paper tray, select the Change Settings button;
otherwise, proceed to the next step.
a) Make the desired selections for Paper Type/Paper Weight, Paper Size, and Paper

Color.
b) If necessary, make the desired changes to paper curl and alignment adjustment.

Note
Refer to the System Administration Guide for detailed information on the paper
curl and alignment adjustment options.

c) Select Save until you are returned to the tray settings window.

8. Select Confirm to close the window.

Loading Media in the 1- or 2-Tray
Oversized High Capacity Feeder (OHCF /
Trays 6 and 7)

Information About Loading Media in the Oversized High Capacity
Feeder (OHCF)
Note
Each feeder tray has a stock loading label. When loading media into the tray, refer to
the labels on the inside panel of the feeder tray for the correct orientation of that stock
type.

Note
It is recommended that you use the Bypass Tray (Tray 5) to feed envelopes. However,
if you use Trays 6 or 7, C5 and #10 envelopes must be fed SEF with the Postcard Bracket
installed. Stack height is limited to 200 envelopes.

Postcard Bracket

The Postcard bracket is delivered with the OHCF from manufacturing. The Postcard
bracket allows you to print on smaller size media without requiring post-processing
cutting or sorting. The Postcard bracket specifically accommodates 4 x 6 in. (101.6 x
152.4 mm) SEF media.
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Using the Postcard Bracket

Use the following procedure for installing and using the Postcard bracket when printing
on smaller media (4 x 6 in./101.6 x 152.4 mm).

With the Postcard Bracket installed, you could print envelopes from Trays 6 and 7. The
stack height is up to 200 envelopes.
1. Slowly open one of the paper trays until it stops and remove the paper.

2. Move the paper guides out to their largest position.

3. Open the front cover of the OHCF.

4. Remove the Postcard bracket from inside the OHCF front cover.
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5. Install the Postcard bracket so that it sits on the locating pins on the upper frame
and in the grooves on the bottom of the tray.

6. Tighten the thumb screw so it locks the Postcard bracket in place.

7. Load the postcard stock and adjust the paper guides against the stock.

8. Close the paper tray and confirm the new settings at the print server.
9. Run your print job.

10. Upon completion of your print job, remove the postcard stock and the Postcard
bracket from the tray.

11. Store the Postcard bracket inside the OHCF front cover area.

Loading Paper in the Oversized High Capacity Feeder (OHCF)
1. Select the appropriate paper stock for your print/copy job.
2. Pull out the tray slowly until it stops.
3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
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5. Load paper into the tray.
6. Adjust the paper guides by pressing in the guide release and carefully moving the

Edge Guide until it lightly touches the edge of the material in the tray.

Do not load materials above the MAX line located on the rear Edge Guide.

7. Gently push in the tray until it comes to a stop.
The Paper Tray settings/Tray Properties window displays on the UI. You can view
and set stock attributes and verify trays are assigned with the correct stock.

8. From the Paper Tray settings/Tray Properties window, enter or verify the correct paper
information, including size, type, weight and, if necessary, paper curl and/or alignment
option. Select the stock and assign the stock to the tray to be used.

9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray
Properties window.

Loading Tabs in the Oversized High Capacity Feeder (OHCF)

Refer to the following tips before loading tab stock in the tray:

• You can load either single straight collated or single reverse collated tab stock.
• For network print jobs, refer to your print server customer documentation for

instructions on loading tab stock into a tray.
• If a jam occurs while running tabbed sets, cancel the job and start again.

1. After programming your tab job at the print server, select the appropriate and
matching tab stock for your print job.

2. Pull out the tray slowly until it stops.
3. Fan the tab paper before loading into the tray.
4. Load the tab stock LEF (portrait) and align the straight edge of the tab stock against

the right edge of the tray (tabs to the left or trailing edge). For single straight collated
tabs, the first blank tab cutout in the stack will be toward the front of the tray. For
single reverse collated tabs, the first blank tab cutout in the stack will be toward the
rear of the tray.

Tab stock is loaded so the straight edge of the stock is in the feed direction. Also, you
can only load the tab stock LEF.

5. Adjust the paper guides by pressing in the guide release and carefully moving the
Edge Guide until it lightly touches the edge of the stock in the tray.

Do not load materials above the MAX line located on the rear Edge Guide.

6. Gently push in the tray until it comes to a stop.
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The Paper Tray settings/Tray Properties window displays on the UG.

7. From the Paper Tray settings/Tray Properties window, confirm the correct tray to
which it is printing and other information, including size (9 x 11 inches), type (precut
tab), and, if necessary, paper curl and/or alignment option.

8. Select Confirm or OK to save the information and close the Paper Tray settings/Tray
Properties window.

Loading Transparencies in the Oversized High Capacity Feeder
(OHCF)

Read these tips before using transparencies:

• Do not use transparencies with the white side strip (either permanent or removable).
• Do not mix paper and transparencies in a tray. Jams may occur.
• Do not load more than 100 transparencies in a paper tray at one time.
• Load 8.5 x 11 in (A4) transparencies long edge feed only (landscape).

1. Select the appropriate paper stock for your print job.
2. Pull out the tray slowly until it stops.
3. Fan the transparencies to stop them from sticking together before loading into the

tray.
4. Load transparencies LEF on top of a small stack of same-size paper and align the

strip edge of the transparency against the right edge of the paper tray, with the side
to be printed on facing down.

5. Adjust the paper guides by pressing in the guide release and carefully moving the
Edge Guide until it lightly touches the edge of the material in the tray.

Do not load materials above the MAX line located on the rear Edge Guide.

6. Gently push in the tray until it comes to a stop.
If enabled by your System Administrator, the Paper Tray settings/Tray Properties
window displays on the UI.

7. From the Paper Tray settings/Tray Properties window, enter the correct paper
information, including size, type, weight and, if necessary, paper curl and/or alignment
option.

8. Select Confirm or OK to save the information and close the Paper Tray settings/Tray
Properties window.

Loading Pre-Drilled Stock into the Oversized High Capacity Feeder
(OHCF)
1. Select the appropriate paper stock for your print job.
2. Pull out the tray slowly until it stops.
3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
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5. Load and register the paper against the right side of the tray for LEF direction.

6. Load and register the paper against the right side of the tray as depicted below for
SEF direction.

7. Adjust the paper guides by pressing in the guide release and carefully moving the
Edge Guide until it lightly touches the edge of the stock in the tray.

Do not load materials above the MAX line located on the rear Edge Guide.

8. Gently push in the tray until it comes to a stop.
If enabled by your System Administrator, the Paper Tray settings/Tray Properties
window displays on the UI.

9. From the Paper Tray settings/Tray Properties window, enter the correct paper
information, including size, type, weight and, if necessary, paper curl and/or alignment
option.

10. Select Confirm or OK to save the information and close the Paper Tray settings/Tray
Properties window.

Loading Paper / Tabs in the Post-Process
Inserter (Tray 8 / T1)
Note
Depending on your product and system configuration, the Post-Process Inserter is called
either Tray 8 or Tray T1.
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Note
This tray is available only on the following finishers:

• Standard Finisher (with our without optional C / Z Folder)
• Booklet Maker Finisher (with our without optional C / Z Folder)
• Standard Finisher Plus (with our without optional C / Z Folder)

1. If necessary, remove any remaining media that is currently loaded in the tray.
2. Hold the center of the paper guides and slide them to their desired paper size.

3. Load the paper or tabs, aligning it to the front side of the tray.

a) If the paper is preprinted, load the paper with the printed side facing up.
b) If the media is tab stock, load the tab side to be fed first (in the direction of the

arrow as shown in the above illustration).

4. From the Paper Tray settings / Tray Properties window, enter the correct paper
information, including size, type, weight, and if needed, decurler and/or alignment
option.

5. Select Confirm or OK to save the information and close the Paper Tray settings /
Tray Properties window.

Loading Tab Stock with the GBC
AdvancedPunch
When this optional finishing device is attached to your press, tab stock is loaded
differently into paper trays. For detailed information on the GBC AdvancedPunch features
and functions, refer to the GBC AdvancedPunch customer documentation which came
with the device.
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The AdvancedPunch punches the leading edge of a sheet. This means that tabs must
be fed with the tab on the trailing edge. The manner in which tabs are loaded into the
tray to cause the correct tab-trailing feeding varies depending upon the tray that is
utilized. The following illustration and related text shows the recommended way to load
tabs depending on which feeder is being used:

1. If using the optional HCF (letter-size/A4) or the OHCF (1- or 2-Trays), load the tabs
upside down and change the order one by one (as shown in the illustration).

2. If using the press Trays 1, 2, or 3, load the tabs upside down (as shown in the
illustration).

3. If using an optional finisher with a post-processor inserter (Tray 8/T1), load the tabs
upside down (as shown in the illustration).
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4
Copy

Document Feeder and Glass

Document Feeder Tips

Tips for using the Duplex Automatic Document Feeder (DADF):

• For best output, ensure that the documents are in good condition.
• A maximum of 250 documents can be scanned at one time by using the document

feeder.
• Mixed-size original documents can be used; however, the top left corners of the

original documents must be aligned in the document handler.
• Remove any staples and paper clips from the documents before loading them in the

document feeder.

Document Glass

Use the Document Glass for scanning and copying various types documents, such as
bound originals (books), odd size documents or poor quality originals. Documents should
be placed face down on the glass and aligned with the tip of the registration arrow in
the top left corner.

The document glass accommodates document sizes up to a maximum of 11 x 17 in./A3.
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Basic Copying Steps

Basic Copying with the Document Feeder (DADF)
1. Adjust the movable document guides to their widest position.

2. Load the documents face up with the first page on top and with the headings toward
the back or left of the machine.
The confirmation indicator lights to show that the documents are loaded correctly.

3. Press the Home button on the press UI.
4. Select Copy on the Home window.
5. Select the desired Copy features/options:

• Paper Supply
• Reduce/Enlarge
• Output Color
• 2-Sided Copying
• Original Type
• Lighten/Darken

The features displayed on the main Copy window vary depending on how it is
configured by the administrator.

6. Enter the quantity.
7. Press Start.
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Basic Copying with the Document Glass
1. Open the document feeder.

2. Place the document face down by aligning it as shown in the illustration.

3. Press the Home button on the press UI.
4. Select Copy on the Home window.
5. Select the desired Copy features/options:

• Paper Supply
• Reduce/Enlarge
• Output Color
• 2-Sided Copying
• Original Type
• Lighten/Darken

The features displayed on the main Copy window vary depending on how it is
configured by the administrator.

6. Enter the quantity.
7. Press Start.

Selecting Copy Options for a Third-Party Finishing Device

Read the following list before performing the procedure:

• If your machine has an optional, third-party, Document Finishing Architecture (DFA)
device attached, then this profile feature is available, and specific copy options may
be selected for a job.

• Prior to physically attaching the DFA device to the machine, device profiles are created.
The profiles represent the characteristics of your finishing device.
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• Refer to the third-party customer documentation for information on setting the
profile values for the specific DFA device attached to the machine.

• A profile for the job can be selected from either the print server, the print driver on
your computer, or the press User Interface. Depending on the DFA device, a maximum
of twelve profiles are available.

1. Place your original documents either in the document feeder or on the document
glass.

2. Press the Home button on the press UI.
3. Select Copy on the Home window.
4. Select the Output Format tab.

a) Select the DFA Finisher.
The DFA Finisher Profile screen displays.

b) From the displayed list, select the profile for the job.
If the device is an e-binder, select the binding position.

c) Select Save.
d) Select the desired Face Up/Down Output option.

5. Select the desired Copy features/options.
The features displayed on the main Copy window vary depending on how it is
configured by the administrator.

6. Enter the quantity.
7. Press Start.

If prompted on the UI, follow the instructions provided to correct any job submission
errors. If there is a DFA problem, refer to your DFA documentation.

Copy Feature

Copy Feature Overview
Tip
Depending on how the Copy tab is configured by the administrator, this tab may contain
different features than the ones listed here.

The Copy feature includes the following options:

• Reduce/Enlarge (R/E)
• Paper Supply (Auto Select)
• Output Color
• Copy Output
• 2 Sided Copying
• Original Type
• Darken/Lighten
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Reduce/Enlarge

Reduce / Enlarge (R/E)

The reduce / enlarge (R/E) feature provides a variety of reduction and enlargement
options to adjust the size of the output image. Originals can be enlarged or reduced
from 25-400%. Various automatic and preset selections are available to help you choose
the most common reductions or enlargements, while a custom setting enables you to
select the ratio that suits your requirements. Basic reduction/enlargement options include:

100% or R/E entry box

The default setting in the R/E entry box is 100%. This selection produces an image on
your copy exactly the same size as the image on your original document.

You can also set the R/E ratio by using the plus or minus buttons. In this case, the ratio
is displayed in the R/E entry box.

Auto%

This selection proportionally reduces or enlarges the image so that it will fit onto your
chosen paper. If this option is selected, you must also select a specific paper tray.

Preset R/E buttons

Depending on what the System Administrator has selected, you see several percentage
options for reduction or enlargement. These buttons can be customized by the
Administrator to display the reduction/enlargement ratios that you frequently use.

More

When the Reduce/Enlarge (R/E) More button is selected, a new window opens and
displays additional R/E options.

More Reduce/Enlarge (R/E) Options

The Reduce/Enlarge (R/E) More options include:

Proportional %

All of the options will reduce or enlarge the image by the same ratio in both directions
so that the image gets bigger or smaller, but the proportion remain the same.

Auto %

Proportionally reduces or enlarges the image so that it will fit onto your chosen paper.
If this option is selected, you must also select a specific paper tray.

4-5Xerox® Versant® 80 Press
User Guide

Copy



Independent X-Y%

This option allows you to specify different height and width ratios to scale the height
and width independently.

Auto X-Y% ensures copies are made with the height and width ratios set automatically
to match the paper size.

Auto Center

This option allows you to specify individually the height and width values.

Preset percentage buttons

The percentage buttons are preset for specific magnification levels by the administrator
to reflect the percentages used most frequently.

Paper Supply

Select the desired tray to be used for your job; options include:

Auto Select

This option automatically detects the size of the original document and selects the
proper tray for output.

Tray buttons

Allows you to select a specific tray containing the desired media for your job.

More button

Displays the Paper Supply screen showing all available trays for the machine and their
media content.

Output Color

Select the desired Output Color option which best applies to the job. The options include:

Auto Detect

This option allows the machine to automatically detect if the original document is in
color or black and white.

Color

This option generates copies with full color output, using all four printing colors - cyan,
magenta, yellow, and black.

Black and White

This option copies in black and white only. Colors in the original are converted to shades
of gray.
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Dual Color

This option allows you to separate the colors of the original into two groups of colors
for copying. The source color is extracted from the original and replaced by the target
area color. The rest of the colors are replaced by the non-target area color that you
select.

Single Color

This option allows you to copy in one of the preset or custom colors.

More

This options allow you to customize the color for the copied output.

Copy Output
Important
Copy Output options vary depending on the finishing devices attached to your machine.

Note
Copy Output may be accessed either from the Copy tab or from the Output Format tab.

Use the Copy Output feature to select the desired options for your output; options
include:

• Auto
• Collated
• Uncollated
• Uncollated with Separators
• Original Orientation
• Optional finishing features, including:

- Output Destination/Offset
- Stapling
- Hole Punching
- C/Z Folding

2 Sided Copying
Note
The 2 Sided Copying option may be accessed either from the main Copy screen or from
the Output Format tab.

Make one or two-sided copies from one or two-sided originals using either the document
feeder or the document glass. The two-sided option enables you to select your output
in book or calendar orientation. Options include:
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1-1 Sided

Use this option if your originals are printed on one side and you want single-sided
copies.

1-2 Sided

Use this option if your originals are printed on one side and you want two-sided copies.

2-2 Sided

Use this option if you want to make two sided copies from two-sided originals.

2-1 Sided

This option will make one-sided copies from two-sided originals.

Originals/Copies

Select the orientation of both your original documents and the output copies. Options
include Head to Head and Head to Toe.

Head to Head

This option is sometimes called Top-to-Top. For your original documents, select this
option when all the pages of your original documents have the same orientation. For
copy output, select this option to copy/print the reverse side of a page so that the
finished document opens like a book.

Head to Toe

This option is sometimes called Top-to-Bottom. For your original documents, select this
option when the pages of your original documents have the opposite orientation such
as on a calendar. For copy output, select this option to copy/print the reverse side of a
page so that the finished document opens like a calendar.

Original Orientation

Upright Images

Select this option when placing the top edge of the document against the top side
of the document glass or document feeder.

Sideways Images

Select this option when placing the top edge of the document against the left side
of the document glass or document feeder.

Original Type
Note
The Original Type option may be accessed either from the main Copy screen or from
the Image Quality tab.
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The Original Type feature provides a convenient way to enhance the quality of your
output based on the type of original images you are copying. Select the Original Type
button on the Image Quality tab, and select the desired option.

Auto

This option sets the output color according to the document type preset in the System
Administration mode.

Photo and Text

Use this option if your original is from a magazine or other source that contains high
quality photographs with text. This setting produces better pictures, but slightly reduces
sharpness for text and line art.

Text

Use this option if your original contains only text or line art. The result is sharper edges
for the text and line art.

Photo

This option is specifically designed to copy photographs or magazine pictures without
any text or line drawings. This option prevents faint reproduction of colors.

Map

Use this option for making copies of documents that have text on colored backgrounds
such as maps.

Darken/Lighten
Note
The Darken/Lighten option may be accessed either from the main Copy screen or from
the Image Quality tab and then by selecting Image Options.

The Darken/Lighten option provides manual control to adjust the lightness or darkness
of the scanned images.

• Select the Left scroll button to darken the scanned image from light originals such
as pencil images.

• Select the Right scroll button to lighten the scanned image from dark originals such
as half tones or originals with colored backgrounds.

Image Quality Feature

Image Quality Feature Overview

The Image Quality feature includes the following options:

• Original Type
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• Image Options
• Image Enhancement
• Color Effects
• Color Balance
• Color Shift

Selecting Image Quality Options
1. Load the document or documents either onto the Document Glass or into the

Document Feeder.
2. Press the Home button on the press UI.
3. Select Copy on the Home window.
4. Select the Image Quality tab.
5. From the Image Quality window, select the desire options:

• Original Type
• Image Options
• Image Enhancement
• Color Effects
• Color Balance
• Color Shift

6. Select the Copy tab.
7. Select the desired Copy options including:

• Paper Supply
• Reduce/Enlarge
• 2-Sided Copying

8. Select any other desired Copy features/options (such as Layout Adjustment, Output
Format).

9. Enter the quantity.
10. Press Start on the UI.

Original Type
Note
The Original Type option may be accessed either from the main Copy screen or from
the Image Quality tab.

The Original Type feature provides a convenient way to enhance the quality of your
output based on the type of original images you are copying. Select the Original Type
button on the Image Quality tab, and select the desired option.

Auto

This option sets the output color according to the document type preset in the System
Administration mode.
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Photo and Text

Use this option if your original is from a magazine or other source that contains high
quality photographs with text. This setting produces better pictures, but slightly reduces
sharpness for text and line art.

Text

Use this option if your original contains only text or line art. The result is sharper edges
for the text and line art.

Photo

This option is specifically designed to copy photographs or magazine pictures without
any text or line drawings. This option prevents faint reproduction of colors.

Map

Use this option for making copies of documents that have text on colored backgrounds
such as maps.

Image Options

Use the Image Options feature to make adjustments to the following options:

Lighten/Darken

This option provides manual control to adjust the lightness or darkness of the scanned
images.

• Select the Down scroll button to darken the scanned image from light originals such
as pencil images.

• Select the Up scroll button to lighten the scanned image from dark originals such as
half tones or originals with colored backgrounds.

Sharpness

This option controls the balance between sharp text and moiré (patterns within the
image). Move the slider control down (Soften) to produce an image with a smooth,
uniform appearance ideally suited for photographic scanned images. Move the slider
control up (Sharpen) to produce an image with better quality text or line art.

Saturation

This option allows colors to become more or less vivid. To make the colors on your
output more vivid, move the slide bar up. To create a less vivid output, or a pastel effect,
move the slide bar down. To keep the output normal, do not adjust the saturation.

Image Enhancement

Use the Image Enhancement settings when your scanned image requires more than
the basic image quality. There are two features associated with Image Enhancement:
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Suppress Background

This option prevents reproduction of unwanted shading from originals where the
opposite side printing shows through.

Off

Auto Suppression: This option automatically reduces or eliminates any background
on the copies caused by colored paper or newspaper originals.

Contrast

Selections are either Auto Contrast or Manual Constrast. The Constrast feature controls
the difference between the image densities within the scanned image. Lower contrast
settings reproduce more detail in light and dark areas of the original. Higher contrast
settings produce vivid blacks and whites for sharper text and lines, but produce less
detail in pictures. Auto Correction automatically chooses the best settings for your job.

Color Effects

This feature produces balanced image tones on your output. Options include:

Lively

This option uses the highest color saturation to produce rich, vivid output colors. The
option increases the color saturation of the most vivid setting in order to produce
fresher images.

Bright

This option produces images that have a brighter appearance and enhanced contrast.

Warm

This option produces a soft image on the output and adding a warm, reddish tint to
low density colors. Use this setting to apply a light pink tone to skin colors and to give
a soft tone to dark, warm colors.

Cool

This option produces a strong, clear blue tone on the output. This setting makes blue
color stronger and makes dark, cold colors clearer.

Shadow Suppression

This option reduces or eliminates any background shadow caused by colored paper or
newspaper originals.
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Color Balance

This feature allows you to adjust the balance between colors and the overall amount of
color on the output copies. You can adjust the levels of all four process colors (Yellow,
Magenta, Cyan, and Black) for their low, medium, and high density ranges.

• The default option is Normal.
• Basic Color adjusts the density.
• Advanced Color adjusts the Highlights, Midtones, and Shadows.

Color Shift

This feature allows you to shift all hues in an image simultaneously in order to make the
overall character of the output image warmer or cooler. For example, if you select one
of the:

Normal

This is the default option.

Plus buttons

The red colors shift toward the yellow hue, the green colors shift toward the cyan hue,
and the blue colors shift toward the magenta hue. All colors between these original
colors also shift in the same direction.

Minus buttons

The red colors shift toward the magenta hue, the blue colors shift toward the cyan hue,
and the green colors shift toward the yellow hue. Again, all colors between these original
colors also shift in the same direction.

Layout Adjustment Feature

Layout Adjustment Feature Overview

The Layout Adjustment feature includes the following options:

• Book Copying
• 2 Sided Book Copying
• Original Size
• Edge Erase
• Image Shift
• Image Rotation
• Invert Image
• Original Orientation
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Selecting Layout Adjustment Options
1. Load the document or documents either onto the Document Glass or into the

Document Feeder.
2. Press the Home button on the press UI.
3. Select Copy on the Home window.
4. Select the Layout Adjustment tab.
5. From the Layout Adjustment window, select the desire options:

• Book Copying
• 2 Sided Book Copying
• Original Size
• Edge Erase
• Image Shift
• Image Rotation
• Invert Image
• Original Orientation

6. Select the Copy tab.
7. Select the desired Copy options including:

• Paper Supply
• Reduce/Enlarge
• Darken/Lighten

8. Select any other desired Copy features/options (such as Image Quality, Output
Format).

9. Enter the quantity.
10. Press Start on the UI.

Book Copying

Bound originals (such as books) can be placed on the document glass to make 1-sided
or 2-sided copies. The bound original should be placed face down and registered to the
rear left corner of the document glass. Align the top of the bound original against the
rear edge of the document glass.
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Book Copying options include:

Both Pages

Copies both pages in page order.

Left Page Only

Copies the left page only.

Right Page Only

Copies the right page only.

Binding Edge Erase

This option erases or deletes the shadow from your copies that is caused by the center
binding of the bound original.

2 Sided Book Copying

You can make 2-sided copies from two pages of a bound original. This feature allows
you to assign pages when making copies of a bound original so that the copied pages
face each other in the same way as the bound original. 2 Sided Book Copying options
include:

• Select a starting and ending page
• Select Starting Page (Left Page or Right Page), and
• Selecting Ending Page (Left Page or Right Page).

Original Size

The machine can detect the size of the document if it is a standard size. If the document
is not a standard size, the machine does not know what size it is. This does not matter
if you select a specific reduction/enlargement option and also select a specific paper
tray. However, you can tell the machine the size of the document if you want to use the
Auto features. Original Size options include:

Auto Detect

This option automatically detects the size of the scanned pages. The document sizes
that can be detected automatically include all standard sizes.

Manual Size Input

This option allows you to select a standard paper size from the options shown or to
input a non-standard (custom) size. When you have selected the size of your document,
you can use the auto reduce/enlarge or the auto paper supply features.

Mixed Size Originals

With this option the machine automatically detects the size of each document.

4-15Xerox® Versant® 80 Press
User Guide

Copy



Edge Erase

This option allows you to erase images around the border of a document. Edge Erase
also deletes center streaks caused by a gap between the spine of a bound document
and the document glass. Options include:

All Edges

This option causes a preset amount to be erased from the top/bottom and left/right
edges and from the center of the output image.

Print to Edge

This option does not perform any edge deletions.

Individual Edges

This option allows you to independently set the amount to be erased for each of the
four edges and the center of your output. The default is 0.1 in. (2.54 mm) and each
edge can be adjusted in 0.1 in. (2.54 mm) increments up to 2.0 in (50.8 mm).

Presets

With this option you choose pre-programmed erase amounts that were previously
created and saved by the system administrator.

Image Shift

Image Shift allows you to move the position of the image on the output page. Options
include:

Off

This is the default setting. The image on the copy will be in the same place as the image
on the original.

Auto Center

This option automatically centers the scanned image on the output paper. To work
effectively, the original should be smaller than the selected output stock or the image
should be reduced.

Corner Shift

This option enables you to move the image to each of the four corners of the paper or
to the center of each of the four sides of the paper (eight positions total).

Margin Shift

This option creates a margin for binding one edge of a document by shifting the image
away from that edge. The Margin Shift option enables you to center a document image,
shift the image to one edge slightly, or move the image to a specified edge (0-2.0
in./0-50.8 mm Left/Right or Top/Bottom) of the output.
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Presets

With this option you choose pre-programmed shift amounts that were previously
created and saved by the system administrator.

Image Rotation

If the orientation of the paper loaded in the selected paper tray differs from that of the
document that is scanned, the Image Rotation option automatically rotates the
document image to match the orientation of the paper loaded in the paper tray. You
can also select which edge of the original document to use as a reference for image
rotation if documents are of mixed orientations. Options include:

Off

This option causes copies to be made as they are loaded, even if they are oriented
differently from the paper in the selected paper tray.

Always On

This option causes copies to be made with the document image automatically rotated
so that the orientation of the document matches that of the paper in the selected
paper tray.

On during Auto

This option provides automatic rotation of the image on your original to fit correctly
on your selected copy paper when Auto Select or Auto% is selected.

Invert Image

The Invert Image feature allows you to make copies with the left and right sides of the
document image reversed or the colors reversed. Options include:

Mirror Image

This option reverses the original image creating a mirror of the original. This feature
can be used when you want to change the apparent direction of an image or where
the original is inked on the reverse of the paper (for example engineering drawings).

Negative Image

This option converts the black image areas in the original to white, the white image
areas to black, and any dark gray image areas to light gray. This feature is useful for
documents that have a substantial amount of dark background and/or light text and
images, saving on toner usage.
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Original Orientation

This feature is used to inform the system of orientation of your original document when
it is placed in the document feeder or on the document glass. The orientation must be
specified in order to identify the top of the document set. This information is used by
the system to make a decision about how to accurately place images on paper when
using features such as Image Shift, Edge Erase, Multiple-Up, Repeat Image, Annotation,
and Booklet Creation. Original Orientation options include:

• Upright Images: Select this option when placing the top edge of the document
against the top side of the document glass or document feeder.

• Sideways Images: Select this option when placing the top edge of the document
against the left side of the document glass or document feeder.

Output Format Feature

Output Format Feature Overview

The Output Format feature includes the following options:

• Booklet Creation
• Covers
• Transparency Options
• Page Layout
• Poster
• Annotations
• Watermark
• Tab Margin Shift
• Face Up/Down Output
• ID Card Copying
• Transparency Options
• Folding (optional)

Selecting Output Format Options
1. Load the document or documents either onto the Document Glass or into the

Document Feeder.
2. Press the Home button on the press UI.
3. Select Copy on the Home window.
4. Select the Output Format tab.
5. From the Output Format window, select the desire options:

• Booklet Creation
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• Covers
• Transparency Options
• Page Layout
• Poster
• Annotations
• Watermark
• Tab Margin Shift
• Face Up/Down Output
• ID Card Copying
• Transparency Options
• Folding (optional)

6. Select the Copy tab.
7. Select the desired Copy options including:

• Paper Supply
• Reduce/Enlarge
• Darken/Lighten

8. Select any other desired Copy features/options (such as Image Quality, Layout
Adjustment, Output Format).

9. Enter the quantity.
10. Press Start on the UI.

Booklet Creation

Booklet Creation allows you to create multi-page booklets from an ordered set of 1-Sided
or 2-Sided originals.

Refer to the following tips when using the Booklet Creation feature:

• When Auto% is selected, the press reduces or enlarges the image as required.
• Any other Reduce/Enlarge selection could result in image loss.
• When Booklet Creation is selected, the output is automatically set to 1-2 Sided.
• Ensure that the Original Orientation setting reflects the same orientation as that

of the original documents.

Booklet Creation Options

When On is selected, the following Booklet Creation options are available:

Original Input

• 1 Sided Originals
• 2 Sided Originals
• 2 Sided Rotated Originals
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Binding Shift

Use this option to set the booklet binding-shift value within the range from 0 to 1.9 in.
(0 to 50 mm) in 0.1 in. or 1 mm increments.

Covers

This option allows you to attach covers to the booklet. The front and back covers can
be output before the first page and after the last page of the document and on a
different type of paper.

Divide Output

Use this option when you have a large number of original documents. The original
documents are divided to create subsets in order to reduce the thickness of each booklet.
The machine folds copies in half, and piles them up to form a booklet. The Light
Production C Finisher with Booklet Maker allows you to specify the number of sheets
within the range of 1-50 sheets in one-sheet increments.

Output/Offset

This option is available only when specific optional finishers are attached, such as the
Standard Finisher or Booklet Maker Finisher.

Auto Image Positioning

This option adjusts the image position so that the printing position from the edge of
each page remains consistent between the inner and outer pages of the booklet. Auto
Image Positioning is available for selection if you have already selected Create Left/Top
Bound Booklet or Create Right Bound Booklet.

Fold and Staple (optional)

Folding and/or stapling are optional features. These features are available only with
finishing devices that provide these capabilities.

When available, select the desired Fold and Staple option:

• No Fold and Staple: This option produces booklets without folding or stapling.
• Fold Only: This option produces booklets that are folded in half.
• Fold and Staple: This option produces booklets that are folded in half and stapled

in the center.

Booklet Trimming/Pressing (optional)

Booklet trimming and pressing are available only if the optional SquareFold Trimmer
Module is attached to the Booklet Maker Finisher.

Booklet Trimming/Pressing options include the following:

• Booklet Trimming: This option trims (cuts) away the face (edge) of the booklet,
resulting in a neat finished edge.

• Book Pressing: Book Pressing, also known as square folding, flattens the booklet
spine, thereby reducing the booklet thickness and giving it the appearance of a
perfect bound book.
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Covers

This feature allows you to automatically add covers to your copied sets using stock from
a different tray. For example you can add colored stock, card or transparencies to your
copied sets to add a professional finish to your copy job.

The Covers feature includes the following options:

Front Cover/Back Cover

Select an option for a front cover only, back cover only, or select options for both front
and back covers:

• Off
• Blank Cover: Uses blank sheets of paper as the cover.
• Print on Side 1
• Print on Side 2
• Print on Both

Paper Supply

Select the tray or trays from which front and/or back cover media is supplied. If Blank
Covers is selected, enter the number of blank sheets that will be used for the covers.

Note
If Blank Cover is used for both the front and back covers, verify that the correct quantity
is selected for both the covers.

Page Layout

The Page Layout options are ideal for handouts, storyboards, or for archival purposes.

Pages per Side

The Pages per Side feature is ideal for handouts, storyboards or for archival purposes.
It allows the scanning of up to eight independent images to fit onto one sheet of paper.
Your press reduces or enlarges the images as needed in order to display them either
in portrait (upright) or landscape (sideways) orientation on one page; this is based on
the paper supply selected.

Repeat Image

This option allows you to copy a single image up to eight times onto one page.

Variable Repeat: This option specifies the number of times to repeatedly copy the
image along each of the long and short sides of the paper. You can specify from 1 to
23 repeats along the short side (Y) and from 1 to 33 repeats along the long side (X).
The examples shown are a typical output that can be produced when using the Repeat
Image feature.
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Poster

This feature allows you to create a large poster by pasting together copies spread over
multiple sheets. Copies are provided with a paste margin so that they can be pasted
together. Options include:

Output Size

This option allows you to choose from a list of preset output poster sizes.

Enlargement %

This option allows you to enter specific height and width percentage values (from
100% to 400%) for your final poster size.

Annotations

This option allows you to add a stamp to your copied output. Options include:

Comment

This option allows you to add comment stamps that are stored on the machine to the
output copies. Select one of eight existing stamped messages to be printed on the first
page or all pages of your copied sets. Stored comments include Confidential, Urgent,
and Draft. You can also create new or edit existing comments. These can also be stored
to the machine memory. You can also change the position and appearance of the
comment using the Position and Font Size buttons.

Date

This option allows you to place the current date in the margins of your output. The
date can be printed on only the first page of the output, or it can be printed on all
pages. You can also change the position and appearance of the date using the Position
buttons.

Page Numbers

This option allows you to add an independent page number to one or many copied
pages. You can also change the position and appearance of the page numbers using
the Position and Font Size buttons.

Bates Stamp

This option allows you to place an alphanumeric prefix, followed by a sequential page
number in the margins of the output. You can specify an existing Bates Stamp, or you
can create a new or edit an existing Bates Stamp. You can also change the position
and appearance of the stamp using the Position and Font Size buttons.

Xerox® Versant® 80 Press4-22
User Guide

Copy



Watermark

This option to add a lightly printed sequential control-number, stored watermark, date
and time, or serial number on the background of each copy set. This feature can be used
to help track confidential documents. For example, you can use sequential numbering
to associate distribution copies with specific recipients. Options include:

Control Number

This option allows you to input a start number that will be printed on each document
set. For example, if you select 1 for the start number, the number 1 will be printed on
the first set of documents, the number 2 will be printed on the second set, and so on.

Stored Watermarks

This option allows you to select an existing watermark to be printed on one page or
many pages. Existing watermarks include Copy Prohibited, Copy, and Duplicate.

Date and Time

This option prints the current date and time on the output (each page).

Serial Number

This option allows you to make copies with the machine's serial number printed on
each page. This feature is useful if you want to track the copies coming from a certain
machine.

Watermark Effect

This option allows you choose an embossed or outline style for the watermark text you
print.

Tab Margin Shift

The Tab Margin Shift option allows you to copy images from a document onto tabbed
stock. You have the option to copy the entire original document onto the tabbed stock,
or you can choose to copy only the edge of the original document onto the tabbed stock.
Options include:

Shift to Tab

This option prints the edge of the original document image onto the tab of the tabbed
stock. You can change the amount of shift required by using the Shift Value buttons
on the touch screen.

Shift All

This option copies the whole image of the document onto tab stock. Use the Shift
Value button when you want to adjust the position of the image on the tab area.
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Shift Value buttons

These buttons allow you to specify a shift value in the range of 0-15 mm (0-0.59 in.)
in 1 mm (0.039 in.) increments.

Add Tab Stock

Use this option to select a specific number of tab stock sheets to use.

Paper Supply

Use this option to select the tray containing the tab stock.

Face Up/Down Output

The Face Up/Down Output option allows you to select whether copies are output facing
up or facing down. Options include:

Auto

Selecting the Auto button automatically determines whether the copies should be
output face up or face down.

Face Up

Selecting the Face Up button causes all output to be delivered face up, with the first
page on top of the output stack.

Face Down

Selecting the Face Down button causes all output to be delivered face down, with the
first page on the bottom of the output stack.

Face Up (Reverse Order)

Selecting the Face Up (Reverse Order) button causes all output to be delivered face
up, with the last page on the top of the output stack. This setting may not be available,
depending on how your system administrator configures the machine.

ID Card Copy

Whether needing to copy insurance cards, a driver’s license, or any other form of
identification, the ID Card Copying feature offers a simple and efficient way to save
time. Information on both sides of an ID card can be copied onto one side of a sheet
of paper into the paper or bypass tray.
1. Open the document feeder and place the ID card on the top, left corner of the

document glass.
2. Close the document feeder.
3. Press the Home button on the press UI.
4. Select Copy on the Home window.
5. Select Output Format  > ID Card Copying .
6. Select On.
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7. Select Save.
8. Enter the quantity.
9. Press Start to begin scanning side 1.

10. Open the document feeder and turn the ID card over to copy side 2.
11. Close the document feeder.
12. Press Start to begin scanning side 2.

Printing begins and copies are delivered to the output area.

Transparency Options

When making a set of transparencies you can insert a divider between each transparency
in order to make it easier to manage your presentation slides. You can also produce
paper copies of the transparencies in order to distribute them to people. Transparency
options include:

Blank Transparency Separators

This option delivers your transparencies to the output destination with a blank sheet
of paper separating each transparency.

Blank Separators and Handouts

This option inserts a blank sheet of paper between each printed transparency. In
addition, a distribution set of copies is also printed on the stock you specify using the
Paper Supply Settings button. Handouts can be 1- or 2-sided and stapled (if available).

Transparency Set and Handouts

This option delivers the transparencies without separators. However, a distribution set
of copies will be printed on the stock you specify using the Paper Supply button.
Handouts can be 1- or 2-sided and stapled (if available).

Transparency Tray

Select the tray containing the transparencies.

Separator Tray / Separator and Handout Tray / Handout Tray

This option varies depending on the selected transparency option. Select the desired
tray that contains the separator and/or handout stock.

Folding (optional)
Note
This feature is available only if the appropriate, optional finishing device is attached to
your press.

Review the following information before using the Folding option.

• If your press is equipped with an optional Folder, you can make copies or prints using
the Folding feature.
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• Depending on the finishing device, the Folding option can fold your output in half
(single or bi-fold) or in thirds (C-fold or Z-fold types).

• The Folding option can be selected for both your copy and network print jobs.
• Depending on the copy/print job, the Folding option can be selected from either the

press UI or from the print driver on your workstation.
• The Folding option can also be selected at the print server for the selected job.
• In order to use the folding option, the orientation of documents must be short-edge

feed (SEF). You must select a paper tray that contains SEF stock.

Folding options include:

• Single Fold (Bi-Fold): Select this option to fold the output copies in half.
• C-Fold: Select this option to fold the output copies in thirds.
• Z-Fold: Select this option to fold the output copies with two folds that are folded in

opposite directions, resulting in a type of fan fold.
• Z-Fold Half Sheet: This option has two folds that are folded in opposite directions,

with two unequal folds. The two unequal folds allow one edge of the sheet to have
a longer edge which allows for stapling or hole punching.

• Image Inside Fold: Folds copies so that the image is printed on the inside.
• Images Outside Fold: Folds copies so that the image is printed on the outside.

Job Assembly Feature

Job Assembly Feature Overview

Job Assembly includes the following features:

• Build Job
• Sample Job
• Combine Original Sets
• Delete Outside / Delete Inside

Build Job

This feature allows you to change and save settings individually for each document
page or stack. You can then make copies of documents with different settings as one
job.
1. Split the hard-copy document into sections for individual programming.
2. On the Home window, select Copy.
3. Select the Job Assembly tab.
4. Select Build Job.
5. Select Build Job On.
6. Select Save.
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7. Program the job requirements for the first segment of the job by selecting and saving
the applicable features from the features shown at the bottom of the Build Job
window.

• Copy Output
• Booklet Creation
• Covers
• Annotations
• Segment Separators
• Watermark
• Face Up/Down Orientation

8. Load only the first segment into the document feeder or place the segment on the
document glass one page at a time.

9. Press Start.
When the first segment has finished scanning, the Copy Status screen will appear.

10. Remove the originals from the document feeder or document glass.
11. Select Change Settings.
12. Program the job requirements for the second segment.
13. Load the second segment into the document feeder or on the document glass.
14. Press Start.
15. Repeat the previous steps until all segments of your job have been programmed and

scanned.
16. After the last segment has been scanned, select Last Original.

The machine will complete the quantity selected.

17. Retrieve the copies from the output area.

Sample Job

When making multiple copies, you can continue making copies after making and
examining a sample set. You can choose to continue or cancel the job after confirmation.
To print a sample of the job, perform the following:
1. Press the Home button on the press UI.
2. Select Copy on the Home window.
3. Select Job Assembly  > Sample Job.
4. Select Sample Job On.
5. Select Save.
6. Load the documents in either the document feeder or on the document glass.
7. Program the job with the Copy desired features/options.
8. Enter the quantity.
9. Press Start.

One copy set of the job (the sample set) is printed and the remainder of the job is
placed on hold, and the machine is paused.

10. If desired, change any applicable setting and copy quantity.
11. Select either Start to finish the job or Cancel to stop the job.
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Selecting Start continues the copy process and the programmed number of sets will
be printed. Retrieve the copies from the output area.

12. Upon completion, press the Clear All button on the control panel to return the settings
to their default state.

Combine Original Sets

This feature allows you to copy sets of documents that cannot be loaded into the
document feeder. This is useful when copying documents that may be damaged, ripped
or torn, or too wrinkled to go through the document feeder. Combine Original Sets allows
you to copy each original by placing it on the document glass and creating one copy
job for the entire set.
1. Press the Home button on the press UI.
2. Select Copy on the Home window.
3. Select the Job Assembly tab.
4. From the Job Assembly tab, select Combine Original Sets.
5. Select either On or Off.

• On: Select this option to have the Next Original option highlighted on the copy
screen when scanning is in process.

• Off: Select this option to have the Last Original option highlighted on the copy
screen the scanning process is in process.

6. Select Save to save your choice.
This feature is available only when Collated is selected in the Copy Output window.

7. Load your documents into the document feeder or individually place them on the
document glass.

8. Program the job with the desired Copy features/options.
9.

10. Enter the quantity.
11. Press Start.
12. When you are finished scanning all the documents, select Last Original to complete

the job.
13. Retrieve the copies from the output area.

Delete Outside/Delete Inside

This feature allows you to specify the area for omission or deletion and then to copy
that area. Keep the following in mind when using this feature:

• When specifying multiple areas to delete, it is also possible to overlap and specify an
area.

• When selecting Reduce/Enlarge, the areas are reduced or enlarged by interlocking
magnification.

1. Press the Home button on the press UI.
2. Select Copy on the Home window.
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3. Select the Job Assembly tab.
4. Select Delete Outside/Delete Inside.

The Delete Outside/Delete Inside screen is displayed. By default, Off is selected.
5. Select either Delete Outside or Delete Inside.
6. If the originals are 2-sided, select the applicable option:

• Both Sides
• Side 1 Only
• Side 2 Only

7. Select the Area 1 button.
The Delete Outside/Delete Inside Area 1 screen is displayed; use this screen to define
the first area for deletion (omission) from the copy output.

8. To define a specific area, enter the two X/Y coordinates within a range 0.0-17.0 inches
(0.0-431.8 mm). Navigate from coordinate to coordinate by selecting each X/Y button:
a) Select the Y1 box and use the numeric keypad on the control panel to enter the

value for Y1.
b) Select the Y2 box and use the numeric keypad on the control panel to enter the

value for Y2.
c) Select the X1 box and use the numeric keypad on the control panel to enter the

value for X1.
d) Select the X2 box and use the numeric keypad on the control panel to enter the

value for X2.

Clear a deletion area by selecting the Clear Area X (1, 2, or 3) button.

9. Select Save.
10. Select Save again.
11. Select any other desired copy features/options.
12. Enter the quantity.
13. Press Start.
14. Retrieve the copies from the output area.
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5
Scan

Scan Overview
The Scan feature supports several methods for scanning and storing an original
document. This machine supports the following scan capabilities:

• Email: Scans a document and sends the scanned data as an e-mail attachment after
converting the data to TIFF, JPEG, PDF, DocuWorks®, or XPS (XML Paper Specification).

• Network Scanning: Scans a document using a job template that was created using
CentreWare® Internet Services (CWIS). When Scan to Home is enabled and the
Remote Access feature is available, the scanned data can be transferred to a different
destination according to an authenticated user.

• Scan to PC: Scans a document and sends the scanned data to a network computer
via the FTP or SMB protocol.

• Store to Folder: Scans a document and saves the scanned data in a folder on the
machine.

• Store to USB: Scans a document and saves the scanned data to a USB memory
device. (This is an optional feature.)

• Store & Send Link (Send to Folder): Scans a document and sends an e-mail notifying
the user of two URLs: one is for the location where the scanned data can be retrieved,
and second is for the location from which the data can be deleted.

• Store to WSD (Web Services on Device): Scan a job either at the press or by sending
a command from a network computer to the press. The scanned data is then sent to
a specified network computer.
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Basic Scanning

Basic Scanning Procedure
1. From the press UI, press the Clear All button.
2. Press the Home button.
3. Select the desired scan method.

• E-mail
• Network Scanning
• Scan to PC
• Store to Folder
• Send from Folder
• Store to USB
• Store & Send Link (Send to Folder)
• Store to WSD

4. Load your original documents either in the document feeder or on the document
glass.

5. Select the desired scan options.

• Color Scanning
• 2 Sided Scanning
• Original Type
• Scan Presets
• Advanced Settings
• Layout Adjustments
• E-mail Options or Filing Options

6. Press Start.
If using the document glass and multiple documents or multiple pages of a bound
original/book need to be scanned, the perform the following substeps:
a) Select Next Original, place the original to be scanned and select the Start button.
b) Continue until you are scanning the last original, select Last Original then select

the Start button.

7. Select Job Status on the UI to view the status of the scanned job.
8. Retrieve the original documents either from the Document Feeder or Document Glass.

Previewing Scanned Images
1. Scan the images and select job features.
2. While scanning, select Preview to preview the last page that was scanned.
3. From the drop-down menu, specify the view size by selecting Whole Page or Enlarge

View, and set Current Page.
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4. After the confirmation, select Close to close the preview screen.

Changing Scan Settings/Options

While your job is scanning, you can change settings to that job by performing the
following steps.
1. Select Next Original.
2. Select Change Settings.
3. Select the appropriate section and make select features. The following features can

be adjusted:

• Color Scanning
• 2 Sided Scanning
• Original Type
• Image Options (Lighten/Darken)
• Image Enhancement
• Resolution
• Quality/File Size
• Shadow Suppression
• Original Orientation
• Original Size
• Edge Erase
• Book Scanning
• Reduce/Enlarge

4. After your changes are complete, select Start.

Canceling a Scan Job
1. Either select Stop on the UI touch screen or press the Stop button on the UI control

panel.
2. On the UI control panel, press Cancel to end scanning or Start to restart the scan.
3. Press the Job Status button on the UI.
4. Select the job to cancel, and then press Stop.

Note
When a scan is canceled, scan data already stored to the mailbox is deleted.

Stopping a Scan Job
1. While a scan job is in process, Press either the Stop button on the UI control panel

or select Delete on the UI touch screen.
2. Select Delete.
3. If Delete does not appear on the screen, press the Job Status button on the UI control

panel.
4. Select the job to cancel and select Delete.
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Scan Options

Scan Options Overview

The following settings can be set for scan jobs.

• Basic Scan Options (shown on the first tab of the selected scan method window)
• Advanced Settings
• Layout Adjustment
• Email Options or Filing Options (depends upon the selected scan method)

Basic Scan Options

The basic scan options are shown on the first tab of the selected scan method. These
options include the following:

Color Scanning

Color Scanning options include:

• Auto Detect: The color of the document is determined automatically; the machine
scans in full color when the document is colored, otherwise, scans in monochrome.

• Color: Select this option to scan a color document.
• Black & White: Scans a document in monochrome two tones. You can select the

document type in Original Type.
• Grayscale: Scans a document in grayscale. Adds shades to monochrome, creating

intermediate tones that change gradually. Suited to documents containing gradations
that cannot be reproduced with monochrome (2-color tone).

2 Sided Scanning

2 Sided Scanning options include:

• 1 Sided: Select this option to scan only one side of the document.
• 2 Sided: Select this option when both sides of the 2-sided document are in the same

orientation.
• 2 Sided, Rotate Side 2: Select this option when both sides of the 2-sided document

are in opposite orientations.
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Original Type

Original Type options include:

• Photo & Text: Select this option when scanning a document that contains both text
and photos. The machine automatically identifies the text and photo areas and
scans each area with optimum quality.

• Text: Select this option when scanning text clearly.
• Photo: Select this option when scanning photos.

Scan Presets

Scan Presets options include:

• Sharing and Printing: This setting is best used for sharing files to be viewed on
screen and for printing most of the standard business documents. This setting results
in small file sizes and higher image quality.

• Archival Record: This setting is best used for standard business documents that are
stored for record keeping purposes. This setting results in the smallest file size and
normal image quality.

• Optical Character Recognition: This setting is best used for documents that are
processed by OCR software. This setting results in large file sizes and the highest
image quality.

• High Quality Printing: This setting is best used for documents that contain detailed
graphics and photos. This setting results in large file sizes and the maximum image
quality.

• Simple Scan: This setting is best used for faster processing but may result in
excessively large file sizes. Use this setting to apply the minimal amount of image
processing and compression.

Advanced Settings

The options for Advanced Settings are shown on the second tab of the selected scan
method; these options include the following:

Image Options

The Image Options include:

• Lighten/Darken: This option provides manual control to adjust the lightness or
darkness of the scanned images. Scroll down to darken the scanned image of light
originals such as pencil images. Scroll up to lighten the scanned image of dark
originals such as half tones or originals with colored backgrounds.

• Sharpness: This option controls the balance between sharp text and moiré (patterns
within the image). Move the slider control down (Soften) to produce an image with
a smooth, uniform appearance (ideally suited for photographic scanned images).
Move the slider control up (Sharpen) to produce an image with better quality text
or line art.
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Image Enhancement

The Image Enhancement options include:

• Background Suppression: This option prevents reproduction of unwanted shading
from originals where the opposite side printing shows through (translucent).

Off: This is the default setting. With background suppression off, originals are scanned
without filtering the document backgrounds.

Auto Suppression: This option automatically reduces or eliminates any background
on the output which may be caused by colored paper or newspaper originals. For
example, when Color Scanning is set to Black & White, the background of a
document printed on colored paper, such as newspaper, is suppressed. When Color
Scanning is set to Color, the background of a document printed on white-color paper
is suppressed.

• Contrast: This option controls the difference between the image densities within the
scanned image. Lower contrast settings reproduce more detail in light and dark areas
of the original. Higher contrast settings produce vivid blacks and whites for sharper
text and lines, but produce less detail in pictures.

Resolution

Choose one of four resolution settings:

• 200 dpi (dots per inch): This setting produces normal output quality and a small file
size. Use this setting for office documents and photos.

• 300 dpi: This setting produces a higher output quality and larger file size. Use this
setting for sharper scanning of office documents and photos.

• 400 dpi: This setting produces medium output quality and the largest file size. Use
this setting for high quality printing; this setting is suitable for fine lines and small
fonts than have been enlarged, and for documents with low image definition.

• 600 dpi: This setting produces maximum output quality and the largest file size. Use
this setting for high quality printing; this setting is suitable for fine lines and small
fonts than have been enlarged, and for documents with low image definition.

Quality/File Size

This feature allows you to select the ratio of data compression for color and grayscale
scanned images. Use the slider to choose from good image quality with small file size,
higher image quality with larger file size, or highest image quality with largest file size.

Note
This feature is unavailable whenever Black and White (Color Scanning) is selected.
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Photographs

This feature enhances the image for files that are scanned using photographic originals.
Select either Off (default setting) or Enhance Photographs.

Note
In order to use this feature, Color Scanning must be set for Color. Furthermore, when
Enhance Photographs is selected, Shadow Suppression and Background Suppression
are not available.

Shadow Suppression

Select Auto Suppression to hide background color and image bleed through for color
scanning. This feature is not available when Black and White is selected for Color
Scanning.

Layout Adjustment

The options for Layout Adjustment are shown on the third tab of the selected scan
method; these options include the following:

Original Orientation

Select the direction that your original lays either in the document feeder or on the
document glass. Select either Upright Images or Sideways Images.

Original Size

Select one of three options that indicate the size of your originals.

• Auto Detect: This option automatically detects the size of the scanned pages. All
standard sizes are automatically detected.

• Manual Size Input: This option allows you to select a standard paper size from the
options shown or to input a non-standard (custom) size.

• Mixed Size Originals: With this option the machine automatically detects the size
of each document.

Edge Erase

This option erases images around the border (margins) of a document.

• All Edges: This option erases a preset, equal amount from the top, bottom, left and
right margins.

• Print to Edge: This option does not erase any of the margins of the document.
• Individual Edges: This option independently erases each of the four margins in

differing amounts.
• Presets: This option erases preprogrammed amounts as set up by the System

Administrator. This includes preset options for Header/Footer Erase and Hole Punch
Erase.
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Book Scanning

Use this option to scan pages from bound originals. Options include:

• Left Page then Right: Scans the left page first and the right page of the bound
original’s facing pages.

• Right Page then Left: Scans the right page first and the left page of the bound
original’s facing pages.

• Top Page then Bottom: Scans the top page first and then the bottom page of the
bound original’s facing pages.

The following sub-options are also available:

• Both Pages: Scans both pages in page order.
• Left Page Only: Scans the left page only.
• Right Page Only: Scans the right page only.
• Top Page Only: Scans the top page only.
• Bottom Page Only: Scan the bottom page only.
• Binding Edge Erase: This option erases or deletes the shadow that is caused by the

center binding of the bound original.

Reduce/Enlarge

Use this option to select a reduction or enlargement value for the scanned document.

E-mail Options

E-mail Options is the fourth tab of the E-mail scan method, and options include the
following:

File Name

Use this option to enter a file name. If no name is entered, the system automatically
generates a file name.

Reply To

Use this option to enter a reply recipient email address.

Read Receipts

This option requests an email with the delivery status from the recipient to the sender.
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File Format

Select the desired file format for scanned data; options include:

• PDF: Saves scanned data in PDF format.
• PDF/A: Saves scanned data in the PDF/A format. PDF/A is used primarily for archiving

and long-term preservation.
• TIFF: Saves scanned data in TIFF format.
• JPEG: Saves scanned data in JPEG format. This option is selectable when either Color

or Grayscale is selected for Color Scanning.
• TIFF/JPEG Auto Select: Automatically selects JPEG or TIFF. The file format is

determined for each page: JPEG for full-color and grayscale pages, and TIFF for
monochrome pages.

• XPS (XML Paper Specification): Saves multiple pages into a single file.

Note
Options may vary and some options may not be available for your machine.

Additional File Format options

Depending on the selected file format, the following sub-options also are available:

• Compression Method: Allows you to select a compression method for the scanned
data.

• MRC High Compression: Allows you to save PDF and XPS files with high compression.
• Searchable Text: Allows you to select whether to perform character recognition in

PDF files.
• PDF Security: Allows you to configure security for the PDF output in order to prevent

unauthorized access.
• Optimize For Quick Web View: Optimizes the PDF file so that it is displayed faster

on a web browser.
• Add Thumbnail: Allows you to attach thumbnails to XPS files when XPS is selected.

A thumbnail is a reduced, small file size image that helps you check the file contents.
• Single File for Each Page: Saves each page as a single file in the specified format.
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Compression Method options

When Manual Select is chosen for the Compression Method, some or all of the
following options are available.

For black and white images/pages only, select one of the following options:

• Modified Modified Read (MMR): This setting is automatically selected when either
Photo and Text or Text is chosen for Original Type.

• Modified Huffman (MH): This setting is automatically selected when Photo is chosen
for Original Type.

• JBIG2 Arithmetic Encoded: This process has better compression performance than
the Huffman encoded process. However, the compression rate is slower than Huffman
encoded and it uses more memory but yields better compression results.

Note
JBIG stands for Joint Bi-level Image experts Group. JBIG compresses only black and
white images.

• JBIG2 Huffman Encoded: Huffman coding takes less page memory and has faster
compression and decompression than the arithmetic coding. Use this option if
high-quality compression results do not matter and you want to use less page
memory.

For grayscale or color images/pages, select one of the following options:

• JPEG: This is the default setting for grayscale/color pages.
• Flate: This option saves the image data at a higher compression rate than JPEG.

Flate is lossless and does not remove data during the compression process.

PDF Security options

The following PDF Security options are available when selecting E-mail Options  >
File Format  > PDF  > PDF Security  > Password:

• Encryption Algorithm: Choose one of three encryption methods:

- 128-bit RC4: Encrypts the file by using the 128-bit RC4 method. Files encrypted
with this method can be opened with Adobe® Acrobat® 5.0 or later.

- 128-bit AES: Encrypts the file by using the 128-bit AES method. Files encrypted
with this method can be opened with Adobe® Acrobat® 7.0 or later.

- 256-bit AES: Encrypts the file by using the 256-bit AES method. Files encrypted
with this method can be opened with Adobe® Acrobat® 9.0 or later.

• File Open Password: This option sets a password for opening the PDF. The recipient
of the PDF file must know the password before it can be opened.

• Permissions: This option adds restrictions to the PDF file which prevents unauthorized
printing or editing of the file. The recipient of the PDF must know the permissions
password in order to remove these restrictions.
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Filing Options
Note
Filing Options is not available with the E-mail scan method.

Filing Options is the fourth tab of the selected scan method, and options include the
following:

File Name

Use this option to enter a file name. If no name is entered, the system automatically
generates a file name.

File Name Conflict

Use this option to resolve file name conflicts. Choices include:

• Do Not Save: Cancels the scan operation so that you can enter another file name.
• Rename New File: Attaches a 4-digit number (0000-9999) to the end of the duplicate

file name and saves the file in the same directory.
• Overwrite Existing File: Deletes the existing file with the duplicate file name and

saves the new file with the specified file name in the same directory.
• Add to Existing Folder: Adds the scanned file to the existing folder and overwrites

any other file that has the same file name.
• Add Date Stamp to File Name: Adds the current date to the name of the new file.

File Format

Select the desired file format for scanned data; options include:

• PDF: Saves scanned data in PDF format.
• PDF/A: Saves scanned data in the PDF/A format. PDF/A is used primarily for archiving

and long-term preservation.
• TIFF: Saves scanned data in TIFF format.
• JPEG: Saves scanned data in JPEG format. This option is selectable when either Color

or Grayscale is selected for Color Scanning.
• TIFF/JPEG Auto Select: Automatically selects JPEG or TIFF. The file format is

determined for each page: JPEG for full-color and grayscale pages, and TIFF for
monochrome pages.

• XPS (XML Paper Specification): Saves multiple pages into a single file.

Note
Options may vary and some options may not be available for your machine.
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Additional File Format options

Depending on the selected file format, the following sub-options also are available:

• Compression Method: Allows you to select a compression method for the scanned
data.

• MRC High Compression: Allows you to save PDF and XPS files with high compression.
• Searchable Text: Allows you to select whether to perform character recognition in

PDF files.
• Optimize For Quick Web View: Optimizes the PDF file so that it is displayed faster

on a web browser.
• Add Thumbnail: Allows you to attach thumbnails to XPS files when XPS is selected.

A thumbnail is a reduced, small file size image that helps you check the file contents.
• Single File for Each Page: Saves each page as a single file in the specified format.

Compression Method options

When Manual Select is chosen for the Compression Method, some or all of the
following options are available.

For black and white images/pages only, select one of the following options:

• Modified Modified Read (MMR): This setting is automatically selected when either
Photo and Text or Text is chosen for Original Type.

• Modified Huffman (MH): This setting is automatically selected when Photo is chosen
for Original Type.

• JBIG2 Arithmetic Encoded: This process has better compression performance than
the Huffman encoded process. However, the compression rate is slower than Huffman
encoded and it uses more memory but yields better compression results.

Note
JBIG stands for Joint Bi-level Image experts Group. JBIG compresses only black and
white images.

• JBIG2 Huffman Encoded: Huffman coding takes less page memory and has faster
compression and decompression than the arithmetic coding. Use this option if
high-quality compression results do not matter and you want to use less page
memory.

For grayscale or color images/pages, select one of the following options:

• JPEG: This is the default setting for grayscale/color pages.
• Flate: This option saves the image data at a higher compression rate than JPEG.

Flate is lossless and does not remove data during the compression process.
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Resolving a File Name Conflict
Note
This option is not available with some of the scan methods.

1. Select the Filing Options tab.
2. Select the File Name Conflict option.
3. Select the appropriate option:

• Do Not Save: Cancels the scan operation so that you may enter another file
name.

• Rename New File: Attaches a 4-digit number (0000-9999) to the end of the
duplicate file name and saves the file in the same directory.

• Overwrite Existing File: Deletes the existing file with the duplicate file name
and saves the new file with the specified file name in the same directory.

4. Select Save.

E-mail

E-mail Overview

The E-mail feature scans a document and sends the scanned data as an e-mail
attachment to one or more recipients.

E-mail Components

New Recipient

If the recipient of the e-mail cannot be found in the address book, select New Recipient
option to add the address in the To, Cc, or Bcc field of the e-mail. A maximum of 128
characters may be entered for a single e-mail address.

Address Book

Use the address book to find and add recipients in the To, Cc, or Bcc fields of the e-mail.

• List all public entries: This option displays the local address list which resides on the
machine.

• Retrieve entries using index: This option displays a keyboard allowing you to enter
characters and narrow the search to specific recipients.

• Search Public: This option searches for entries in the local address list.

Note
The address book displays only entries that were previously added by the system
administrator. A maximum of 2,000 addresses may be stored in the address book.
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Add Me and From fields

By default, these fields are not available for use. The system administrator must change
the settings for these fields before they can be used.

When these fields are available for use, enter the sender’s e-mail address in the From
field and send a copy of the e-mail to the sender by selecting Add Me. A maximum of
128 characters may be entered for the sender’s address in the From field.

Recipient(s) field

From this field, an e-mail address can be edited or removed by selecting a specific
recipient.

Subject

Use this field to enter the subject of the e-mail. A maximum of 128 characters may be
entered for the subject line.

Message

Use this field to enter a message to the recipient. A maximum of 512 characters may
be entered for the e-mail body text.

Preview

Select this check box in order to preview the scanned images/data.

Note
Scanned images/data cannot be previewed with E-mail Options > File Format > MRC
High Compression > On.

Scanning to an E-mail Address
1. From the UI, press the Clear All button.

This clears all previous settings from the machine.
2. Press the Home button.
3. Select E-mail.
4. Specify one or more recipients by choosing one of the following options:

• Select New Recipient.

1. Use the keyboard to enter the entire address.
2. Select Add.
3. If sending to multiple recipients, repeat the previous sub-steps until finished.
4. Select Close.

• Select Address Book.

1. Select Address Book.
2. Select one of the choices from the pull-down menu (such as List all public

entries).
3. Select the desired recipient.
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4. Select one of the fields To, Cc, or Bcc.
5. If sending to multiple recipients, repeat the previous sub-steps until finished.
6. Select Close.

5. If applicable, perform the following:

• Select From and add the sender e-mail address.
• To send a copy of the email to the sender, select Add Me.
• Edit or remove recipients from the Recipient(s) field.
• Select Subject to enter and save an e-mail subject.
• Select Message to enter and save the e-mail message.

6. Load your original documents either in the document feeder or on the document
glass.

7. Select the desired scan options.
8. Press Start to begin scanning.
9. Retrieve the original documents from either the Document Feeder or the Document

Glass.

Network Scanning

Network Scanning Overview

This feature scans documents after selecting a specific job template and choosing other
scan options such as the forwarding destination server. Job templates are created by
using CentreWare Internet Services. Scanned data is converted to the format specified
in a job template, and is automatically sent to a server. The machine allows you to
automatically retrieve the job templates that are stored in a server.

When Scan to Home is enabled, and when the Remote Access feature is available, the
scanned document can be transferred to a different destination according to an
authenticated user.

Note
In order to use Network Scanning, job templates must be created and set up by the
system administrator. The system administrator uses CentreWare Internet Services to
create and set up Job templates. Refer to the System Administration Guide for detailed
information.
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Network Scanning Components

Job templates

On the Network Scanning tab, this is a list of available job templates. Select the desired
template to use for your network scanning job. If a template is not listed, contact your
system administrator.

DEFAULT: This is the default job template. When a new template is created from
CentreWare Internet Services, it is based on the default template. This template cannot
be deleted. It can be edited and returned to the factory-default template only by the
system administrator.

Go To

Use the numeric keypad to enter a 3-digit job template number. The job template then
appears at the top of the list.

Template Description

This displays the Template Description screen. This button is available for selection
only when a description has been added to a job template.

Update Templates

Select this button to refresh the information. If a created job template is not displayed,
select Update Templates to display all the job templates.

Network Scanning Procedure

On the Network Scanning window, you can scan documents after specifying a file (job
template) saving scanning conditions, information on the forwarding destination server,
and others. This feature creates job templates on a computer using CentreWare Internet
Services. Scanned data is converted to the format specified in a job template, and is
automatically sent to a server. The machine allows you to automatically retrieve job
templates stored in a server. When Scan to Home is enabled, and when the Remote
Access feature is available, the scanned document can be transferred to a different
destination according to an authenticated user.
1. From the UI, press the Clear All button.
2. Press the Home button.
3. Select Network Scanning.
4. Select a template.
5. Load your original documents either in the document feeder or on the document

glass.
6. Select Preview.

a) From the drop-down menu, specify the view size by selecting Whole Page or
Enlarge View, and set Current Page.

b) After the confirmation, select Close to close the preview screen.

7. Select the desired scan options.
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8. Press Start to begin scanning.
9. Retrieve the original documents from either the Document Feeder or the Document

Glass.

Scan to PC

Scan to PC Overview

The Scan to PC service allows you to scan documents and send the scanned data to a
network computer using the FTP or SMB protocol.

Scan to PC Components

Transfer Protocol

The Scan to PC service allows you to scan documents and send the scanned data to a
network computer using the FTP or SMB protocol. Specify the protocol to use when
selecting Transfer Protocol. Choices include:

• FTP
• SMB
• SMB (UNC Format): UNC stands for Universal Naming Convention and its format

is as follows: \\host name\shared name\directory name

Address Book

Specify the recipient from the Address Book.

Browse Network for PC

Specify a destination PC by browsing your network. Selecting browse will displays a
hierarchy consisting of available server names and folders.

Specify Destination

Use this option to specify a destination PC using the screen keyboard, Enter information
in the fields provided for the selected protocol, to specify a forwarding destination.

How to Use the Scan to PC Feature

Using the Scan to PC Feature

Before performing the following procedure, ensure that a shared folder is created on
your computer; this folder is where the scanned data will be stored.
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The Scan to PC service allows you to scan documents and send the scanned data to a
network computer using the FTP or SMB protocol.
1. From the UI, press the Clear All button.
2. Press the Home button.
3. Select Scan to PC.
4. Select the desired Transfer Protocol.
5. Select Save.
6. Choose the Save in destination where the data will be stored:

• Address Book; for instructions, refer to Using the Address Book to Specify a Scan
to PC Destination.

• Browse the network for a destination PC; for instructions, refer to Browsing the
Network for a Scan to PC Destination.

• Use the UI screen keyboard; for instructions, refer to Specifying a Scan to PC
Destination Using the UI Keyboard.

7. Load your original documents either in the document feeder or on the document
glass.

8. If desired, select Preview.
9. Select the desired scan options.

10. Press Start to begin scanning.
11. Retrieve the original documents from either the Document Feeder or the Document

Glass.

Using the Address Book to Specify a Scan to PC Destination
1. From the main Scan to PC tab window, select Address Book.
2. The Address Book was previously setup (contains address information):

• Yes: Continue to the next step
• No: See your System Administrator; only the administrator can setup entries in

the Address Book.

3. Select a recipient from the Name/Protocol list.
4. Select Add.

This adds the recipient to the Save in box.
5. Select Close to save and close the window.

Complete the steps in the procedure Using the Scan to PC Feature.

Browsing the Network for a Scan to PC Destination
1. From the main Scan to PC tab window, select Browse.
2. Select the destination for saving the data by locating a file:

• Select Previous to move to an upper directory.
• Select Next to move to a lower directory.

3. To add the selected destination to the address book, perform the following substeps:
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a) Select Add to Address Book.
b) Select Save.

The Browse window is displayed.

4. Select Save to save and close the Browse window.

Complete the steps in the procedure Using the Scan to PC Feature.

Specifying a Scan to PC Destination Using the UI Keyboard
1. From the main Scan to PC tab window, select inside the Server field.

The UI screen keyboard is displayed.
2. Enter information to identify the server using the keyboard.

For the Server name, enter a server name or IP address. When the save location is in
the DFS namespace on Windows, enter a domain name or server name. Up to 64
characters are allowed.

3. Select Save.
4. Select inside the Shared Name field and enter a shared name.

When the save location is in the DFS namespace on Windows, enter a root name. Up
to 64 characters. This option is only available when you select SMB in Transfer
Protocol.

5. Select Save.
6. Select inside the Save In field and enter a directory path.

When the save location is in the DFS namespace on Windows, enter a folder name.
Up to 128 characters. This option is only available when you select FTP or SMB in
Transfer Protocol.

7. Select Save to save and return to the main Scan to PC tab window.
8. Select inside the User Name field then enter the user name of the computer to which

you are forwarding the data.
When a user name is not required for the destination, this field can be skipped.

9. Select Save.
10. Select inside the Password field and enter the password for the user name.

Up to 32 characters are allowed.

11. Select Save.

Complete the steps in the procedure Using the Scan to PC Feature.

Store to Folder

Store to Folder Overview

Use the Store to Folder option to scan documents and save the scanned data in a folder
of the machine.
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Note
Folders must be created before using the Store to Folder feature. Refer to the System
Administration Guide for detailed information and instruction on creating folders.

Store to Folder Components

Use the Scan to Folder option to scan documents and save the scanned data in a folder
of the machine.

Folder

Select a folder to save the scanned data in. Select the up arrow to return to the previous
screen, or the down arrow to move to the next screen.

Go to

Use the numeric keypad to enter a 3-digit folder number. The folder then appears at
the top of the list.

File List

Select a folder and then select this button to display the File List screen. You can confirm
or delete files stored in the folder.

Using the Store to Folder Feature
Note
Folders must be created before using the Store to Folder feature. Refer to the System
Administration Guide for detailed information and instruction on creating folders.

1. From the press UI, press the Clear All button.
2. Press the Home button.
3. Select Store to Folder.
4. Select the desired destination folder.
5. Load your original documents either in the document feeder or on the document

glass.
6. Select the desired scan options.
7. Press Start to begin scanning.
8. Retrieve the original documents from either the Document Feeder or the Document

Glass.
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Store to USB

Store to USB Overview

The Store to USB allows you to scan documents and save the scanned data to a USB
memory device.

Use the following USB memory devices:

• A formatted USB memory device
• A USB 2.0 compliant memory device (USB 1.1 is not supported.)
• A USB memory device with a storage capacity of up to 128 GB

Before using the Store to USB feature, review the following information:

• A USB memory device encrypted with software is not supported.
• A commercially available Memory Card Reader with a single slot can be used for this

feature, but the safe performance of this reader is not guaranteed. When a Memory
Card Reader with multiple slots is used, only one particular slot is available.

• When a USB memory device is inserted into the USB memory slot during the Energy
Saver mode, the UI touch screen does not light. After exiting the Energy Saver mode
by pressing the Energy Saver button, insert the USB memory device again or select
Store to USB on the Home window.

• Before removing the USB memory device, make sure that a window indicating that
data is being transferred is not displayed. If you remove the USB memory device
while the data is being stored, the data in the device may be damaged. You can also
view Job Status to confirm if the data has been stored to the USB memory device.

Using the Store to USB Feature
1. Load your original documents either in the document feeder or on the document

glass.
2. Insert the USB memory device into the USB memory slot on the front of the press

(near the User Interface).
One of the following happens:

• The USB Device Detected window displays.
• The Store to USB window displays.
• The Media Print - Text window displays.
• The UI touch screen does not change.

3. Choose one of the following options:

• If the USB Device Detected window displays, perform the following:

1. On the press UI, select Store to USB.
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2. Go to Step 4.

• If the Store to USB window displays, go to Step 4.
• If either the Media Print - Text window displays, or if the UI touch screen does not

change, perform the following:

1. On the press UI, press the Home button.
2. Select Store to USB.
3. Go to Step 4.

4. From the main Store to USB window, select Save in.
5. Select a folder in which to save the scanned data.

This will be a folder location on the USB memory device.

6. Select Save.
The main Store to USB window displays.

7. Select the desired scan options.
8. If desired, select Preview.
9. Press Start to begin the scanning process.

10. Retrieve the original documents from either the Document Feeder or the Document
Glass.

Store and Send Link Feature (Send to
Folder)

Store and Send Link (Send to Folder) Overview
Tip
This feature may not be available in all marketplaces.

Note
The Store & Send Link feature is also referred to as the Send to Folder feature.

If an authenticated user scans a document, the press temporarily saves the scanned
data, and automatically obtains the user's e-mail address that was registered in advance.
The press then sends an e-mail notifying the user of two URLs:

• One URL is for the location where the scanned data can be retrieved.
• The second URL is for the location from which the data can be deleted.

Tip
Only the authenticated user who logs into the press can be the recipient of an e-mail
transmission. The press cannot send e-mail to multiple recipients.

After receiving the e-mail on a computer, the user can retrieve the scanned data using
a web browser.
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Review the following information before using the Store & Send Link (Send to Folder)
feature:

• Scan files stored in the machine will be automatically deleted when the retention
period expires.

• This retention period can be specified in URL File Expiration option by the System
Administrator in the range of 1 to 168 hours. The default value is 3 hours.

• The files will always be deleted automatically.
• To strengthen security, after retrieving the scanned data, access the second URL to

delete the scanned data stored in the machine.
• The Store & Send Link feature does not provide the following document management

features:

- Backing up and/or restoring files,
- Deleting all the data at one time,
- Listing files, and
- Displaying available storage space.

• The Store & Send Link feature allows you to retrieve scanned data without specifying
an e-mail address from the Address Book or from a folder for each scan job. However,
the size of the data and its retention period are restricted on the press. If you want
to avoid these restrictions, use the Scan to PC or E-mail service.

• For more information, refer to the System Administration Guide.
• You can customize the layout of the features displayed on the Store and Send Link

feature. For more information, refer to System Administration Guide.

Storing and Sending a Link (Sending to Folder)
1. Press the Log In/Out button on the UI or select the login information field on the UI

touch screen.
2. Enter the user ID.
3. Select Store & Send Link on the UI Home window.

The system automatically obtains the preregistered e-mail addresses of the
authenticated users and displays them in the Scan To and From fields.

4. Select inside the Subject and Message fields to enter the desired information.
A maximum of 128 characters may be used for the Subject field, and a maximum of
512 characters may be used for the Message field.

5. Load your original documents either in the document feeder or on the document
glass.

6. If desired, select Preview.
7. Select the desired scan options.
8. Press Start to begin scanning.
9. Retrieve the original documents from either the Document Feeder or the Document

Glass.
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Store to Web Services for Devices (WSD)

Store to WSD Overview
Note
WSD stands for Web Services for Devices.

Use the Store to WSD feature to scan a job either at the press or by sending a command
from a network computer to the press. The scanned data is then sent to a specified
network computer.

The following options are available with Store to WSD:

• Computer: Select this option to start a scan job by sending a request from a network
computer, and then forward the scanned data to a network computer. The scan job
will be operated from the network computer.

- To operate the scan job from a network computer, use an application which
supports image loading feature such as Windows Fax and Scan.

- Windows Fax and Scan is not available for computers with Windows Vista Home
Basic or Windows Vista Home Premium. To perform a scan from such a computer,
use a different method, for example, using the Paint application and selecting
the option From Scanner or Camera.

• This Device: Select this option to start a scan job from the press UI, and then forward
the scanned data to a network computer. When this option is selected a list of
available computers is displayed; from this list select the computer that will receive
the scanned data.

- When This Device is selected, a List of Components is displayed.
- This list shows computer names and four processing methods including Scan to

User PC (this is a specified network computer), Scan for Print to User PC, Scan
for E-mail to User PC, and Scan for OCR to User PC.

How to Use the Store to Web Services for Devices (WSD) Feature

Using the Store to WSD Feature
1. From the press UI, press the Clear All button.
2. Load your original documents either in the document feeder or on the document

glass.
3. Press the Home button.
4. Select Store to WSD.
5. From the Start Scan Job From window, choose one of the following options:

• Computer; go to Starting a Scan Job from a Network Computer
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• This Device; go to Starting a Scan Job from This Device

Starting a Scan Job from a Network Computer
Ensure that the original documents are loaded and that Computer is selected on the
Start Scan Job From window.

Note
The following procedure describes the scan method using Windows Fax and Scan with
Windows 7.

1. Select Operate from Computer.
The UI displays a standby message stating that a scan job is waiting.

2. To exit the standby mode, select Delete.
The UI displays a Remove Your Original message.

3. Remove your originals and select OK.
4. Reload your originals.
5. From the network computer, select Start  > All Programs  > Windows Fax and Scan
6. At the bottom of the left pane, select Scan, and then select New Scan from the

toolbar.
7. In the New Scan dialog box, select Change, and then select the press.

Ensure that the press model name is displayed; it will be shown to the right of Scanner.
If the press model name is not displayed, select Change, and then select the press.

8. Select the Profile list, and then select Document.
9. Select the desired scan options.

10. Select Scan.
After the documents are scanned, the scanned data is forwarded to the specified
computer.

11. The press UI displays a Remove Your Original message.
a) Remove your original documents from the press Document Feeder or Documennt

Glass.
b) Select OK on the press UI.

12. The UI displays a standby message stating that a scan job is waiting.

• Yes: The press cannot start another scan job even though the network computer
recognizes the press. Clear the press; go to the next step.

• No: The scan job is completed and the press is ready for other copy/print jobs.

13. From the UI, select Delete.
The scan operation is stopped. The UI displays a Remove Your Original message.

14. Remove your originals and select OK.
The scan job is completed and the press is ready for other copy/print jobs.

Starting a Scan Job from This Device
Ensure that the original documents are loaded and that This Device is selected on the
Start Scan Job From window.
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Note
This procedure is done from the press UI.

1. From the List of Components, select a destination.
2. Press the Start button.

The scanned date will be forwarded to the specified destination.
3. Retrieve the original documents from either the Document Feeder or the Document

Glass.
4. Check the forwarded data on the destination computer.
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6
Send from Folder (Folder /
File Management)

Send from Folder (Folder / File
Management) Overview
The Send from Folder feature allows you to access and manage folders and files that
were saved on the press. Folder/file management includes the following functions:

• Access the saved files
• Review the details of the files
• Print the files
• Rescan the files
• Send the files in an email
• Retrieve the email (with the file attachment) from a network computer
• Delete the files
• Create automatic routine tasks
• Register/create private folders and/or shared folders

File Options
The following options are available:

• Refresh: Displays the updated information.
• List: Lists the files stored in the folder, with their stored dates and pages.
• Thumbnail: Displays the images and names of the files stored in the folder.
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• Number of Files: Displays the number of files stored in the selected folder.
• Select All: Allows you to select all the files in the folder. If you select Select All again,

all the files are deselected.
• Delete: Allows you to delete the selected files in the folder.
• File Details: Previews the selected file to allow you to check its details, and copy or

move it to another folder.
• Job Flow Settings: Allows you to create, link, and execute job flows.
• Print: Allows you to print selected files separately.
• Batch Print: Allows you to print multiple files as one file.

File Details Option

For the File Details option, these additional selections are available:

• Whole Page: Allows you to select whether to display the whole page or to enlarge
the image by 200%. You can select the view size from Whole Page and Enlarged
View. A small-sized document cannot be enlarged even if you select Enlarged View.
You can rotate or enlarge the image of the file in a folder in preview, but cannot save
the file with the image rotated or enlarged.

• No Rotation: Allows you to select an angle to preview the image from Right 90
degrees, Left 90 degrees, and 180 degrees. You can rotate or enlarge the image of
the file in a folder in preview, but cannot save the file with the image rotated or
enlarged

• Change File Name: Allows you to change the file name. Use the displayed keyboard
to enter a new name.

• Current Page: Allows you to specify a page to preview on the screen using + and - or
the numeric keypad.

Print Option

For the Print option, these additional selections are available:

• Paper Supply: Select the desired paper tray.
• 2 Sided Printing: Select 2-sided printing.
• Output: Select the desired output options including stapling, hole punching, and

which finishing tray to deliver the printed output.
• File Details: Displays a preview image of the selected file.
• Print Quantity: Select the number of print sets.
• Print: Prints the selected file.

Batch Print Option

The Batch Print option allows you to select batch printing. You can print multiple files
as one file. A maximum of 100 files can be bound in the selected order.
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Note
For 2-sided printing, the last page becomes blank when the total number of printed
pages is odd. For printing of multiple files, a blank page is inserted after the final page
of each file. If a different size document is included in multiple files, it may be printed
in improper orientation.

These additional options are available with Batch Print:

• Paper Supply: Select the desired paper tray.
• 2 Sided Printing: Select 2-sided printing.
• Output: Select the desired output options including stapling, hole punching, and

which finishing tray to deliver the printed output.
• File Details: Displays a preview image of the selected file.
• Print Quantity: Select the number of print sets.
• Print: Prints the selected file.

Managing Folders and Scanned Files
1. From the UI, press the Clear All button.
2. Press the Home button.
3. Select Send from Folder.
4. Select a folder.
5. Select a file from the folder list.
6. From the drop-down menu, select how to display the file:

• List
• Thumbnail

7. Select one or more other options.

• Refresh
• Number of Files
• Select All
• Delete
• File Details
• Job Flow Settings
• Print
• Batch Print
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How to Configure/Start a Job Flow

Configuring/Starting a Job Flow

The Send from Folder feature allows you to configure and/or start a job flow. Refer to
the following information for the various job flow settings and options that are available
in the Send from Folder feature.

Job Flow Settings

The options available with Job Flow Settings include the following:

• Auto Start: This sets auto start of the job flow for files stored in the folder. The job
flow automatically starts when a file is stored.

• Start Current Job Flow: Select files in the folder, and then select this button to start
the job flow linked to this folder. After executing the job flow, confirm from Job Status
or print a Job History Report to check the result.

• Cut Link: Cancels the link between a folder and the linked job flow sheet.
• Create/Change Link: Displays the Link Job Flow Sheet to Folder window.
• Select Job Flow Sheet: Select this button while files are selected to display the Select

Job Flow Sheet screen.

Create/Change Link

The settings available with the Create/Change Link option include the following:

• Refresh: Displays the updated file information.
• Create: Displays the Create New Job Flow Sheet window.
• Edit/Delete: Displays the Details window.
• Search by Name: Searches for job flows that partially match the entry. The machine

searches through job flow names that were registered upon each job flow creation.
The entry can be up to 128 characters.

• Search by Keyword: Searches for job flows that fully match the entry. The machine
searches through keywords that were registered upon each job flow creation. The
entry can be up to 12 characters. You can select from preset keywords if they have
been registered in the System Administration mode.

• Select by Keyword: Displays the Select Keyword window. Select a keyword registered
in the System Administration mode to search for job flows. Job flows that fully match
the entry are searched. The machine searches through keywords that were registered
upon each job flow creation.

• Sheet Filtering: Displays the Sheet Filtering window. Sheet Filtering allows you to
filter the job flow sheets that are displayed. Displayed job flow sheets may vary
depending on the Authentication feature.
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Select Job Flow Sheet

The settings available with the Select Job Flow Sheet option include the following:

• Start: Executes the selected job flow sheet.
• Refresh: Displays updated information.
• Details: Displays the Details window.
• Change Settings: If the selected job flow sheet setting is editable, the Change Settings

window appears. You can temporarily change the settings.
• Search by Name: Searches for job flows that partially match the entry. The machine

searches through job flow names that were registered upon each job flow creation.
The entry can be up to 128 characters.

• Search by Keyword: Searches for job flows that fully match the entry. The machine
searches through keywords that were registered upon each job flow creation. The
entry can be up to 12 characters. You can select from preset keywords if they have
been registered in the System Administration mode.

• Select by Keyword: Displays the Select Keyword window. Select a keyword registered
in the System Administration mode to search for job flows. Job flows that fully match
the entry are searched. The machine searches through keywords that were registered
upon each job flow creation.

• Sheet Filtering: Displays the Sheet Filtering window. Sheet Filtering allows you to
filter the job flow sheets that are displayed. Displayed job flow sheets may vary
depending on the Authentication feature.

Sheet Filtering Options

Sheet Filter options include the following:

• Owner:

- System Administrator - If this box is checked, the only Job Flow Sheets available
to the System Administrator are displayed.

- Non-System Administrator - If this box is checked, Job Flow Sheets displayed do
not include those available to the System Administrator.

- No Filtering - When both the System Administrator and Non-System Administrator
boxes are checked, all the Job Flow Sheets are displayed.

• Target: Place a check in each job type you want displayed.

Using Send from Folder to Link a Job Flow Sheet to a Folder
1. From the UI, press the Clear All button.
2. Press the Home button.
3. Select Send from Folder.
4. Select a folder, if required.
5. Select the files from the folder list.
6. Select the desired Job Flow option.

• Auto Start
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• Start Current Job Flow
• Cut Link
• Create/Change Link
• Select Job Flow Sheet

7. To link a specific job flow sheet, choose Select Job Flow Sheet.
a) Select a desired job flow sheet.
b) Select Job Flow Settings.
c) Select Create/Change Link.
d) Select any option.

If Sheet Filtering is selected, select the desired filtering conditions, and then select
Save.

e) From the Link Job Flow Sheet to Folder window, select Save.

8. Select Start to run the job flow.
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7
Job Flow

Job Flow Overview
Job Flow is a feature that allows you to register transfer settings of scanned data, such
as a transfer method and destination; this simplifies data-transfer tasks. Job flow sheets
are categorized into two types according to the target:

• One type of job flow sheet targets files stored in folders, and
• The other type targets scan files

Automatic/Manual Starting a Job Flow

A Job Flow is started in the following ways:

• Automatically when a document/file is linked to a folder
• Manually selecting a Job Flow to act on the documents/files stored in the folder.

To automatically start a job flow, you must create a link with a folder and a job flow
sheet in advance. Files are automatically processed with the job flow sheet when they
are stored in the linked folder.

Acceptable Features to Register

You can register the following features:

• Forward: Multiple forwarding recipients can be configured for each forwarding
method.

- FTP: Forwards via FTP. A maximum of two recipients can be specified.
- SMB: Forwards via SMB. A maximum of two recipients can be specified.
- Mail: Forwards via email. A maximum of 100 recipients can be specified.

• Email Notification: Job results may bes sent by email.
• Print: Files in a folder may be printed.
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Job Flow Restrictions

A job flow sheet can be used by only one user, can be shared by multiple users, or can
be used for only certain folders.

Only the Job Flow Sheets that you have permission to execute are displayed.

Job Flow Settings and Options

Overview of Job Flow Options
Note
Created Job Flow Sheets can be executed, modified, duplicated, or deleted only from
the folder in which it was created.

Job Flow options include the following:

• Refresh: Displays updated information.
• Details: Displays the Details window. You can confirm the details of a job flow such

as the name, last updated date, target, owner, and save location. When you select
the information (i) button, the entire description of the job flow sheet is displayed.

• Change Settings: If available, this option allows you to change the job flow settings.
• Search by Name: Searches for job flows that partially match the entry. The machine

searches through job flow names that were registered upon each job flow creation.
The entry can be up to 128 characters.

• Search by Keyword: Searches for job flows that fully match the entry. The machine
searches through keywords that were registered upon each job flow creation. The
entry can be up to 12 characters. You can select from preset keywords if they have
been registered in the System Administration mode.

• Select by Keyword: Displays the Select Keyword window. Select a keyword registered
in the System Administration mode to search for job flows. Job flows that fully match
the entry are searched. The machine searches through keywords that were registered
upon each job flow creation.

• Sheet Filtering: Displays the Sheet Filtering window. Sheet Filtering allows you to
filter the job flow sheets that are displayed. Displayed job flow sheets may vary
depending on the Authentication feature.

Additional Job Flow Options

Additional job flow options include the following:

• Name: Set the name for the job flow using a maximum of 128 characters.
• Description: Set the description of the job flow using a maximum of 256 characters.
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• Keyword: Used to search for a Job Flow Sheet using a maximum of 12 characters.
For example, enter Accounting as a keyword to access any Job Flow Sheets that
contain Accounting in the Job Flow name.

• Send as E-mail: Specify the recipients for the e-mail. You can specify a total of up to
100 addresses. Select from the address book numbers or by direct input by using the
keypad.

• Transfer via FTP (1), Transfer via FTP (2): Specify the server where documents are
sent using SMB protocols. When the server address is registered in the address book,
you can specify the address from the address book. The specified address appears
in the SMB Transfer window.

• Transfer via SMB (1), Transfer via SMB (2): Specify where SMB forwarding is to be
stored.

• Print: Configure the print settings. When On is selected, you can configure the settings
for the Print feature.

• E-mail Notification: You can receive an e-mail notification when a file is saved in a
folder or a job flow ends.

• Edit/Delete: Review the content of the job flow sheet, and edit, copy, or delete it.
Additonal options include: Edit, Delete, and Copy.

Sheet Filtering Options

Sheet Filter options include the following:

• Owner:

- System Administrator: If this box is checked, the only Job Flow Sheets available
to the System Administrator are displayed.

- Non-System Administrator: If this box is checked, Job Flow Sheets displayed do
not include those available to the System Administrator.

- No Filtering: When both the System Administrator and Non-System Administrator
boxes are checked, all the Job Flow Sheets are displayed.

• Target: Place a check in each job type you want displayed.

Send as E-mail Options

The settings available with the Send as E-mail option include the following:

• Address Book: The recipients can be specified from address book. The specified
recipient appears in Recipient Name/E-mail Address in the Send E-mail screen.

• New Recipient: Specify a new recipient. The specified recipient appears in Recipient
Name/E-mail Address in the Mail Send screen.

• Name/E-mail Address: Displays the recipient name or e-mail address specified.
• Subject: If desired, set a specific subject.
• Delete Recipient: Deletes all the information for the selected recipient.
• Edit: Allows you to check or change the information for the selected recipient.
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• File Format: Specify the output file format.
• Resend Attempts: Set the amount of times you want to resend an E-mail or to switch

off the feature. If you select On, set the number of resend attempts and time interval:

- Resend Attempts: Set the number of times to resend an email between 1-5.
- Resend Interval: Set the transmission retry interval from 30-300 seconds.

Transfer via FTP (1) / Transfer via FTP (2) Options

The additional settings available with the Transfer via FTP (1) / Transfer via FTP (2)
option include the following:

• Address Book
• File Format
• Resend Attempts
• Name, Server, Save, User Name, and Password: The maximum number of characters

for each item is:

- Name: Maximum 18 single-byte characters
- Server: Maximum 64 single-byte characters
- Save in: Maximum 128 single-byte characters
- User Name: Maximum 97 single-byte characters
- Password: Maximum 32 single-byte characters

Transfer via SMB (1) / Transfer via SMB (2) Options

The additional settings available with the Transfer via SMB (1) / Transfer via SMB (2)
option include the following:

• Address Book
• File Format
• Resend Attempts
• Name, Server, Save, User Name, and Password: The maximum number of characters

for each item is:

- Name: Maximum 18 single-byte characters
- Server: Maximum 64 single-byte characters
- Save in: Maximum 128 single-byte characters
- User Name: Maximum 97 single-byte characters
- Password: Maximum 32 single-byte characters

Print Options

The additional settings available for Print option include the following:

• Print Quantity
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• Paper Supply
• 2 Sided Printing
• Output

E-mail Notification Options

The additional settings available for E-mail Notification option include the following:

• Name/E-mail Address
• Message
• When to Notify
• Delete Recipient
• Edit
• Close Menu

Job Flow Procedures

Creating a Job Flow Sheet
1. Press the Machine Status button.
2. Select the Tools tab on the UI.
3. Select Setup & Calibration  > Setup  > Create Job Flow Sheet .
4. Select Create.
5. Select one of the line items from the list (Name).

a) Select Edit.
b) Enter the name information using the UI screen keypad.
c) Select Save.

6. Repeat the previous step for other line items (such as Description) until all desired
information is entered and saved.

7. If Send as E-mail is used, ensure all the required information is entered for it, including
recipient's name and e-mail address.

8. If desired, select Print to set options to print the linked Job Flow Sheet. Select Off to
disable this feature.

9. Select Save to keep your settings.
To activate the Save option, you must enter values in any of the following fields:
Send as E-mail, Transfer via FTP, Transfer via SMB, Print.

10. Review the newly created Job Flow Sheets and select Exit.
11. Press Clear All to return the press to its default values and settings.

Linking a Job Flow Sheet with a Folder
1. Press the Machine Status button.
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2. Select the Tools tab on the UI.
3. Select Setup & Calibration  > Setup  > Create Folder .
4. Select a folder that is not being used (Available).

The New Folder window displays.
5. On the New folder - Password window choose one of the following:

• Off; if you do not assign a passcode, all users will be allowed access to the folder.
• On:

1. Enter a passcode with a maximum of 20 digits.
2. Select a Target Operation option: Always (All Operations), Save (Write),

or Print/Delete (Read).
3. Select Save.

6. Enter the following information by selecting each line item and selecting Edit:

• Folder Name (maximum of 20 characters)
• Check Folder Passcode
• Delete Documents After Retrieval
• Delete Expired Documents
• Link Job Flow Sheet to Folder: Select and go to the next step.

7. At the Link Job Flow to Folder window, select Create/Change Link.
8. Select the Job Flow Sheet that you want to link and then select Save.
9. At the Link Job Flow to Folder window, choose one of the following:

• Auto Start: Select this option if you want the Job Flow Sheet to be automatically
executed when a new document is saved to the folder. If you do not select Auto
Start, you will need to press the Start button on the UI to execute the linked Job
Flow Sheet.

• Select Close.

Note
Selecting Cut Link at any time will remove the link to the specified Job Flow
Sheet.

The Job Flow Sheet is linked to the folder.
10. Select Close to exit to the Tools tab.

Starting a Job Flow Manually
1. Load the original document(s).
2. From the UI, press the Clear All button.
3. Press the Home button.
4. Select Job Flow Sheets, and if enabled by the System Administrator, select OK.
5. Select a listed Job Flow Sheet.
6. Press the Start button. The job runs and is placed in a folder or on the appropriate

server.
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Confirming/Changing a Job Flow

You can confirm a Job Flow and temporarily change its parameters. However, only fields
that have change permission, assigned when the Job Flow was created, can be edited.
1. From the UI, press the Clear All button.
2. Press the Home button.
3. Select Job Flow Sheets, and if enabled by the System Administrator, select OK.
4. Select a listed Job Flow.
5. Select Change Settings.
6. Select the group to change from the Group of Items.
7. Select an item in the group that will be changed.
8. Select the options you want to change and make changes as instructed.
9. Close any open windows to keep your changes.
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8
Stored Programming

Stored Programming Overview
Note
A maximum of 100 consecutive operations can be recorded/saved in each stored program,
and a maximum of 40 programs can be stored.

Frequently used features and job settings can be saved as Stored Programming, which
can be accessed using a shortcut button.

Stored Programming not only remembers feature settings, but it can record a series of
operations. This enables you to record the hierarchy of displayed screens for each step.
For example, you could use Stored Programming to record the following actions: press
the Machine Status button, and display the Print Reports screen to print reports.

In addition, while Build Job is running, a stored program can be used for the remaining
document stacks. This negates the need to program and select the options for the
remaining documents stacks in the Build Job process.

Stored Programming Options
Stored Programming includes the following options:

• Store: Use this option to create and save a job as a stored program.
• Store Build Job: Use this option to create and save a Build Job as a stored program.
• Delete: Use this option to delete a stored program.
• Enter/Change Name: Use this option to enter the name for a new stored program,

or to change the name of an existing program. A maximum of 36 characters is allowed
for a stored program name.
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• Assign/Change Icon: Use this option to assign an icon or change an existing one for
a stored program.

Stored Programming Notes and
Restrictions
The following notes and restrictions apply when you create and save jobs to Stored
Programming.

• The Build Job feature cannot be used with Stored Programming. However, segments
of a complex job can be saved to a stored program, and then recalled at point of
need when using Build Job. Therefore, while Build Job is running, a stored program
can be used for the remaining document stacks, which then negates the need to
program and select the options for the remaining documents stacks in the Build Job
process.

• When saving a stored program which includes selecting a paper size or type loaded
in the bypass tray, save both the paper size and the paper type. If only the paper size
or type is saved, the stored program may not be called properly

• If any of the following operations is performed while a stored program is being saved,
the stored program may not be saved or may not work correctly

- Removing or inserting a paper tray
- Loading or reloading paper in the bypass tray

• System Settings, Job Flow Sheets, Network Scanning, Address Book, and the Browse
feature for the Scan to PC cannot be used with Stored Programming

There are situations where a stored program will become invalid:

• Changing the default values of the Watermark feature when it is used in a stored
program

• Changing the password to the folder used in the stored program after it is stored
• Trying to use a stored program with different settings on the UI than the ones that

were saved to the stored program
• When buttons are added or removed from the touch screen, since stored programming

only remembers the location of a button on the screen, not the name of the button.
For example, button positions can change when a job flow or job template is added
or deleted

• When stored program that contains a selection from a list of the Address Book or a
Job Flow Sheet

• When the settings for an installed optional component (such as a finisher) are
changed, then the settings within a stored program for that finisher are no longer
valid

• Changing the measurement unit (millimeters or inches)
• When a stored program contains a selected job that is set for secure printing
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The following features and operations cannot be saved in Stored Programming:

• The selection of the Store (save) option from Stored Programming
• Selecting the steps to recall and run a stored program
• Any System Settings features or options.
• The Media Print - Text button on the Home window
• The Store to USB button on the Home window
• The Network Scanning, Job Flow Sheets, and Web Applications buttons on the

Home window
• The Custom button that is assigned to the Network Scanning or Job Flow Sheets

service
• Buttons than cannot be selected include the following:

- The Language button on the Home window
- The Screen Brightness button on the Home window
- Selecting items using the scroll bar
- Scrolling operation while previewing
- The Browse button for the Scan to PC service
- Operations to edit e-mail addresses for the E-mail service (such as the pop-up

menu Keyboard, Remove, and Edit which are displayed by selecting Recipient(s)
or From)

- The Energy Saver button

• An unsaved job (program) will be canceled during the following activities:

- When the Interrupt button is pressed
- If the Auto Clear feature causes a time-out
- If a pop-up window occurs (such as a paper jam)

Stored Programming Procedures

Creating and Saving a Job as a Stored Program
Note
For the purpose of this procedure, an example Copy job will be created and stored.

1. Press the Machine Status button on the press UI.
2. Select the Tools tab.
3. Select Setup & Calibration  > Setup  > Stored Programming .
4. Select Store.
5. Select a Stored Programming item from the numbered list.

If required, select the up and down arrows to display the previous or next screen.
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Note
Once a job is stored to a button (item), it cannot be overwritten.

6. Begin selecting the desired features/options by pressing the Home button on the UI.
7. Select Copy.
8. From the main Copy window, select 2 Sided Copying.

a) Select 1-2 Sided.
b) Select Save.

9. Select the Output Format tab.
10. Select Watermark.

a) Select Date & Time.
b) Select Add.
c) Select Save.

11. Press the Start button.
If no name is entered for the newly stored program, the name automatically becomes
(No Name).
This ends the job and saves (store) the programming. When you run this stored
program at a later time, the stored program displays all the required screens prior to
job submission.

Creating and Saving a Stored Program to Use with Build Job

Use the Store Build Job option to create and save a stored program that can be used
with a complex Build Job function.

• Build Job programs segments of the job as if they were ordinary, independent jobs,
and then prints all the segments as one complete job.

• Store Build Job allows you to program, scan, and store individual job segments of a
large or complex job, and recall the stored program at point of need when using Build
Job.

• Therefore, while Build Job is running, a stored program can be used for the remaining
document stacks, which then negates the need to program and select the options
for the remaining documents stacks in the Build Job process.

Note
For the purpose of this procedure, an example Copy job will be created and stored.

1. Press the Machine Status button on the press UI.
2. Select the Tools tab.
3. Select Setup & Calibration  > Setup  > Stored Programming .
4. Select Store Build Job.
5. Select a Stored Programming item from the numbered list.

If required, select the up and down arrows to display the previous or next screen.

Note
Once a job is stored to a button (item), it cannot be overwritten.
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6. Begin selecting the desired features/options by pressing the Home button on the UI.
7. Select the first feature/option (for example, Copy).
8. Continue to select more features/options (refer to the following steps for examples):

a) From the main Copy window, select 2 Sided Copying
b) Select 1-2 Sided.
c) Select Save.

9. If desired select additional features/options (refer to the following steps for examples):
a) Select the Output Format tab.
b) Select Watermark.
c) Select Date & Time.
d) Select Add.
e) Select Save.

10. Press the Start button.
If no name is entered for the newly stored program, the name automatically becomes
(No Name).
This ends the job and saves (store) the programming. When you run this stored
program at a later time, the stored program displays all the required screens prior to
job submission.

Deleting a Stored Program
1. Press the Machine Status button on the press UI.
2. Select the Tools tab.
3. Select Setup & Calibration  > Setup  > Stored Programming .
4. Select Delete.
5. Select the stored program number you want to delete.

A message displays on the UI asking you to confirm whether or not you want to
delete the selected stored settings.

6. Select Delete to confirm stored programming deletion.
7. Select Close to exit Stored Programming.

Note
Deleted stored programs cannot be restored.

Naming / Renaming a Stored Program
1. Press the Machine Status button on the press UI.
2. Select the Tools tab.
3. Select Setup & Calibration  > Setup  > Stored Programming .
4. Select Enter / Change Name.
5. Select the stored program that you want to name or rename.
6. Enter the name.

A maximum of 36 characters is allowed for a stored program name.

7. Select Save.
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8. Select Close to exit Stored Programming.

Assigning or Changing Icons for a Stored Program
1. Press the Machine Status button on the press UI.
2. Select the Tools tab.
3. Select Setup & Calibration  > Setup  > Stored Programming .
4. Select Assign / Change Icon.
5. Select the stored program to add or change the icon.
6. Select an icon.

There are 12 icons from which to choose.

7. Select Save.
8. Select Close to exit Stored Programming.

Running a Stored Program
1. Press the Home button.
2. Select Stored Programming.
3. Select the stored program containing the features you want to use.

4. After the stored program is displayed on the UI, select other features if necessary.
5. If necessary, select additional features/options.
6. If necessary, ensure that the original documents are loaded in either the Document

Feeder or on the Document Glass.
7. Select Start to run the stored program.

Using a Stored Program while Build Job is Running
Tip
This procedure is used only when Build Job is running.

While Build Job is running, a stored program can be used for the remaining document
stacks, which then negates the need to program and select the options for the remaining
documents stacks in the Build Job process.
1. From the (Build Job) Copy window, select Change Settings.

2. Select the Job Assembly tab.
3. Select Stored Programming.

Xerox® Versant® 80 Press8-6
User Guide

Stored Programming



4. Select the desired stored program which contains the features you want to use.
5. If necessary, select additional features/options.
6. If necessary, ensure that the original documents are loaded in either the Document

Feeder or on the Document Glass.
7. Select Start to run the stored program.
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9
Web Applications

Web Applications Overview
Web Applications is a service that allows you to access to web applications via a network
using the browser on the press in order to display and store data.

The press provides the following features:

• Access web applications from the press, and display the web application on the press
UI.

• Store scanned documents directly in a web application folder on the press.
• Print a file that is stored on a remote server.

Note
The web applications that can be displayed are those which are compatible with the
press. You cannot access internet websites on the press UI.

Accessing Web Applications
1. Press the Home button on the UI.
2. Select Web Applications.
3. Select an access destination.
4. Select Open from the pop-up menu displayed.
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10
Media Print - Text

Media Print - Text Overview
The installation of the optional USB Enablement Kit allows the machine to retrieve and
print PDF, TIFF, and XPS document files. This feature is called the Media Print feature.

When a USB memory device is connected to the press, the data stored in the USB memory
device can be printed. The Media Print feature includes the Media Print - Text mode
that prints data stored in text format. It also includes index printing that prints a list of
files retrieved in the mode.

Make sure to back up data on media. Data stored on media may be lost or damaged
for the following reasons.

• When switching the machine off/on or disconnecting/connecting the USB memory
device

• When receiving the effect of electrical noise or an electrical discharge
• When a failure or repair occurs
• When damage results from a natural calamity

Note
For Media Print - Text: Files cannot be displayed in thumbnail view, and they cannot be
previewed.
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Media Print - Text Options

The following options are available with Media Print - Text:

• Select All: This option selects all the files for printing.
• Select From List: This option display a listing of all the files and allows the user to

select the desired files for printing.
• Select Range: This option allows the user to select a range of files to print by using

the plus and minus buttons.
• Index Print: This option prints a list of the selected files with index numbers that

were automatically assigned to each file.

Index Print

When Index Print is selected, file names, dates when files were stored on the USB
memory device, and the total number of files are printed. The print quantity can be set
with the numeric pad, within the range of 1 - 999 sets.

For other printing options, the settings that were chosen before selecting the Index
Print check box will be effective. To change these settings, deselect the Index Print
check box, change the print settings, and then reselect the Index Print check box.

When using Index Print, the following items are restricted:

• Paper Supply: Trays 1-3 and 5; any of the following sizes of paper must be loaded in
the selected tray: 8.5 x 11 in./A4 LEF, 8.5 x 11 in./A4 SEF, or A3

• 2 Sided Printing: Must be set to Off
• Pages per side: Not available

Media Print - Text Tab

• Quantity: Specify the print quantity within the range of 1 - 999, using the numeric
keypad
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• Paper Sizes: A3, B4, A4, A4 SEF, B5, B5 SEF, A5, A5 SEF, 8.5 x 11 in., 8.5 x 11 in. SEF,
8 x 14 in., 11 x 17 in.

• Paper Type: Select the paper type to be used from the list
• Paper Supply: Auto Paper Select, Trays 1-3 and 5

- Select Auto or a tray that holds any of the following sizes of paper: A3, B4, A4,
A4 short edge feed (SEF), B5, B5 SEF, A5, A5 SEF, 8.5 x 11 in., 8.5 x 11 in. SEF,
8.5 x 14 in., 11 x 17 in.

- When selecting Auto, a paper tray of the size of the document is selected
automatically, and the document is printed at its original size

- When the tray to be used is not displayed, select More. On the screen displayed,
select the desired tray

- If you select More and then Tray, Paper Size and Paper Type are selectable

• 2 Sided Printing: Off, Long Edge Flip, Short Edge Flip
• Pages per side: Off, 2 Pages Up, 4 Pages Up

Advanced Settings Tab

Bitmap Smoothing: Off, On

Supported File Formats
The following file formats can be used:

• PDF: PDF 1.3 or later; extension: pdf
• TIFF: Extension: tif; Grayscale 4 bit/8 bit uncompressed, 8 bit/24 bit JPEG compressed,

MH/MMR compressed
• XPS files: Extension: xps

Review the following information on file formats:

• If the medium contains more than 900 folders, the machine may not be able to
recognize them correctly.

• PDF files or TIFF files cannot be printed if they are stored in folders.
• PDF files saved on a MAC OS cannot be displayed on the screen and cannot be printed.
• If a file name contains characters that are not supported by the machine, the file

name will not be displayed on the screen.
• Up to 255 characters can be recognized as a file name.
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Notes and Restrictions
The following notes and restrictions apply to the use of the Media Print - Text feature:

• Printing speed depends on the size and number of files on the USB device.
• Eject the USB drive before switching off the press power.
• Be sure to wait until printing is completed and then eject the USB device from the

port on the press.
• Always backup the data stored on the USB device before connecting it to the press.
• Before storing document files, format the media with a computer.
• In Media Print - Text mode files are printed only from the directory located directly

on the USB device. A file or folder name can be recognized even if it exceeds 8
characters.

• When using Media Print - Text to print a PDF file, PDF Bridge is selected automatically
regardless of the Print Processing Mode setting in PDF Direct Print.

• Do not connect multiple USB memory devices to the press simultaneously.
• USB 2.0 compliant devices are supported; USB 1.1 compliant devices are not

supported.
• The press does not support some types of USB memory devices, such as those with

an encryption function or with multiple partitions.
• Do not connect or disconnect the USB memory device while the machine is retrieving

or printing the data, or accessing the USB memory device.

Printing with the Media Print - Text
Feature
Important
Do not disconnect the USB memory device while the press is retrieving the files. After
the press retrieves the files, the UI displays the Media Print - Text window.

Depending on the types of files stored in the USB memory device or the directory
configuration, some of the selected files may not print.
1. Insert the USB memory device into the USB memory slot on the front of the press

(near the User Interface).
One of the following happens:

• The USB Device Detected window displays.
• The Store to USB window displays.
• The Media Print - Text window displays.
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• The UI touch screen does not change.

2. Choose one of the following options:

• If the USB Device Detected window displays, perform the following:

1. On the press UI, select Media Print - Text.
2. Go to Step 3.

• If the Store to USB window displays, perform the following.

1. On the press UI, press the Home button.
2. Select Media Print - Text.
3. Go to Step 3.

• If the Media Print - Text window displays, go to Step 3.
• If the UI touch screen does not change, perform the following:

1. On the press UI, press the Home button.
2. Select Media Print - Text.
3. Go to Step 3.

3. From the Media Print - Text window, select the desired files to print:

• Select All
• Select From List
• Select Range
• Index Print.

4. Select the desired printing options from the Media Print - Text tab and Advanced
Settings tab.

5. Select Print or Start to print the files.
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11
Job Status

Job Status Overview
The Job Status feature allows the user to check active, pending, and completed jobs.
The ability to cancel printing or pause jobs is also available from Job Status.

Job Status Area
The Job Status button on the press UI displays the progress and status of any currently
printing jobs and lists all completed jobs.

1. Select the Active Jobs tab to view the status of currently pending or in-progress
print jobs on the system.

2. Select the Completed Jobs tab to view a list of all jobs that have printed successfully.
3. Select the Group Parent Jobs checkbox to list and display the jobs according to a

parent/child relationship hierarchy.

Active Jobs Tab
1. Press the Job Status button on the UI.
2. Select the Active Jobs tab.
3. From the displayed list, select the applicable job to view.

Use the up or down buttons to navigate the list.

4. If required, select Display Time to show the time required to process the job.
5. To delete a job or change the execution order, select a job from the list.
6. Select Delete or Promote from the pop-up menu.
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• Delete: This option cancels the current or pending job.
• Promote: This option moves a job to the top of list and runs it after the job that

is currently printing/copying.
• Job Progress: This option shows the details of the selected document.
• Close Menu: This option closes the pop-up menu.

Completed Jobs Tab
1. Press the Job Status button on the UI.
2. Select the Completed Jobs tab.

A list of the completed or deleted jobs display. Use the scroll bar to navigate the list.
3. To check the details of a job, select the job from the displayed list.
4. From this Status window, select one of the following to print a history of this job.

a) To print the job details, select Print this Job Report button.
b) To print the history of parent / child jobs, select Print this Job History button.

5. After checking the job details, select Close.
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12
Machine Status

Machine Status Overview
Press the Machine Status button on the UI to access the Machine Status information,
including maintenance and reporting features.

• Device Information
• Faults
• Supplies
• Billing Information
• Tools

Device Information Tab
This tab provides general information about the press such as the currently installed
software version and the press (device) serial number. This area also allows you to print
reports and view details that apply to billing impressions.

Device Serial Number

The Device Serial Number is displayed under the General Information area on the
Device Information tab. Use this number when calling Xerox for technical information
or assistance.

Current System Software

The version of the system software that is currently installed on the press is displayed
under the Current System Software title.
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IP Address and Host Name

The unique Internet Protocol Address and name identifying the press to the specific
network to which it is connected.

Paper Tray Status

Select the Paper Tray Status button to display tray status information including
percentage amount of media installed in each tray.

Device Configuration

Select the Device Configuration button to display a list of the various hardware
components and options that are available on the press as well as their status. Hardware
components and options include any optional feeding and finishing devices attached
to the press.

Software Version

Select the Software Version button to display a list of the software versions for the
various system components, including any optional feeding and finishing devices.

Print Reports

This Print Reports button is enabled by the system administrator. From the various
reports available, select a report on the touch screen and then select the Start button
to print. Some reports are only available in the system administrator mode.

From the Print Reports screen, select:

• Job Status
• Copy Reports
• Scan Reports
• Network Controller Job Report
• Job Counter Report (available in System Administrator mode only)
• Auditron Report / Meter Report (available in System Administrator mode only)

Maintenance Assistant

Select the Maintenance Assistant button to send the Xerox Remote Print Services
diagnostic information on the press to Xerox Support.

Others

From the Device Information - Others window select the Overwrite Hard Disk button;
this feature is a standard data security function on the system. It prevents the document
image and registered data that is recorded on the press hard disk from being illegally
retrieved or removed.

Job image data stored on the hard disk within the press can be deleted and overwritten
after a number of overwrites or a period of time specified by the system administrator.
The Standby status indicates the completion of the overwriting process.
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Faults Tab
The Faults tab provides access to a list of current faults affecting the press and some
detailed information about the fault such as when it occurred. Access this tab by pressing
the Machine Status button on the UI and selecting the Faults tab on the screen.

Fault History

This column identifies the fault code number assigned to the fault message.

Date/Time

This column indicates the day and time the fault occurred.

Image Count

This column indicates the total number of printed impressions.

From the Faults screen, select a fault to view instructions on how to fix the error.

Supplies Tab
The Supplies tab provides status information about the customer replaceable units
(CRUs) that are used in the press.

To access supplies information, press the Machine Status button on the UI and then
select the Supplies tab. Each Customer Replaceable Unit and status is displayed.

Billing Information Tab

Accessing Billing Information
1. Press the Machine Status button on the UI.
2. Select the Billing Information tab.

The Billing Information screen displays.

Billing Impressions Information

The Billing Information screen allows you to view the total number of impressions (prints)
recorded by the press, including a category of the number of color prints only, black
prints only and large media prints. It also displays specific usage counter information.
The counters display the impression amount for all printed jobs.
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All meters that may be used for billing purposes are displayed on the Billing Information
screen:

• Color Printed Impressions: This value (number) represents the total number of color
impressions that have been printed.

• Black Printed Impressions: This value (number) represents the total number of
black-only impressions that have been printed.

• Total Impressions: This value (number) represents the total number of ALL
impressions. It is the sum of the Color Impressions and the Black Impressions.

• Color Large Impressions: This value (number) represents the total number of large
color impressions. These impressions are one side of one sheet of large media (for
example 11 x17 in./A3). Large Impressions are any prints that are larger than 145
sq. in./935 sq. cm.

Note
This meter/counter is NOT added to the Total Impressions meter/counter since it is
already added to the Color Impressions meter/counter.

• Black Large Impressions: This value (number) represents the total number of large,
black-only impressions. These impressions are one side of one sheet of large media
(for example 11 x17 in./A3). Large Impressions are any prints that are larger than
145 sq. in./935 sq. cm.

Note
This meter/counter is NOT added to the Total Impressions meter/counter since it is
already added to the Black Impressions meter/counter.

Usage Counters

Select the Usage Counters button (from Machine Status  > Billing Information )to
view even more detail on billing and counts being tracked on the press such as the
number of 1-sided vs 2-sided print jobs.

From the Counters drop-down list you can select the desired counter to view:

• Impression Counters
• Sheet Counters
• Images Sent Counters
• All Usage Counters
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Impression Counters

This view displays the total impression amount. In other words, impression is the image
on one side of one sheet of media. This counter shows the total impression amount
for color and black-only impressions.

• Total Impressions: This number represents the total number of impressions for all
color and black-only print jobs.

• Black Impressions: This number represents the total number of impressions for all
black/white print jobs; includes Black Copied Impressions and Black Printed
Impressions.

• Black Large Impressions: These impressions are one side of one sheet of a large
black-only document (such as 11 x17 in./A3). Large Impressions are any prints that
are larger than 8.5 x14 in./B4.

• Color Impressions: This number represents the total number of impressions for all
color print jobs; includes Color Copied Impressions and Color Printed Impressions.

• Color Large Impressions: These impressions are one side of one sheet of a large color
document (such as 11 x17 in./A3). Large Impressions are any prints that are larger
than 8.5 x14 in./B4.

Sheet Counters

This counter provides information on the total number of sheets the press feeds to the
output area. Each sheet counts as one click on the counter (regardless of size or whether
it is a one-sided or two-sided print job).

Images Sent Counters

This counter provides information on the total amounts for email images and network
scanned images.

All Usage Counters

This view provides a complete total of all the counters, including the totals from the
Impression Counters and Sheet Counters.

Update Button

Select this button to refresh and update the counts.

Tools Tab
Regular users have limited access to some of the features on the Tools tab.

Create Folder

Use this feature to create folders on the press for storing copied and scanned
documents.
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Stored Programming

When available to the user, this feature enhances productivity by saving a series of
programming steps and assigning them to a specified Stored Programming option.
Stored programs save frequently used features and job settings which can be accessed
using a shortcut button. Stored Programming not only remembers feature settings,
but it can record a series of operations. This enables the user to record the hierarchy
of displayed screens for each step. For example, Stored Programming can record the
following actions: press the Machine Status button, and display the Print Reports
screen to print reports.

Note
This feature is available only if the system administrator has created and saved stored
programs.

Create Job Flow Sheet

Use this feature to create job flow sheets which contain transfer settings of scanned
data, such as a transfer method and destination. These sheets simplify data-transfer
tasks.

Add Address Book Entry

Select to add Address and Recipient Information. To add, select an available entry and
enter the information. To view an entry, select the entry and the information will
automatically display.

Paper Tray Attributes

The Paper Tray Attributes feature allows the user to change the attributes of a paper
tray, including size, type, and weight.

Note
The Paper Tray Attributes feature appears on the Tools tab only if the system
administrator has made it available to users.

Billing Impression Mode

The Billing Impression Mode defines how the press tracks and records impressions
made on large-size paper such as A3 or tabloid. The type of Billing Impression Modes
used by your press is set during system installation. A Xerox Sales Representative can
confirm the Billing Impression Modes applicable for your press. There are two types of
Impression Mode:

• A3 Impression Mode - For all media sizes (including oversized), counts all impressions
equally.

• A4 Impression Mode - Counts large impressions on media such as A3 and 11 x 17
inches (media that is larger than 8.5 x 14 inches), as their A4 equivalent.

To view the current Billing Impression Mode, press the Machine Status button on the
UI, then select Tools  > Billing Impression Mode .
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Changing the Paper Tray Attributes
1. Press the Machine Status button on the UI.
2. Select the Tools tab.
3. Select Setup & Calibration  > Setup  > Paper Tray Attributes .
4. Select a tray.
5. Select Change Settings.
6. If the settings are correct, select Confirm or select Change Settings.
7. If necessary, make the required changes to the tray settings (such as weight, type,

and size).
8. Select Save.
9. Select Confirm.

10. Select Close.
The main Tools screen is displayed.

11. Press the Home button on the UI to return to the main home screen.
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13
How to Submit a Print Job

Setup and Submit the Print Job
The following is a basic workflow for setting up a job and submitting it from the print
server:

1. At the press, load the appropriate paper to be used for the job.
2. From the press UI, ensue that the Paper Tray settings/Tray Properties window

matches the stock properties for the paper you will use, and that it assigned to the
same feeder tray where the paper is loaded.

3. At the print server main window, customize your job such as inserting special pages
and tabs, and create your print queue that defines the attributes of those jobs sent
to the queue.

4. Submit the job file from the print server to the networked press for printing.

How to Submit a Print Job
There are several ways in which to submit your job for printing:

• From your computer workstation (PC or Mac), using print drivers such as PostScript
and Printer Command Language (PCL), you can submit a document file to the print
server queue. From the print server, you would then submit the job to the press.

Note
Make sure the appropriate print drivers have been installed on your computer. Refer
to your print driver documentation or the Xerox web site for more information on
how to download or install print drivers.

• At any remote workstation, using a Hot Folders application to submit the document
file to the print server.
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• At the print server, importing/adding a document file to a print queue. Manage the
job settings of the document and then submit to the press for printing.

Printing from a Computer or Print Server

Printing from a Computer

The system supports either Xerox FreeFlow or Fiery EX print drivers. Through print drivers
installed on your computer or Mac, you can send a document file from your desktop to
the print server, which can then be submitted to the press for printing.

Note
You can also use a drag and drop Hot Folders feature by which to send your files to the
print server for printing to the press.

1. From your computer, select the file you want to print and open it in its application.
2. Select File  > Print.
3. Select the desired print server queue.
4. Select the Properties button for the queue.
5. Select the desired output options such as quantity or 1 sided/2 sided printing.
6. Select OK to close the Properties window.
7. Select Print to send the job to the print server queue.

Printing from the FreeFlow Print Server

From your computer, you can submit your document files (select Print) to a directory on
the print server through the use of installed print drivers. You could also copy the
document files onto a USB flash drive or CD/DVD and then connect those devices to the
print server for importing.
1. If you copied the file onto a storage device, connect your device to the print server

and from the top menu bar select Services  > Print From File.
2. From the Print From File window, select the Files tab and Browse.
3. From Look In, locate your storage device or other network directory containing the

document files you want.
4. Select and highlight one of the document files. Select OK.
5. From the Queue field at the top right of the Print From File window, select the desired

print queue.
6. Using the other tabs on the screen, select the desired output options such as quantity

or 1 or 2-sided printing.
7. Select Print.

The job is sent to the desired queue and either held or immediately printed.

8. Select Close.
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Printing from the EX Print Server

From your computer, you can submit your document files (select Print) to a directory on
the print server through the use of installed print drivers. You could also copy the
document files onto a USB flash drive or CD/DVD and then connect those devices to the
print server for importing.
1. If you copied the file onto a storage device, connect your device to the print server

and select Services  > Print From File.
2. From the EX Print Server, select File  > Import Job .
3. Select Add.
4. Locate your storage device or other directory containing the document files.
5. Select and highlight one of the document files. Select Open.
6. Select Import.
7. Select the desired queue such as Process and Hold or Print and Hold.

The job is sent to the selected queue or to the press for immediate printing.

Printing on Tabs from a Print Server

Basic Procedure for Printing on Tabs from a Print Server

There are many types of tab stock and tab sequences available. Precut tabs are commonly
used and have two different orientations: the single straight collated tab stock or the
single reverse collated tab stock.

When programming tab jobs and loading tab stock, consider the following:

• Precut tabs can only print 1-sided
• There are specific job settings that you need to define such as tab order/sequence,

number of bank sets, stock weight, paper size, and insertion before or after body
pages. Refer to your print server documentation for more detailed setting information.

• Always load tab stock LEF into the tray where the straight edge of the stock is the
lead edge and the tabs are oriented at the trail edge.

• Always use a complete set or bank or tabs in the paper tray.
• If staple or punch finishing, use tray 5 or trays 6 or 7 (if available).

The following are the basic steps for printing tabs on your press.
1. From the print server, create and define the Tab stock for the paper tray you will be

using.
2. Load the Tab stock in Trays 1, 2, 3, 5, 6 or 7.
3. From the print server window, access the Held queue that contains your document.

Select the document you want to configure with tabs. Double click to open the file’s
properties.

4. Once all settings are made, select Print.
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The press prints the complete set of tabs with the body pages defined. Any extra
tabs not used in the job are sent to the output tray.

Tips for Printing on Tabs from the EX Print Server

Use the following tips for printing on tabs from the EX Print Server:

• The EX Print Server allows for setting up your job to print on tabs. Otherwise, you can
set up your job to insert preprinted tabs into your document. Use one tray for the
body pages, another tray for the preprinted tab stock, and another tray for cover or
back pages.

• While you can print tab stock from any of the paper trays on the system (Trays 1, 2,
3, 5, 6 or 7), Trays 6 and 7 should be used for best results. If you plan to apply staple
or punch finishing, use Trays 5, 6 or 7 only.

• Loading orientation depends on what tray you are using.
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14
Press Maintenance

Procedures for Cleaning the Press

Cleaning the Press Overview
• Before you start to clean the press, be sure to switch off the power using the rear

breaker switch and unplug the press. Cleaning the press without switching off the
power may cause an electric shock.

• Always use a dry lint-free cloth for all cleaning actions unless otherwise directed.
• Do not use benzene, paint thinner, other volatile liquids, or spray insect repellent on

the press as doing so may discolor, deform, or crack covers.
• If a moistened cloth is used, wipe afterwards with a dry lint-free cloth. Cleaning the

press with an excessive amount of water may cause the press to malfunction and/or
damage documents during printing.

Cleaning the Exterior
1. Wipe the exterior with a soft cloth moistened with water. If dirt is difficult to remove,

try gently wiping with a soft cloth moistened with a small amount of neutral detergent.

2. Wipe off any excess water from the exterior with a soft cloth.
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Cleaning the Document Cover and Glass
1. Cleaning the document cover

a) Raise the document feeder.

b) To remove dirt, wipe the document cover with a soft cloth moistened with water
and then wipe it dry with a soft cloth. If dirt is difficult to remove, try gently wiping
with a soft cloth moistened with a small amount of neutral detergent.

2. Cleaning the document (platen) glass
a) To remove dirt, wipe the document glass with a soft cloth moistened with water

and then wipe it dry with a soft cloth. If dirt is difficult to remove, try gently wiping
with a soft cloth moistened with a small amount of neutral detergent.

Caution
Do not press heavily on the document glass to avoid damaging the glass surface.

3. Cleaning the second-side scanning lens assembly
a) The second-side scanning lens assembly is located along the left side of the

document cover. The assembly consists of the mirrored-glass strip, a metal strip,
a white-plastic strip, and rollers. All parts of the assembly must be cleaned to
ensure the best image quality when making copies.
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b) With the document feeder open, pull the lever that is located at the top of the
document cover.

Part of the document cover pulls away from the assembly, which allows better
access to the second-side scanning lens assembly.

c) To remove dirt, wipe the mirrored glass, metal strip, both sides of the white-plastic
strip, and the rollers with a soft cloth moistened with water, and then wipe it dry
with a soft cloth.

Caution
Do not press heavily on the mirrored glass as this will result in damage to the film
around the glass surface.

Note
If dirt is difficult to remove, try gently wiping with a soft cloth moistened with a
small amount of neutral detergent.
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4. Once the second-side scanning assembly is clean, return the document cover to its
original position and ensure that the lever is locked in place.

If you touch the document cover with your bare hands, wipe it clean before closing
the document feeder.

5. Gently close the document feeder.

Cleaning the Document Feeder Rollers
1. Gently lift the latch of the document feeder top cover until it is open completely in

a fixed position.

2. While turning the rollers, gently clean them with a soft cloth moistened with water.

Caution
Use a cloth that has been thoroughly wrung to prevent drops of water falling into
the machine. Drops of water on internal components may cause a malfunction.

If dirt is difficult to remove, try gently wiping with a soft cloth moistened with a small
amount of neutral detergent.

3. Close the top cover of the document feeder until you hear it click into place.
4. Close the left cover of the document feeder until you hear it click into place.
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Cleaning the Drum Drawer Area

When you are replacing a drum cartridge, and before inserting the new cartridge, perform
these steps to clean under the drum cartridge area:

1. With the Drum Cartridge Drawer open, look for dry ink/toner waste on the bottom
of the catch pan under the drum cartridges.

2. Use a clean cloth to wipe down the catch pan.
3. Continue following the instructions on how to insert the new cartridge.

Cleaning the ROS Windows

Unfused dry ink/toner collects on the 4 color ROS window areas located just above the
Drum Cartridge Drawer within the press. Contaminated ROS windows can cause a white
streak defect on your printed output.

Perform this procedure to clean the ROS window of the affected color whenever:

• You replace the drum cartridge
• A white streak (no image captured) shows in the same position on every print

Note
Use only the wand and cloth pad provided when performing this cleaning procedure.
Do not use any other cleaning device, liquid solutions, or cloths.

1. Open the Left Front Door of the press.
2. Locate the Cleaning Wand tool stored on the side panel of the open front door and

remove.
Make sure the pad at the tip of the wand is clean. Replace the pad after 4 uses. Several
pads are provided in the Nationalization Kit. To acquire additional pads, contact your
Service representative.

3. With the pad facing upward, insert the wand fully into the ROS color window opening
and then bring the wand fully out towards you. Complete this in/out action 3 or 4
times in each ROS window.

4. Replace the Cleaning Wand tool into the storage area on the side panel of the open
front door.

5. Close the Front Door of the press.

Cleaning the Fuser Assembly

If you see dry ink/toner debris on the back side of the print output, select and run the
Clean Fuser Assembly routine from the press UI to clean the fuser component and
address this image quality issue caused by contaminants in the fuser.
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Note
If you still notice contaminants on the back of the prints after running this procedure,
contact Service. Dry ink/toner debris may be coming from the Transfer roll area instead
of the fuser.

1. Press the Machine Status button on the UI.
2. Select the Tools tab.
3. Select Setup & Calibration  > Clean Fuser Assembly .
4. From the screen that displays, specify the paper tray to use and the number of blank

sheets to print for the "Clean with Paper" method of removing the unfused dry
ink/toner.

5. From Paper Supply, select the paper tray to use.

Note
Any type of paper and size can be used. However, the smooth surface of coated paper
does offer more contact area to the pressure roll.

6. From Number of Sheets, select the number of blank sheets to print (1 to 5).

Note
For best results, run a minimum of 5 sheets.

7. Select Save.
8. Press the Start button.

The system begins the cleaning process and displays a "successfully completed"
message when finished.

9. Select OK.

Note
The process with 5 sheets of paper will take approximately one minute.

Procedures for Replacing Consumables

Replacing Consumable Supplies

The following items are the Customer Replaceable Units (CRU) for the press. It is
recommended that you have a supply of these items available to eliminate down time
when they need to be replaced.

• Dry Ink/Toner cartridges (C, M, Y, K)
• Drum cartridges (C, M, Y, K)
• An empty Waste Dry Ink/Toner bottle
• Suction Filter

Refer to www.xerox.com for the latest consumable part numbers.
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Note
The Fuser Module may be replaced by the customer only if directed to do so by Service.

Note
Store supply items and Xerox parts in their original packages in a convenient location.
Always recycle/dispose the used CRU according to the disposal instructions supplied
with the new CRU.

Ordering Supplies

Xerox supplies, paper, and throughput material can be ordered from the web site
www.xerox.com and clicking on the Supplies link. For any item that is not orderable from
the web site, contact your Xerox Service Representative.

Note
The cleaning pads used with the ROS Window cleaning wand are not orderable. Contact
your Xerox representative for any additional cleaning pads.

Approximate Print Yield (Full
Color 8.5x11/A4 Prints)

Reorder QuantityCRUs (Supply Item)

50,0002 per boxBlack Dry Ink/Toner Cartridge

55,0001 per boxCyan Dry Ink/Toner Cartridge

51,0001 per boxMagenta Dry Ink/Toner Cartridge

51,0001 per boxYellow Dry Ink/Toner Cartridge

45,0001Waste Dry Ink/Toner Bottle

200,0001Suction Filter

348,0001 per boxDrum Cartridge (R1)

348,0001 per boxDrum Cartridge (R2)

348,0001 per boxDrum Cartridge (R3)

348,0001 per boxDrum Cartridge (R4)

500,0001 kitOHCF Feed Roll Kit

5,000 staples each cartridge4 Staple Cartridges
(5,000 staples per cart-
ridge) and 1 Staple
Waste Container per
carton

Standard Finisher Staple Cartridge
and Staple Waste Container

5,000 staples each cartridge4 pack: 5,000 staple re-
fills each

Booklet Maker Finisher Staple Cart-
ridge

5,000 staples per cartridge1 Staple CartridgeBusiness Ready (BR) Finisher Staple
Cartridge

5,000 staples per cartridge4 pack: 5,000 staple re-
fills each

Business Ready (BR) Finisher with
Booklet Maker Staple Cartridge
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Approximate Print Yield (Full
Color 8.5x11/A4 Prints)

Reorder QuantityCRUs (Supply Item)

5,000 each refill for a total of
15,000

3 refills per cartonStaple Refills for the Business Ready
Finisher and Business Ready Finisher
with Booklet Maker

Checking the Status of Consumables

When a consumable is reaching the time it needs to be replaced, a message is displayed
on the press UI. This indicates when it is time to order and/or install a new consumable
item. With some CRUs, the screen indicates that the press may continue to run print
jobs without immediately replacing the item. Otherwise, when it is time to replace it, a
message appears and the press stops running.
1. Press the Home button on the UI.
2. Press Machine Status and select the Supplies tab.

The Supplies area shows a 1 to 100% indicator bar of the remaining amount of dry
ink/toner. Remaining dry ink/toner is updated in 10% increments.

3. From the Supplies pull-down menu, select Other Consumables to view the status of
other consumables, such as the drum cartridges the Dry Ink/Toner Waste Bottle, and
any applicable optional devices (such as the OHCF feed rolls).

Note
The status of the Fuser and Suction Filter are not shown, but a message displays
when these items require replacing.

Replacing a Dry Ink/Toner Cartridge
Note
The dry ink/toner cartridge can be replaced while a job is printing.
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Note
After you replace a dry ink/toner cartridge, the system automatically resets the usuage
counter to zero (0) for this CRU. Check the Consumables Supplies screen to verify the
reset and new status.

1. Open the Dry Ink/Toner cover, located just above the press front door.

2. Lay paper on the floor before removing the cartridge. This will allow any excess dry
ink/toner to fall on the paper.

3. Grasp the handle of the dry ink/toner cartridge matching the color indicated in the
message.

4. Remove the dry ink/toner cartridge by slowly and gently pulling it straight out. While
pulling out, hold the bottom of the cartridge with your other hand to give it support.

5. Dispose of or recycle the cartridge per your local authorities and regulations.
In the United States, also refer to the Electronic Industries Alliance website:
www.eiae.org. For more information about Xerox environmental programs, go to
www.xerox.com/environment.

6. Remove the new dry ink/toner cartridge from its packaging.
7. With one hand on either side of the cartridge, vigorously shake and rotate the new

cartridge up and down and left and right for 30 seconds to redistribute the toner.
8. Install the new dry ink/toner cartridge by gently and evenly sliding the cartridge into

the press until it stops.
9. Close the dry ink/toner cover. If the cover does not close completely, make sure the

cartridge is in the lock position and is installed into the appropriate dry ink/toner
location.

Replacing the Dry Ink/Toner Waste Bottle

The Dry Ink/Toner Waste Bottle collects dry ink/toner that accumulates during the
printing process. When the bottle is full, a message displays on the press UI informing
you to exchange the full bottle with an empty one.
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The press contains one waste bottle located at the front of the press behind the Dry
Ink/Toner Waste Bottle Door. When removing a full Dry Ink/Toner Waste bottle, SLOWLY
pull it out of the press. This will prevent any dry ink/toner from spilling out of the bottle.

Note
After you replace the Dry Ink/Toner Waste Bottle, the system automatically resets the
usage counter to zero (0) for this CRU component. Check the Consumables Supply screen
to verify the reset.

1. Ensure that the press is stopped (not running any jobs).
2. Open the front door of the press.
3. Open the Dry Ink/Toner Waste Bottle Door.

4. Grasp the handle of the Dry Ink/Toner Waste bottle and pull it halfway out of the
press.

5. Support the underside of the bottle with your other hand and continue pulling it out
from the press.

Caution
Never use a vacuum cleaner when cleaning up spilled dry ink/toner. Use a broom or
a cloth moistened with a neutral detergent.

6. Use both hands to place the old used Dry Ink/Toner Waste Bottle into the provided
plastic bag.

7. Remove a new, empty waste bottle from the packaging.
8. Hold the center part on the top of a new bottle and insert it evenly and gently into

the press until it comes to a stop.
9. Close the waste bottle door.

10. Close the press front door.

Replacing a Drum Cartridge

Other than replacing a drum cartridge after 348,000 prints, you may need to replace a
drum cartridge if it is damaged by light or you are experiencing spots and streaks on
your output.

Note
All four Drum cartridges are interchangeable.
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Note
After replacing the drum cartridge, the system automatically resets the usuage counter
of this CRU component to zero (0). Check the Consumables screen for the reset and new
status.

Caution
Do not leave the Drum Cartridge Drawer open for more than one minute. Exposing the
drum cartridges to direct sunlight or strong light from indoor fluorescent lighting for
more than one minute may cause image quality defects.

Caution
Replace drum cartridges while the press is powered ON.

1. Ensure that the press is stopped and is not currently printing jobs.
2. Open the press Front Door.
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3. Rotate and turn the R1-R4 Drum Drawer Handle to the unlock position.

4. Open the bag containing the new drum cartridge. Place the new drum cartridge near
the press.

Caution
Do not touch or scratch the surface of the drum when you take it out from the bag.

5. Unwrap the sheet covering the new drum cartridge and place it under the cartridge.
Some drum cartridges may include a protective film. Remove the film on the drum
cartridge, if the film is present.
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6. Grab the Release Handle and pull the Drum Drawer straight out.

7. Remove the old drum cartridge by holding the finger rings provided at the both ends
of the drum cartridge and gently lifting up.

Caution
Drums are light sensitive. Do not leave the Drum Cartridge Drawer open for more
than one minute when replacing cartridges. Exposing the drum cartridges to direct
sunlight or strong light from indoor fluorescent lighting for more than one minute
may cause image quality defects.

8. Install the new drum cartridge into the press following the guides with the side marked
front facing the front.
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9. Press both ends of the drum cartridge to place it in a horizontal position.

10. Immediately close the drum cartridge drawer to protect the other drums from light.
11. Return the Release Handle to its original position.
12. Return the R1-R4 handle to the original position and close the front door.
13. Insert the used drum cartridge into an empty container for recycling.

Replacing the Suction Filter

You will need the T10 Torx driver tool for this procedure.

After you replace the filter, you will need to contact the system administrator who will
log into administrator mode and reset the counter to zero (0) for this CRU.

Caution
Make sure the press is powered off before performing this procedure.

1. At the back of the press, locate the Suction filter cover on the lower panel.
2. Use the Torx driver to remove the screw on the right side of the cover by turning the

screw counterclockwise.

3. Pull out and remove the Suction Filter Cover.
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4. Grasp the handle of the filter box and pull straight out.

5. Remove the Suction filter out of the box.
6. Place the new Suction filter into the box and push the tray back in until it stops and

is flush with the press.
7. Place the cover back onto the filter box area. Make sure to first insert the left two

tabs of the cover into the left side of the box area. Then push the entire cover flush
to the press.

8. Insert the Torx driver with the screw attached into the cover and turn clockwise to
tighten.

9. Either log in as the administrator or ask the administrator to perform the following
steps to reset the counter to zero (0), which indicates a new filter has been installed.
a) At the UI, press the Machine Status button.
b) From the screen that displays, select the Tools tab.
c) Select System Settings  > Common Service Settings  > Maintenance.
d) Use the up/down arrow buttons to access the next Maintenance screens.
e) Select the Technical Key Operator icon. The Technical Key Operator feature

displays.
f) Select the CRU item that corresponds with the newly-replaced component.
g) Select Reset Current Value. The system resets the HFSI to 0.

10. Exit administrator mode by pressing the Log In/Out button on the Control Panel.
When prompted, select Logout.
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15
Press Problem Solving

Locating the Press Serial Number
The press serial number can be accessed from either the press User Interface or from
the serial number plate which is located on the inside frame of Tray 1.
1. Press the Machine Status button on the User Interface.
2. From the Machine Status screen, ensure that the Device Information tab is displayed.

The press serial number is displayed under Device Serial Information near the bottom
of the screen.

3. If there is a loss of power and it is not possible to access the Machine Status screen,
the press serial number can also be found on the inside frame of the press near the
Paper Tray 1 drawer:
a) At the press, fully open Tray 1.
b) At the left of the tray, on the press frame, locate the plate with the serial number

(SER#).

Calling for Service
1. Record any displayed fault codes.
2. Record the press serial number.

a) Select the Machine Status button at the press UI.
b) From the Machine Status screen, select the Device Information tab to view the

serial number listed.
If the serial number is not displayed, open the press Paper Tray 1 drawer and
locate the serial number plate on the left side of the frame (SER #).

3. If output quality is a problem, take a sample as a reference to assist you in describing
the problem over the telephone when answering the questions from the customer
support operator about the defects.
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4. If possible, use a phone near the press when calling for assistance. Follow the
instructions provided by the operator.

5. For system support, user help, and service support, call the appropriate number. For
the specific number in your area, go to www.xerox.com and select the Support link.

Press Troubleshooting

Basic Troubleshooting Information

Check the press status for system troubleshooting.

Warning
Precision components and high-voltage power supplies are used on the press. Never
open or remove covers that are screwed shut unless specifically instructed in the User
Guide. A high-voltage component can cause electric shocks. When opening the panels
and covers that are screwed shut to install or detach optional accessories, be sure to
follow instructions in the User Guide. Do not try to alter the press configuration or modify
any parts. Doing so might cause press malfunction or fire.

General Problems

This section contains a problem solving table to help you resolve some basic problems
you may encounter with the press. If the problem persists after following all the
instructions, contact your Xerox Representative or the Customer Support Center.

Note
If your print server indicates that the press has a fault and the press UI does not readily
display a message, refer to the Error History report.
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Suggested solutionsProblem

The press does not power
on. • Ensure the power cord from the press is plugged into the power

outlet/receptacle correctly. If not, press the main power switch
inside the front door to off and then firmly plug in the power
cord. Then press the power switch on.

• Ensure the power switch inside the front door is set to the ON
position. Press firmly on the On/Off button located on top of
the press near the UI.

• Make sure that the power supply is 200 -240 V (volts), 30A
(amperes).
Make sure that power of capacity compatible with the specified
maximum power consumption of the press (2.8 - 3.1 KVA) is
being supplied.

• Check the Ground Fault Interrupter (GFI) circuit breakers.
• If the power in your location is working properly, and you have

tried the suggested solutions but the press does not power on,
contact the Customer Support Center for assistance.

The press UI is locked up or
completely dark. • If the UI buttons or keyboard do not work, press the power

button on the press to power down the print engine. Wait 30
seconds and press the power button again to reboot the system.

• If the Power Saver button is on (lit), the press is in the Power
Saver mode. Press the Power Saver button on the UI to cancel
the Power Saver mode.

Open Paper Tray 1. The serial number is located on the left frame
near Tray 1.

There is no power to the
press, and you cannot ac-
cess the Machine Status
screen to get the press seri-
al number.

The press does not success-
fully complete a print job. • Is your press connected to the network? Try printing a test page

from the print server to the press to verify that the press is
connected on the network.

• Verify that the power cable is connected to the press and to a
suitable power outlet.

• Verify that the network cables are attached securely to the
press and seated properly.

• Clear out the print job from the print queue and resend print
job.

• Power Off/On the press to restart it.
• Your press may not be configured on the network. Contact your

System Administrator to connect the press to the network.
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Suggested solutionsProblem

The system requires approximately 2 minutes when switching print
modes in order to make any necessary adjustments for the next
print job, including color-to-color registration, density, charge levels,
bias levels, or other adjustments.

• The system has two print modes selectable at the print server:

- 4 Color Mode (CMYK: Cyan, Magenta, Yellow, Black)
- Black and White Mode Only

• If the next print job is switching print modes, for example from
black-only to 4-color, the system requires approximately 2
minutes to make any necessary adjustments.

• During this time, the touch screen displays the Adjusting Image
Quality message.

• The next job begins printing once the system completes its
adjustments.

Other information to remember includes:

• From a cold start (power on or power saver), system takes less
than 5 minutes to start printing.

• From standby mode, system usually takes less than 1 minute
to start printing.

The press is taking longer
than one minute before
printing the next job.

Check the application or print driver settings on whether non-
standard fonts are being used for printing.

Text prints incorrectly (text
is corrupted).

• At the UI, check the paper settings for the tray ( Machine
Status  > Device Information  > Paper Tray Status ).

• Check the print server settings.
• Check that the paper is loaded correctly as either SEF or LEF

and this matches the paper settings programmed at the print
server.

Trays do not recognize the
media.
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Suggested solutionsProblem

Prints are not on desired
paper size. • Ensure that the correct paper size and type is loaded in the

paper trays.
• Set the paper guides to the correct positions.
• Select the paper size, tray and weight at the print server and

ensure these paper attributes are set correctly at the Tray
Properties window.

• Ensure that “Fit to Paper” or an equivalent selection is not se-
lected in your print driver.

Paper is misfed, jams often,
or wrinkles repeatedly. • If a message appears on the press touch screen, follow the in-

structions displayed.
• Make sure the paper and paper tray selected match the paper

size settings. Refer to The Recommended Media List.
• Make sure the trays are loaded properly with acceptable media

and do not exceed the MAX fill line.
• Ensure the paper tray edge guides are in the correct position.

To ensure tray closure, firmly push it in as far as possible.
• Turn the paper stack around and/or over in the selected paper

tray.
• Remove a few sheets from the top and the bottom of the stack

in the paper tray.
• Fan all four edges of the paper in the selected paper tray.
• Replace the paper in the selected paper tray with paper from

a new package.
• Remove any partially fed paper from the trays. Make sure to

remove any torn pieces of paper still remaining inside the press.
• Ensure the paper you are using had been stored properly.

Multiple sheets feed from
the paper trays. • Do not fill the paper trays above the MAX fill line indicator.

• Remove the paper from the tray and fan the sheets to separate
the joined sheets.

• Predrilled sheets may stick together at the holes. Remove the
paper from the tray and fan the sheets to separate the joined
sheets.

• Paper and transparencies may stick together if environmental
conditions are too dry and cause excessive static. Increase the
humidity level in the room to minimize static.

• Gently fan transparencies to separate the sheets before you
load them.

Paper jams in the optional
Oversized High Capacity
Feeder Trays

• Visually check to see if the Feed/Retard/Nudger Rolls are worn
or damaged.

• Check the HFSI interval status for the rolls. Replace if needed.
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Suggested solutionsProblem

• Ensure that the edge guides of the paper tray fit snugly against
the paper stack.

• Do not fill the paper trays above the MAX fill line indicator.
• Close the tray slowly to avoid shifting the paper stack.

Paper jams when exiting
the Paper Trays.

• When no other output device is present, the Offset Catch Tray
can hold up to 500 sheets of 24 lb (90 gsm) paper. Empty the
catch tray when output approaches this limit to ensure continu-
ous production.

• Ensure the first sheet is not blocking the paper exit, particularly
for 11 x 17 inch (A3) output.

Output jams when exiting
the press to the Offset
Catch Tray.

Potential impacts:

• Ensure that the correct paper weight and paper type are selec-
ted.

• The mass of dry ink (toner) coverage on the print output - the
greater the dry ink/toner mass, the greater the paper curl.

• The paper weight and whether or not it is coated or uncoated.
• The humidity conditions at the press.
• You can sometimes minimize curl problems by flipping the paper

over in the tray. If excessive curl is still present, use a heavier
paper.

• To ensure continuous production, empty the output device
when the output approaches the maximum amount that the
device can hold; refer to the specifications for that output device
for output limit amount.

• An attempt to print on thicker paper or on paper stock that is
less sensitive to moisture.

Paper curl can be adjusted in the following ways:

• If the Interface Module or Interface Cooling Module is attached,
use the manual decurl buttons on the module's control panel.
Refer to the section, Interface Module / Interface Cooling
Module.

• If the Standard Finisher or Booklet Maker Finisher is attached,
use the manual decurl buttons on the finisher. Refer to the
section, Standard / Booklet Maker Finisher.

• Use the Adjust Paper Curl feature; refer to the System Admin-
istration Guide for more information.

Excessive paper curl.
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Suggested solutionsProblem

• Replace the fuser assembly with one that supports the specific
paper width for the current print job. Refer to the Hints and
Tips section of this chapter.

• Cancel the current print job and continue with the print job by
resubmitting from the print server.

Note
Recommend not overriding. This mismatch could prematurely
damage the fuser.

Unable to print with current
fuser assembly. Output pa-
per width does not match
the installed fuser.

• If the fault is a paper jam, ensure that any paper is removed
from the area and that there are no hidden or small pieces of
paper left behind.

• Reboot the press by pressing the On/Off button located on top
of the press near the UI.

Message on UI will not
clear.

Check that Transparencies is selected as the paper type. The press
adjusts for different types of media; paper can tolerate more heat
than transparencies.

Deformed transparencies.

Check paper curl and that the paper tray guides are locked into
position against the paper.

Note
Mixed media sizes may not stack well.

Output is not stacked cor-
rectly.

• Select the option on the press touch screen.
• Check that there are staples in the staple cartridge.
• Check that the Punch Scrap Container is not full.

From the Standard Finisher
or Booklet Maker Finisher,
pages in the set are not
stapled or punched.

Ensure that the drilled paper is loaded correctly in the paper tray
and that the holes are positioned as shown on the tray label.

Drilled paper holes are on
the wrong side.

Image Quality Problems

This section contains a problem solving table to help you locate and resolve an image
quality defect.

Initial Actions

Perform these actions first to improve image quality:

• Check the status of consumables/supplies (CRUs) at the press UI and replace any
due CRUs.

• Run the Cleaning the Fuser Assembly routine at the press UI daily or before any
color-critical job to correct density uniformity.

• Access the print server and perform the print server calibration (refer to the print
server documentation). If necessary, perform 1-sided and 2-sided alignment profiles
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and registration adjustments; refer to the System Administration Guide for more
information.

Secondary Actions

If image quality is not improved after performing the suggested actions below, contact
the Customer Support Center.

Suggested SolutionsProblem

• Perform Initial Actions.

• If a paper jam occurred, run a few blank sheets to clear out re-
sidual dry ink/toner. Run the Cleaning the Fuser Assembly
routine from the Tools screen to automatically clean the fuser
assembly.

• If problem continues, contact the Customer Support Center.

The back side of the printed
output contains dry
ink/toner spots or blotches
(residual and unfused dry
ink/toner).

• Perform Initial Actions (especially the Clean Fuser Assembly
routine and Density Uniformity adjustment).

• Perform the Clean ROS Windows procedure. If the problem
continues, contact the Customer Support Center.

Uneven Density side-to-
side; light or dark areas

• Perform Initial Actions.
• Ensure that the media used is approved, within press specifica-

tions and is clean.
• Check that the press is within environmental specifications

(humidity levels).
• Load a new ream of paper, different media.
• Check for Drum failure or damage. Acquire your measuring tool

from the Nationalization Kit and check the frequency of the
spot intervals. If spots occur every 147 mm on the prints, run
the Halftone Test Pattern to determine which color drum is af-
fected. Replace or swap the Drum.

Random white or dark spots

• Perform Initial Actions.
• Acquire your measuring tool from the Nationalization Kit and

check the frequency of the spot intervals:
• If the defect occurs every 44 mm on the prints, do not replace

the drum. This interval is caused by a damaged or defective
Developer Housing.

• If spots or bands occur every 147 mm on the prints, the Yellow,
Magenta, Black or Cyan Drum is damaged or light-shocked.
Run your Halftone Test Pattern to determine which color drum
is affected. Replace or swap the appropriate Drum cartridge.

• If the defect occurs every 374 mm on the prints, replace the
Fuser Belt Assembly.

Spots at equal intervals
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Suggested SolutionsProblem

• Perform Initial Actions.
• Check for Drum failure. Acquire your measuring tool from the

Nationalization Kit . Run the Halftone Test Pattern to determine
which color drum is affected. Replace or swap the affected
color Drum cartridge.

• Perform the Clean ROS Windows procedure.

Solid color streaks (lead
edge to trail edge)

If you run multiple width papers, refer to Fuser Hints and Tips and
Extended Fuser Life for more information.

Edgewear

• Perform Initial Actions.
• If problem continues, contact the Customer Support Center.

Halo or smudges

Unfused dry ink/toner collected on the ROS windows located above
the Drum Cartridge Drawer prevents the image for that color to
be captured. Streaks will display on the output if the ROS windows
are contanimated. Perform the ROS Window Cleaning procedure.
Use the provided wand to remove dry ink/toner that has collected
on the ROS window.

White streaks or deletions

• Check the status of the CRUs/Supplies screen by pressing the
Home button on the Control Panel. Shake or replace the af-
fected dry ink/toner cartridge.

• Adjust the 2nd transfer settings using media profile in the Stock
Library.

• Determine if the drum is contaminated or light shocked by
running a set of Halftone Test Patterns to identify which color
is affected and then replace or swap the appropriate drum.

Print output is too light,
faint, or washed out; solid
areas not black or inconsist-
ent shading; part of image
missing

• Ensure that the paper is loaded correctly and within press spe-
cifications: set the horizontal and vertical paper guides to the
correct positions and ensure the paper tray guides are against
the edges of the loaded paper. Push the tray in completely.

• Create or use an existing Alignment profile.

Image on the printed out-
put is skewed or crooked

• Check that the paper weight settings at the print server match
the actual paper loaded in the tray.

• Ensure that the paper loaded is within press specifications. Go
to the Paper information section for information on paper and
storage. Load a new ream of paper into the selected paper tray.

• Run the Clean Fuser Assembly routine.

Unfused dry ink/toner on
the output; not permanent
and smears and rubs off
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Suggested SolutionsProblem

• Ensure that the paper tray guides are flush against the edges
of the loaded paper.

• Check that the stock meets the RML requirements.
• Alignment settings may need to be optimized for the media.

Create or use an existing Alignment Profile.

Misregistration or Image
Shift

• Run the Density Uniformity Adjustment routine.
• Create a custom stock and use it.
• If output is still unacceptable, contact the Customer Support

Center.

Trail edge of output con-
tains dry ink/toner dele-
tions, density inconsistency,
or is lacking in color depth;
this occurs mainly when us-
ing heavier or lighter weight
stock

Press Fault Codes
Note
For fault codes for optional feeding and finishing devices, refer to the specific device
chapter in this guide.

If printing ended abnormally, or a malfunction occurred in the press, then a fault code
is displayed. If a fault code appears on the press screen and it is not listed in the table
below, or if a fault persists after following the listed solution, then contact your Xerox
Customer Support Center. If a fault code is displayed, all print data on the press as well
as print data stored in the system’s built-in memory is discarded.

Recommended solutionPossible causeFault codeFault Area

Remove unnecessary data
from the hard disk to increase
free disk space.

Unable to process the job
template due to insufficient
hard disk space.

002-770General

Check the 2 Sided Book Copy
settings.

Unable to store any docu-
ments with 2 Sided Book
Copy feature.

003-750

Increase the resolution or
scan area size.

The press is unable to pro-
cess size, because the spe-
cified document area is too
small.

003-751

Decrease Scan Resolution to
400 dpi or less, and rescan.

When setting a mixed size
document to Full Color/2
Side and attempting to scan
at 600dpi, an error occurs.

003-752Scanner (Document
Feeder/Glass)
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Recommended solutionPossible causeFault codeFault Area

Decrease Scan Resolution to
200 dpi or less, and rescan.

When scanning a mixed size
document using the 2 sided
simultaneous scan feature
with 300, 400, or 600 dpi,
an error occurs.

003-753

Reprocess the job.An error occurred in the
document feeder.

003-754, 003-
755

Document Feeder

Decrease Scan Resolution to
300 dpi or less, and rescan.

When scanning a mixed size
document using the 2 sided
simultaneous scan feature
with 400, or 600 dpi, an er-
ror occurs.

003-757Scanner (Document
Feeder/Glass)

Check the selected options.An incompatible combina-
tion of features is specified
in the document scan condi-
tions.

003-760Copy or Scan Fea-
ture

Change the paper size for the
tray, or change the Paper
Type Priority settings.

The paper size of the tray
selected for auto tray is dif-
ferent from the paper size
of the tray selected for Auto
Repeat.

003-761

Take one of the following ac-
tions:

• Manually enter a reduc-
tion/enlargement ratio

• Change the paper size.

When enlarging/reducing a
scanned document to the
specified paper size, the re-
duction/enlargement ratio
value exceeds the allowed
range.

003-795

Power-cycle the machine.
Contact your Xerox Customer
Support Center.

An error occurred in the
document feeder.

005-274, 005-
275, 005-280,
005-281, 005-
282, 005-283

Document Feeder

Power Off/On the press.
If error persists, contact the
Customer Support Center.

Fuser Assembly belt speed
fault

010-319Fuser Assembly

Power Off/On the press.
If error persists, contact the
Customer Support Center.

Pressure Roll Sensing fault,
Humidity Sensor fault, Fuser
Belt error, Temperature
faults, and Fuser Motor
fault

010-604, 010-
605, 010-606,
010-607, 010-
608, 010-612,
010-613

Check the belt module install-
ation. Replace Belt Module
Assembly.

Fuser Belt walk failure010-611
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Recommended solutionPossible causeFault codeFault Area

Power-cycle the machine.
Contact your Xerox Customer
Support Center.

An error occurred on the
software settings.

016-210, 016-
211, 016-212,
016-213, 016-
214, 016-215

Press Software

Power-cycle the machine.
Contact your Xerox Customer
Support Center.

The machine does not have
the software license.

016-219

Power-cycle the machine.
Contact your Xerox Customer
Support Center.

An error occurred in the
document scanner.

016-220, 016-
221, 016-222,
016-223, 016-
224, 016-225,
016-226, 016-
227, 016-228

Scanner (Document
Feeder/Glass)

Login as administrator. Select
Machine Status  > Tools  >
System Settings  > Common
Service Settings  > Mainten-
ance  > Delete All Certific-
ates / Initialize Settings .
From the screen, select Start.

Software error016-405General

Check the DNS configurations
and IP address retrieve
method.

Unable to retrieve IP ad-
dress from DNS.

016-454Connectivity / Net-
work

Remove unnecessary data
from the hard disk to increase
free disk space.

Annotation is not possible
due to insufficient hard disk
space.

016-708General

Check print options and spe-
cify the print data again. If
the hard disk is malfunction-
ing, contact your Xerox Cus-
tomer Support Center.

Delayed print documents
cannot be registered.

016-710

Increase resolution or scan
area size.

The machine is unable to
process size, because the
specified document area is
too small.

016-712
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Recommended solutionPossible causeFault codeFault Area

Perform one of the following:

• When printing by auto-
matic tray selection, set
one of the paper types to
a setting other than
Automatic Tray Switch-
ing  > Off  in Paper Type
Priority.

• Check print data.

An error occurred during
print processing. Probable
causes are as follows:

• Printing was instructed
by automatic tray selec-
tion when Paper Type
Priority is set to Auto-
matic Tray Switching  >
Off  for all paper in the
Common Service Set-
tings.

• ESC/P command error

016-721

Retry printing after waiting
for a period.

Attempted to print Job
Template List while updat-
ing the job template.

016-735

Specify the printable paper
size for booklet creation.

Booklet Creation is not ap-
plied to the specified paper.

016-738

Specify the combination of
the printable document and
paper size for booklet cre-
ation.

The specified document and
paper size are an unauthor-
ized combination.

016-739

Specify the printable paper
tray for booklet creation.

Booklet Creation is not ap-
plied to the specified paper
tray.

016-740

Reduce the number of pages
of print data, for example, by
dividing up the print data or
printing one copy at a time
when making multiple copies.

Printing is not possible due
to insufficient hard disk
space.

016-748

Cancel the printing prohibited
specification using Adobe
Reader, and try to print again.

Attempted to process PDF
file which was specified to
printing prohibited.

016-755

Check with your System Ad-
ministrator.

No permissions to use the
service.

016-756

Enter the correct password.Password is incorrect.016-757

Check with your System Ad-
ministrator.

No Permissions to use ser-
vice.

016-758

Check with your System Ad-
ministrator.

Maximum number of pages
for this service has been
reached.

016-759

Contact the SMTP server ad-
ministrator.

Cannot connect to the
SMTP server.

016-764
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Recommended solutionPossible causeFault codeFault Area

Contact the SMTP server ad-
ministrator.

An error occurred on the
SMTP server.

016-766

Check the DHCP environment.
Or, specify a fixed IP address
for the machine.

The IP address for the ma-
chine is not set properly.

016-773

Remove unnecessary data
from the hard disk to increase
free disk space.

Compression conversion is
not possible due to insuffi-
cient hard disk space.

016-774

Remove unnecessary data
from the hard disk to increase
free disk space.

Image conversion is not
possible due to insufficient
hard disk space.

016-775

The hard disk might be defect-
ive. When replacing a hard
disk, contact your Xerox Cus-
tomer Support Center.

A hard disk error occurred
during image processing.

016-777

Remove unnecessary data
from the hard disk to increase
free disk space.

Conversion processing of
scanned image was interrup-
ted, because of insufficient
disk space.

016-778

Retry scanning.An error occurred during
scanned image conversion
processing.

016-779

The hard disk might be defect-
ive. When replacing a hard
disk, contact your Xerox Cus-
tomer Support Center.

A hard disk error occurred
during scanned image con-
version processing.

016-780

Either remove unnecessary
data from the hard disk to in-
crease free disk space, or ini-
tialize the hard disk.

When using the scan fea-
ture, hard disk capacity is
insufficient for writing to a
file.

016-786

Check whether you can access
the specified forwarding des-
tination.

In Scan to FTP / SMB, or
Job Template, the forward-
ing destination or job tem-
plate save location could
not be accessed.

016-791

Specified job history does not
exist.

Specified job history could
not be acquired, when
printing Job Counter Re-
port.

016-792

Either remove unnecessary
data from the hard disk to in-
crease free disk space, or ini-
tialize the hard disk.

The hard disk has run out
free space.

016-793

Xerox® Versant® 80 Press15-14
User Guide

Press Problem Solving



Recommended solutionPossible causeFault codeFault Area

Check the data stored in the
media with a computer.

An error occurred when
reading data stored in a
media (such as a card read-
er for a digital camera).

016-794, 016-
795

Remove all paper from the
tray. Set the output tray for
three fold.

The envelope folder tray is
full.

024-987, 024-
988

General

Power Off/On the press.
If error persists, contact the
Customer Support Center.

Developer Housing fault024-923, 024-
924, 024-925

Developer

Create an Auto Alignment
Profile at the Stock Library
Manager. If error persists,
contact the Customer Support
Center.

Registration error; press de-
tected less than optimal re-
gistration thresholds

26-401

Change the IP address.IP address already exists027-452General

Change the IP address
manually.

Failed to obtain IP address
from DHCP server.

027-453

Check the medium with a
computer, or insert the medi-
um correctly..

The medium (media reader
/ USB drive) is damaged or
inserted incorrectly.

027-700, 027-
701

Check the data stored in the
media with a computer.

No data is stored in the
medium, or the data stored
in the medium is damaged.

027-702

Check the connection
between the media reader
and the machine.

A media reader is not con-
nected with the machine
correctly.

027-703

Power Off/On the press.
If error persists, contact the
Customer Support Center.

Machine Drum Motor faults,
Drive Motor faults, Fan
faults

042-3xx, 042-
6xx

NOHAD / Drive

Power Off/On the press.
If error persists, contact the
Customer Support Center.

Communication, Controller,
Fan and Connector failures

045-310, 045-
311, 045-390
to 396

Print Engine

Power Off/On the press.
If error persists, contact the
Customer Support Center.

Power fault046-310HVPS

Power Off/On the press.
If error persists, contact the
Customer Support Center.

Fuser temperature faults059-335, 059-
399

Fuser

Power Off/On the press.
If error persists, contact the
Customer Support Center.

Press power faults060-3xx, 061-
3xx, 061-6xx,
061-9xx

ROS
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Recommended solutionPossible causeFault codeFault Area

Contact your Xerox Customer
Support Center.

An error occurred in the
document feeder or it mal-
functioned.

062-211, 062-
220

Document Feeder

Contact your Xerox Customer
Support Center.

A communications error oc-
curred between the docu-
ment scan unit and the
document feeder.

062-277

Power-cycle the machine. If
the machine is not improved
by performing the relevant
remedy, contact your Xerox
Customer Support Center.

An error occurred in the
document feeder.

062-278

Check to see if the document
can be copied.

The scanned document is
copy-protected.

062-790Copy / Scan Fea-
tures

Contact your Xerox Customer
Support Center.

An error occurred in the
document feeder.

063-210Document Feeder

Contact your Xerox Customer
Support Center.

An error occurred with the
machine.

065-210General

Power-cycle the machine. If
the machine is not improved
by performing the relevant
remedy, contact your Xerox
Customer Support Center.

An error occurred in the
document feeder.

065-215, 065-
216, 065-219

Document Feeder

Check accepted paper is
loaded correctly in trays, clear
any paper jams, and com-
pletely close all trays, drawers
and doors on press.

Incorrect paper positioning,
Entrance area paper jam
faults, Paper tray faults, Pa-
per path sensor faults, Open
drawer faults, Open door
interlock faults

071-1xx, 071-
2xx, 072-1xx,
072-2xx, 073-
1xx, 073-2xx,
075-1xx, 075-
2xx, 075-3xx,
075-6xx, 076-
1xx, 076-2xx,
076-3xx, 077-
1xx, 077-2xx,
077-3xx, 077-
4xx, 077-6xx,
077-9xx, 078-
1xx, 078-2xx,
078-3xx, 078-
4xx, 078-6xx,
078-9xx

Paper Handling /
Transport

Power Off/On the press.
If error persists, contact the
Customer Support Center.

089-313, 089-
314, 089-316,
089-317

Registration
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Recommended solutionPossible causeFault codeFault Area

Reseat the Drum Cartridge;
For 091-324 to 091-327, re-
place the Drum Cartridge.

Erase Lamp faults; Drum
Cartridge not set correctly

091-323 to
091-327, 091-
4xx to 091-
9xx

Xerographic Clean-
ing

Reposition the waste bottle,
order a new waste bottle, and
replace when full.

Waste Toner Bottle Near
Full

091-400

Reseat the Drum Unit (Y);
Switch Drum Units; If prob-
lem persists, replace Drum
Unit (Y).

CRUM data is damaged091-920, 091-
924

Reseat the Drum Unit (M);
Switch Drum Units; If prob-
lem persists, replace Drum
Unit (M).

CRUM data is damaged091-922, 091-
925

Reseat the Drum Unit (C);
Switch Drum Units; If prob-
lem persists, replace Drum
Unit (C).

CRUM data is damaged091-923, 091-
926

Reseat the Drum Unit (K);
Switch Drum Units; If prob-
lem persists, replace Drum
Unit (K).

CRUM data is damaged091-915, 091-
916

Power Off/On the press.
If error persists, contact the
Customer Support Center.

Software error092-333Process Control

Replace/Reinsert Cartridge.
Ensure Doors are closed.
Power Off/On the press. Con-
tact Customer Support.

Dry Ink/Toner Cartridge093-3xx, 093-
4xx, 093-6xx,
093-9xx

Power Off/On the press.
If error persists, contact the
Customer Support Center.

Transfer Belt or Roll fault094-312, 094-
318

Transfer

Fuser Belt Assembly is out of
position. Reseat the assembly
and make sure the Belt Edge
Sensor is in contact with the
belt edge.

Fuser Belt in Limit Fail099-339

Power Off/On the press.
If error persists, contact the
Customer Support Center.

General Fuser faults099-xxx
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Recommended solutionPossible causeFault codeFault Area

Fuser Belt Assembly is out of
position. Reseat the assembly
and make sure the Belt Edge
Sensor is in contact with the
belt edge.

Fuser Belt Out Limit Fail099-340

Paper Jams

Paper Jams Overview

If a paper jam occurs, a fault screen displays a message on the press UI indicating in
which area the jam is situated. Follow the instructions provided for clearing the jam and
resuming press operation.

Information about Paper Jams

Review the following list to address paper jams:

• When paper jams inside the press, the press stops and a fault message displays.
• Follow the instructions displayed on the User Interface to remove the jammed paper.
• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove

all torn pieces.
• If a piece of jammed paper remains inside the press, the paper jam message will

remain on the display.
• Paper jams can be removed with the press still powered on. When the power is turned

off, all information stored to the system's memory will be erased.
• Do not touch components inside the press. This can cause print defects.
• After clearing a paper jam, printing is automatically resumed from the state before

the paper jam occurred.
• If a paper jam occurred during printing, press the Start button. Printing is resumed

from the state before the paper jam occurred.

Warning
When removing jammed paper, make sure that no pieces of jammed paper are left in
the press. A piece of paper remaining in the press can cause fire. If a piece of paper is
stuck in a hidden area or paper is wrapped around the fuser unit or rollers, do not remove
it forcefully. You can get injured or burned. Switch off the press immediately and contact
the Customer Support Center.
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Document Feeder Jams
1. Gently lift the latch of the document feeder top cover until it is completely open.

2. Open the left cover until it comes to a stop.

3. If the document is not caught in the entry of the document feeder, then remove it.

4. If instructed to open the inner cover, lift up the lever, and open the inner cover.
Remove the jammed document.

Note
If the document is stuck, do not pull on it forcefully, as this could damage the
document.
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5. If the jam is inside of the left cover, remove the jammed document.

6. Close the following open covers until they click into place. Close them in the following
order:

• Inner cover
• Top cover
• Left cover

7. If a document jam cannot be found, slowly raise the document feeder, and if the
document is there, remove it.

8. Close the document feeder.
9. If indicated, raise the feeder tray area and remove the document.

10. Gently return the feeder tray to its original position.
11. After removing the jammed document, follow the instructions to reload the entire

document set into the document feeder.

Note
Ensure that there are not any torn, wrinkled, or folded documents in the document
set. To scan torn, wrinkled or folded documents, use the Document Glass, only. The
already scanned document sheets are automatically skipped and scanning resumes
from the document sheet last scanned prior to the jam.
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Document Jams Under the Document Feeder Belt
1. Open the document feeder.

2. Open the belt of the document cover while gripping the lever, and remove the jammed
document.

3. Gently return the belt to the original position.

4. Close the document feeder.
5. Follow the instructions to reload the entire document set into the document feeder.

Note
Ensure that there are not any torn, wrinkled, or folded documents in the document
set. To scan torn, wrinkled or folded documents, use the Document Glass, only. The
already scanned document sheets are automatically skipped and scanning resumes
from the document sheet last scanned prior to the jam.
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Paper Jams Inside the Press

Warning
Never touch a labeled area (found on the fuser unit or nearby) indicating High
Temperature andCaution. Contact can lead to burns.

1. Open the press Front Door.

2. Rotate Handle 2 to the right until it is in the horizontal position, and then pull out
the transfer module.

3. Remove the visible jammed paper.
4. After clearing the jammed sheets, ensure that no torn paper pieces are left in the

machine.
5. Move Handle 2b and remove any jammed paper.

6. Return Handle 2b to its original position.
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7. Move Handle 2e and remove any jammed paper.

8. Return Handle 2e to its original position.
9. Pull down Handle 2f and remove the jammed paper.

10. Return Handle 2f to its original position.
11. Push in the transfer module completely and rotate Handle 2 to the left.
12. Close the pree Front Door.
13. Run five blank sheets to clean left-over toner from the fuser roll and resume the

copying/printing process.

Paper Jams in Trays 1-3
Note
Paper is sometimes torn and remains inside the press if you open a tray without checking
the paper jam position. This may cause a malfunction. Check where the paper jam
occurred before clearing the problem.

1. Open the tray where the paper jam occurred.
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2. Remove the jammed paper.

3. Push the tray in gently until it comes to a stop.

Paper Jams in the Bypass (Tray 5)
Tip
Always ensure that all paper jams, including any small, ripped pieces of paper, are cleared
before proceeding with any print jobs.

1. Remove the paper currently loaded in the Bypass Tray.
2. Lift and open the Cover Tray located near the entrance of the press and remove any

jammed paper.
3. Close the tray cover.

Note
If paper is torn, check inside the press and remove it.

4. Reload paper into the tray and resume printing.
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Fuser Hints and Tips

Extending Fuser Life

To extend the life of your fuser, discuss the usage of multiple fusers with your Service
Representative. Multiple fusers provide maximum print output for longer periods of time
and ensure image defects on output are avoided. Depending on the types of jobs run
and their frequency, you may want more than one fuser available, such as the following
for example:

• One fuser roll for narrower paper
• One fuser for wider paper

Preventing Fuser Damage
1. To reduce 11 in./279.4 mm lines and wear marks, you may require the use of two

fusers - one when running 8. 5x 11 in./A4 stock, and the other when running 12 x
18 in./304.8 x 457.2 mm or larger stock. This is especially true for the graphic arts
people.

2. Image quality defects such as marks or spots will occur every 110 mm/4.3 in. on the
prints if the fuser roll is damaged. Defects which occur every 98 mm/3.89 in. indicate
a damaged fuser belt.

Fuser Paper Width Information

The press is delivered and installed with a standard type fuser that accomodates all
paper width sizes. However, the press allows for the installation of other fuser assemblies
and paper width types for printing specific paper width ranges. When installing a new
fuser, the customer can indicate that the fuser be used for certain paper widths only.
Identifying the fuser width type is performed by connecting the appropriate fuser jumpers
provided in the nationalization kit as well as attaching a colored fuser width clip.

Before using the new fuser, the system administrator must update the NVM width setting
values to match the specific width used for this fuser.

The following table defines the media sizes and width ranges that can be set for the
fuser.

Table 1. Bypass Connector used for Default Paper Width NVM Settings

Width rangeMedia sizeBypass Connect-
or

Range No.

98.0 - 330.2 mm (3.858 - 13.0 in.)All paper widthsNone1
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Width rangeMedia sizeBypass Connect-
or

Range No.

270.4 - 298.0 mm (9.84 - 11.69 in.)A4/Letter SEF A3
SEF
A4/Letter LEF
11 x 17 in.
12 in.

Black Resistor
Type

2

300.0 - 330.2 mm (12.09 - 13.00 in.)SRA3
13 in.

Blue Type3

100.0 - 330.2 mm (3.937 - 13.0 in.)Custom4 See Note

Note
Refer to the System Administrator Guide on how to set the NVM width.
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16
Press Technical Data

Press Specifications

General Press Specifications

Rated Speed

80 pages per minute of Letter (8.5 x 11 in.) / A4 paper size (full color or black only)

Print Modes

Two print modes are supported and are specified at the print server:

• 4 Color Mode (CMYK)
• Black and White Mode (Greyscale)

Maximum Printable Area

• Default Border: 2 mm on all sides
• Adjustable Border: 0.5 mm up to 400 mm on all sides
• Print Image Quality Assurance Area: 317 mm x 482 mm (12.48 x 18.89 inches)

• For Trays 1, 2 or 3:

- 323.0 x 482.0 mm

Paper Size Ranges

• Minimum:

- Trays 1-3: 5.5 x 7.2 in./A5 (140 x 182 mm)
- Bypass Tray: 4 x 5.6 in. (98 x 146 mm)

• Maximum:
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Trays 1-3: 13 x 19.2 in. (330 x 488 mm)-
- Bypass Tray: 13 x 19.2 in. (330 x 488 mm)

Printing Resolution

• Print Engine Imaging Resolution: 2400 x 2400 dpi
• Print Server RIP Resolution (print server to print engine): 1200 x 1200 dpi

First Print-Out Time

From standby mode, system usually takes less than 1 minute to the start printing
• From a cold start (power on or power saver), system takes less than 5 minutes to start

printing

Press Warm-up Time

The press warmup times vary depending on the current state/mode of the press. Warmup
times are listed as follows:

• From a cold start (either power on or power saver mode), less than 5 minutes
• From Sleep Mode/Power Saver, less than 5 minutes
• From Standby Mode, less than 1 minute
• When switching print modes (such as from black only to full color), approximately 2

minutes

Document Feeder Specifications

SpecificationItem

Size:
Maximum: A3/11 × 17 in. (297 ×432 mm)
Minimum: A5/5.82 x 8.26” (148 x 210 mm)
Weight: 10-53 lb./38-200gsm (2 sided: 50-200 gsm)
Type:
A5, A5, A4, A4, 8.5 × 11 in., 8.5 × 14 in. (SEF), 11 × 17 in. (SEF)

Document Size / Type

250 sheets
When using Xerox 20 lb./75 gsm paper.

Paper Capacity

Monochrome: 80 sheets/minDocument Changing Speed
(8.5 x 11 in./A4 portrait, 1-
sided)
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Paper Tray Information

Print Engine Trays 1, 2 and 3

When the press is first installed, the tray size setting for Trays 1 and 3 are set at 8.5 x
11 inches or A4 (LEF). The tray size setting for Tray 2 is set at 11 x 17 inches or A3 (SEF).
When the Stock Library Manager is installed on the print server, the default for all trays
is Letter (8.5 x 11 inches). At the Stock Library Manager, the operator can then set those
trays to different stock size settings. The specifications for each tray are:

• Maximum of 550 sheets of 24 lb.(90 gsm) uncoated paper; 28 lb. to 80 lb. cover
(105-120 gsm) coated stock

• Paper weight range of 18 lb. Bond to 95 lb. Cover (64 gsm to 256 gsm)
• Paper sizes starting at 7.2 x 7.2 in. (182 x 182 mm) to a maximum of 13 x 19.2 in.

(330 x 488 mm)
• If using the optional Postcard bracket, minimum size is 101.6 x 152.4 mm (4 x 6

inches)

Note
For more information on the optional Postcard bracket, refer to the Paper and Media
section of this guide.

• Stock types include transparencies, heavyweight, coated and uncoated, predrilled,
and tabs

• Loading paper Long Edge Feed (LEF)/portrait or Short Edge Feed (SEF)/landscape
(dependent on the actual paper size)

• Auto size detection capability
• Automatically adjusts the tray position in the front and back based on the paper size;

this is done once the tray is closed

Bypass Tray 5

• Maximum of 250 sheets of 24 lb. (90 gsm) uncoated paper; 28 lb. to 110 lb. cover
(106-300 gsm) coated stock

• Paper weight range of 52 gsm (uncoated) to 300 gsm (coated)
• Stock types include transparencies, heavyweight, coated and uncoated, predrilled,

and tabs

Throughput / Productivity Information

Process and print speed is based on simplex/duplex mode, paper type, paper weight,
paper size and feeding tray.
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Table 2. Trays 1, 2 and 3 in LEF Feed Direction

Prints Per MinuteSimplex/DuplexPaper WeightPaper Type

100 ppm / 50 ppmSimplex / Duplex64 to 256 gsm8.5 x 11 / A4 uncoated
and coated

40 ppmSimplex106 to 256 gsm8.5 x 11 / A4 Labels
and Transparencies

80 ppmSimplex106 to 176 gsm8.5 x 11 / A4 Tab un-
coated and coated

80 ppmSimplex177 to 256 gsm8.5 x 11 / A4 Tab un-
coated and coated

Table 3. Trays 1, 2 and 3 in SEF Feed Direction

Prints Per MinuteSimplex/DuplexPaper WeightPaper Type

80 ppm / 40 ppmSimplex / Duplex64 to 256 gsm8.5 x 11 uncoated and
coated

60 ppm / 30 ppmSimplex / Duplex64 to 256 gsmA4 uncoated and
coated

60 ppm / 30 ppmSimplex / Duplex64 to 256 gsm8.5 x 14 / B4 uncoated
and coated

52 ppm / 26 ppmSimplex / Duplex64 to 256 gsm11 x 17 / A3 uncoated
and coated

50 ppm / 24 ppmSimplex / Duplex64 to 256 gsm12 x 18 / SRA3 un-
coated and coated

50 ppm / 24 ppmSimplex / Duplex64 to 256 gsm13 x 19.2 coated and
uncoated

32 ppmSimplex106 to 256 gsm8.5 x 11 / A4 Labels
and Transparencies

25 ppmSimplex106 to 256 gsm8.5 x 14 / B4 Labels
and Transparencies

Table 4. Tray 5 (Bypass Tray)

Prints Per MinuteSimplex/DuplexPaper WeightFeed DirectionPaper Type

70 ppm / 35 ppmSimplex / Duplex52 to 300 gsmPostal card 148 x
148 mm

70 ppm / 35 ppmSimplex / Duplex52 to 300 gsmLEF8.5 x 11 / A4 un-
coated and coated

60 ppm / 30 ppmSimplex / Duplex52 to 300 gsmSEF8.5 x 11 uncoated
and coated

50 ppm/ 25 ppmSimplex / Duplex52 to 300 gsmSEFA4 uncoated and
coated
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Prints Per MinuteSimplex/DuplexPaper WeightFeed DirectionPaper Type

50 ppm / 25 ppmSimplex / Duplex52 to 300 gsmSEF8.5 x 14 / B4 un-
coated and coated

44 ppm / 22 ppmSimplex / Duplex52 to 300 gsmSEF11 x17 / A3 un-
coated and coated

41 ppm / 21 ppmSimplex / Duplex52 to 300 gsmSEF12 x 18 / SRA3
coated and un-
coated

40 ppm / 20 ppmSimplex / Duplex52 to 300 gsmSEF13 x 19.2 coated and
uncoated

Copy Specifications

110/125Item

ConsoleCopier Type

600 × 600dpi (23.6 × 23.6 dots/mm)Scanning Resolution

600 × 600dpi (23.6 × 23.6 dots/mm)Output Resolution

256 gradationGradation

5 minutes or less (when the room temperature at 68° F/20° C)Warm-up Time

The maximum size is 297 × 432 mm (A3, 11 × 17in.) for both sheets
and books

Copy Document

Max: 12.6 × 19.2in. (320 × 488 mm), 13 x 19 (330 x 483 mm)
Min: A5/5.75 x 8.25 in. (Postcard for Tray 5 (Bypass))
Image loss:
Lead edge/trail edge: 0.157 in./4 mm or less
Front/back 0.157 in./4 mm or less.

Copy Paper Size

Paper Trays 1 - 3
A5, A4 LEF, A4 SEF, A3, B5, B4
8.5 × 11 in. LEF, 8.5 × 11 in. SEF, 8.5 × 13 in., 8.5 × 14 in., 11 × 17 in.,
12.6 × 19.2 in. (320 x 488 mm)
8K,16K, tab paper (8.5 x 11 in./A4)
Non-standard size: X direction from 5.5-13 in./140-330 mm, Y direc-
tion from 7-19 in./182-488 mm
Tray 5 (Bypass)
A6, A5, A4 LEF, A4 SEF, B4
8.5 × 11 in. LEF, 8.5 × 11in. SEF, 8.5 × 13 in., 8.5 × 14 in.,11 × 17 in.,
12 × 18 in., 12.6 x 19.2 in. (320 x 488 mm)
, 13 x 19 in. (330 x 483 mm)
8K,16K
Non-standard size: X direction from 5.8-19 in./148-488 mm, Y direc-
tion from 4-13 in./100-330 mm

Trays 1-3, 6, 7: 13 - 57 lb./52 - 216 gsm
Tray 5 (Bypass): 13 - 67lb./52 - 253 gsm
Use Xerox recommended papers for best results.

Copy Paper
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110/125Item

3.5 seconds (When the Document Glass, 100% Reduction/Enlarge-
ment, Tray 1, 8.5 x 11 in./A4 are used)
5.0 seconds (A4/Document Feeder/Finisher Output Tray)

First Copy Output Time
Values may differ depend-
ing on machine configur-
ation.

100%: 1:1 ± 0.7%
Preset%: 1:0.500,1:0.707,1:0.816,1:0.866,
1:1.154,1:1.225,1:1.414,1:1.632, 1:2.000
Variable%: 1:0.25 to 1:4.00 (in 1% increments)

Copy Reduction / Enlarge-
ment Ratio

Continuous 1-sided copy/100% reduction/enlargement
7 x 10 in./B5: 116 sheets/min
8.5 x 11 in./A4: 110 sheets/min
SEF:
8.5 x 11 in./A4: 78 sheets/min
7 x 10 in./B5: 78 sheets/min
10 x 14 in./B4: 69 sheets/min
11 x 17 in./A3: 55 sheets/min
Continuous 2-sided copy/100% reduction/enlargement
7 x 10 in./B5: 116 pages/min
8.5 x 11 in./A4: 110 pages/min
SEF:
8.5 x 11 in./A4: 70 pages/min
7 x 10 in./B5: 70 pages/min
10 x 14 in./B4: 62 pages/min
11 x 17 in./A3: 55 pages/min

Continuous Copy Speed
The speed may be re-
duced in order to adjust
image quality.
The performance may be
reduced depending on
the paper type.

Standard:
Tray 1: 1,200 sheets
Tray 2: 1,800 sheets
Trays 3: 600 sheets each
Tray 5/Bypass: 280 sheets
Maximum paper capacity: 9080 pages (including Trays 6 and 7
(optional High Capacity Feeder)
The maximum paper capacity (9080) is based on 20 lb./75 gsm

Paper Feed Method / Ca-
pacity

9,999 sheets
The machine may pause temporarily to perform an image stabiliza-
tion.

Continuous Copy Pages

Scan Specifications

Color scannerType

Maximum size: 297 × 432 mm (A3/11 × 17in.) for both sheets
and books

Scan Size

600 × 600dpi, 400 × 400dpi, 300 × 300dpi, 200 × 200dpi
(23.6 × 23.6, 15.7 × 15.7, 11.8 × 11.8, 7.9 × 7.9 dots/mm)

Scan Resolution

Color: 10-bit input / 8-bit output for each RGB color
Monochrome: 1 bit input, 1 bit output
color: 10 bit input, 8 bit output for each RGB color

Scan Graduation
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Color scannerType

200 copies/min (Scanning into mailbox for ITU-T No.1 chart
8.5 x 11 in./A4 200dpi)
Important: Scanning speed varies by the document.

Document Scan Speed

Sharing with print controllerInterface

Supported protocol: TCP/IP (Salutation, HTTP)
Output format: Monochrome (2 colors: TIFF)
Driver: TWAIN (Salutation)
Driver supported OS: Windows 2000/XP, Microsoft Windows
Server 2003, Microsoft Windows Vista, Windows 7

Scan to Folder

Supported protocol: TCP/IP (SMB, FTP), NetBEUI (SMB)
Supported Operating Systems: Windows 2000, Windows XP,
Windows Server 2003, Windows Server 2008, Windows Vista,
Windows 7, Novell NetWare 5.x
*1 SMB protocol only is supported.
*2 FTP protocol only is supported.
Output format:
Monochrome 2 colors: TIFF (compression type: MH and MMR)
DocuWorks, PDF

Scan to PC

Supported protocol: TCP/IP (SMTP)
Output format
Monochrome 2 colors: TIFF (compression type: MH and MMR)
DocuWorks documents, PDF

E-mail

Paper Specifications
Note
Always refer to the Recommended Media List (RML) for a comprehensive list of supported
media. The RML can be accessed can be downloaded from www.xerox.com.
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Weight (gsm)TraysPaper SizePaper Type

52 to 256
52 to 350

Trays 1 to 3
Trays 5, 6 and 7

B5 SEF/LEF
A4 SEF/LEF
A4-Cover SEF/LEF
DT Special A4 SEF/LEF
B4 SEF
A3 SEF
SRA3 SEF
DT Special A3 SEF
4 x 6 in. SEF
7.25 x 10.5 in. SEF/LEF
8 x 10 in. SEF/LEF
8.46 x 12.4 in. SEF
8.5 x 11 in. SEF/LEF
8.5 x 13 in. SEF/LEF
8.5 x 14 in. SEF
9 x 11 in. SEF/LEF
11 x 15 in. SEF
11 x 17 in. SEF
12 x 18 in. SEF
12.6 x 19.2 in. SEF
13 x 18 in. SEF
16-kai (TFX) SEF/LEF
16-kai (GCO) SEF/LEF
Pa-kai (TFX) SEF
pa-kai (GCO) SEF

Plain paper (coated & uncoated)
Drilled paper (coated & un-
coated)

64 to 105All TraysRecycled paper (coated & un-
coated)

106 to 256
106 to 350

Trays 1 to 3
Trays 5, 6 and 7

Embossed (coated & uncoated)

---All Trays8.5 x 11 in. (A4) LEFTransparency

106 to 350Trays 5, 6 and 7Postcard (coated & uncoated)

---215.9 x 330.28.5 x 13 in.Government-Legal SEF/LEF

---226.0 x 310.08.90 12.20 in.DT Special A4 SEF/LEF

---310.0 x 432.012.20 x 17.00 in.DT Special A3 SEF

rectangle 3 x 10 SEF
Square SEF / LEF

Envelopes

106 to 256
106 to 350

Trays 1 to 3
Trays 5, 6 and 7

8.5 x 11 in./A4 LEFLabels (coated & uncoated)

163All Trays9 x 11 in. LEFTabbed Inserts
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Environmental Specifications
The temperature and relative humidity of the room where the press is located must be
within the minimum and maximum allowable temperature and relative humidity limits
for the press system to operate correctly.

Ambient temperature

The operating temperature range is 10° to 32° Celcius (50° F to 90° F)

Relative humidity

The required humidity range is 15 % to 85% (relative humidity) - (RH) J zone (Dew
condensation is inhibited)

Altitude

The press functions at the elevation of 0 to 2,500 meters (0 to 8,200 feet)
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17
1-Tray High Capacity
Feeder (HCF / Tray 6),
Letter-Size / A4 Only

High Capacity Feeder (HCF) Overview
The 1-tray High Capacity Feeder (HCF), otherwise known as Tray 6, provides a
2,000-sheet, letter-size (8.5 x 11 in./A4) paper source.

Note
Only letter-size (8.5 x 11 in.)/A4 paper, Long Edge Feed (LEF) can be used in this tray.
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Loading Paper in the 1-Tray High Capacity
Feeder (HCF / Tray 6)
Tips about the 1-tray HCF (Tray 6):

• This tray accommodates only 8.5 x 11 in./A4 Long Edge Feed (LEF) stock
• Stock weights between 18 lb./64gsm bond to 80 lb./220 gsm cover may be used in

this tray
• It holds a maximum of 2000 sheets of 20lb./75 gsm paper
• Stock must be loaded only in LEF direction
• Do not load materials above the MAX line

1. Select the appropriate paper stock for your job.
2. Pull out the tray slowly until it stops.

3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
5. Load the paper in the tray.

a) Align the edge of the paper against the RIGHT edge of the tray.
b) Move the paper guides to just touch the edges of the paper stack.
Do not load materials above the MAX line.

6. Gently push in the tray until it comes to a stop.
If enabled by your System Administrator, the Paper Tray settings screen may be
displayed on the UI.

7. If changes have been made to the paper tray, select the Change Settings button;
otherwise, proceed to the next step.
a) Make the desired selections for Paper Type/Paper Weight, Paper Size, and Paper

Color.
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b) If necessary, make the desired changes to paper curl and alignment adjustment.

Note
Refer to the System Administration Guide for detailed information on the paper
curl and alignment adjustment options.

c) Select Save until you are returned to the tray settings window.

8. Select Confirm to close the window.

HCF Problem Solving

Clearing Paper Jams in the HCF (Tray 6)
1. Open Tray 6 and remove any jammed paper.

Note
If paper is torn, check for any torn pieces of paper inside the machine.

2. Gently close the tray.
3. Gently move Tray 6 to the left until it stops.

4. Grasp the top cover handle and open the top cover.

5. Remove any jammed paper from the top cover area of Tray 6.
6. Close the Tray 6 top cover.
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7. Return Tray 6 to its original position.

Clearing HCF Paper Jams in the Lower Left Cover
1. Gently move Tray 6 to the left until it stops.

2. Gently open the lower left cover while gripping the release handle.

3. Remove the jammed paper.

Note
If paper is torn, check for any torn pieces of paper inside the machine.

4. Gently close the lower left cover.
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5. Gently move Tray 6 back into position.

HCF (Tray 6) Fault Codes

If an error caused the printing to end abnormally, or a malfunction occurred in the
machine, then an error code is displayed. When an error code is displayed, all print data
of the machine as well as print data stored in the machine's built-in memory is discarded.

Note
If an error code appears that is not listed in the table below, or if an error persists after
following the listed solution, then contact the Xerox Customer Support Center.

RemedyCauseFault Code

Add paper to Tray 6.Tray 6 is empty/out of paper.024-955

Reset the paper or cancel the job.The designated paper size and
size of paper in the tray differ
when feeding paper from the
inserter.

024-974

1. Check the paper loaded in Tray 6.
2. Power off and then power on the

machine.
3. If the tray errors are not fixed by

performing the relevant remedy,
contact the Customer Support
Center.

(Optional) Paper Tray 6 malfunc-
tioned.

078-100, 078-
101, 078-102,
078-151

Power-cycle the machine. If the machine is
not improved by performing the relevant
remedy, contact your Xerox Customer Sup-
port Center.

The high capacity tray (the Tray
6) malfunctioned.

078-250
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RemedyCauseFault Code

1. Check the paper loaded in Tray 6.
2. Power off and then power on the

machine.
3. If the tray errors are not fixed by

performing the relevant remedy,
contact the Customer Support
Center.

(Optional) Paper Tray 6 malfunc-
tioned.

078-260, 078-
261, 078-262,
078-263, 078-
264, 078-265,
078-266, 078-
267, 078-268,
078-269, 078-
270, 078-271,
078-272, 078-
273, 078-274,
078-275, 078-
276, 078-277,
078-278, 078-
279, 078-280,
078-300, 078-
301, 078-500,
078-901, 078-
941, 078-942,
078-943

HCF Specifications

SpecificationItem

2,000 sheetsPaper Capacity

8.5 x 11 in. or A4Sheet Size

18 lb. bond to 80 lb. cover / 64-220 gsm (uncoated or coated)Paper Weight
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18
1- or 2-Tray Oversized High
Capacity Feeder (OHCF /
Trays 6 and 7)

Oversized High Capacity Feeder
Introduction
The Oversized High Capacity Feeder (OHCF) is available in a 1-tray or 2-tray option. The
OHCF feeds a variety of stock sizes, including standard and oversized stock up to 13 x
19.2 in./330.2 x 488 mm. Each tray holds 2,000 sheets.

2-tray OHCF (with Bypass)1

1-tray OHCF (with Bypass and storage cabinet above the tray)2
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Loading Media in the 1- or 2-Tray
Oversized High Capacity Feeder (OHCF /
Trays 6 and 7)

Information About Loading Media in the Oversized High Capacity
Feeder (OHCF)
Note
Each feeder tray has a stock loading label. When loading media into the tray, refer to
the labels on the inside panel of the feeder tray for the correct orientation of that stock
type.

Note
It is recommended that you use the Bypass Tray (Tray 5) to feed envelopes. However,
if you use Trays 6 or 7, C5 and #10 envelopes must be fed SEF with the Postcard Bracket
installed. Stack height is limited to 200 envelopes.

Postcard Bracket

The Postcard bracket is delivered with the OHCF from manufacturing. The Postcard
bracket allows you to print on smaller size media without requiring post-processing
cutting or sorting. The Postcard bracket specifically accommodates 4 x 6 in. (101.6 x
152.4 mm) SEF media.

Using the Postcard Bracket

Use the following procedure for installing and using the Postcard bracket when printing
on smaller media (4 x 6 in./101.6 x 152.4 mm).

With the Postcard Bracket installed, you could print envelopes from Trays 6 and 7. The
stack height is up to 200 envelopes.
1. Slowly open one of the paper trays until it stops and remove the paper.
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2. Move the paper guides out to their largest position.

3. Open the front cover of the OHCF.

4. Remove the Postcard bracket from inside the OHCF front cover.
5. Install the Postcard bracket so that it sits on the locating pins on the upper frame

and in the grooves on the bottom of the tray.
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6. Tighten the thumb screw so it locks the Postcard bracket in place.

7. Load the postcard stock and adjust the paper guides against the stock.

8. Close the paper tray and confirm the new settings at the print server.
9. Run your print job.

10. Upon completion of your print job, remove the postcard stock and the Postcard
bracket from the tray.

11. Store the Postcard bracket inside the OHCF front cover area.

Loading Paper in the Oversized High Capacity Feeder (OHCF)
1. Select the appropriate paper stock for your print/copy job.
2. Pull out the tray slowly until it stops.
3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
5. Load paper into the tray.
6. Adjust the paper guides by pressing in the guide release and carefully moving the

Edge Guide until it lightly touches the edge of the material in the tray.

Do not load materials above the MAX line located on the rear Edge Guide.

7. Gently push in the tray until it comes to a stop.
The Paper Tray settings/Tray Properties window displays on the UI. You can view
and set stock attributes and verify trays are assigned with the correct stock.

8. From the Paper Tray settings/Tray Properties window, enter or verify the correct paper
information, including size, type, weight and, if necessary, paper curl and/or alignment
option. Select the stock and assign the stock to the tray to be used.

9. Select Confirm or OK to save the information and close the Paper Tray settings/Tray
Properties window.
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Loading Tabs in the Oversized High Capacity Feeder (OHCF)

Refer to the following tips before loading tab stock in the tray:

• You can load either single straight collated or single reverse collated tab stock.
• For network print jobs, refer to your print server customer documentation for

instructions on loading tab stock into a tray.
• If a jam occurs while running tabbed sets, cancel the job and start again.

1. After programming your tab job at the print server, select the appropriate and
matching tab stock for your print job.

2. Pull out the tray slowly until it stops.
3. Fan the tab paper before loading into the tray.
4. Load the tab stock LEF (portrait) and align the straight edge of the tab stock against

the right edge of the tray (tabs to the left or trailing edge). For single straight collated
tabs, the first blank tab cutout in the stack will be toward the front of the tray. For
single reverse collated tabs, the first blank tab cutout in the stack will be toward the
rear of the tray.

Tab stock is loaded so the straight edge of the stock is in the feed direction. Also, you
can only load the tab stock LEF.

5. Adjust the paper guides by pressing in the guide release and carefully moving the
Edge Guide until it lightly touches the edge of the stock in the tray.

Do not load materials above the MAX line located on the rear Edge Guide.

6. Gently push in the tray until it comes to a stop.
The Paper Tray settings/Tray Properties window displays on the UG.

7. From the Paper Tray settings/Tray Properties window, confirm the correct tray to
which it is printing and other information, including size (9 x 11 inches), type (precut
tab), and, if necessary, paper curl and/or alignment option.

8. Select Confirm or OK to save the information and close the Paper Tray settings/Tray
Properties window.

Loading Transparencies in the Oversized High Capacity Feeder
(OHCF)

Read these tips before using transparencies:

• Do not use transparencies with the white side strip (either permanent or removable).
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• Do not mix paper and transparencies in a tray. Jams may occur.
• Do not load more than 100 transparencies in a paper tray at one time.
• Load 8.5 x 11 in (A4) transparencies long edge feed only (landscape).

1. Select the appropriate paper stock for your print job.
2. Pull out the tray slowly until it stops.
3. Fan the transparencies to stop them from sticking together before loading into the

tray.
4. Load transparencies LEF on top of a small stack of same-size paper and align the

strip edge of the transparency against the right edge of the paper tray, with the side
to be printed on facing down.

5. Adjust the paper guides by pressing in the guide release and carefully moving the
Edge Guide until it lightly touches the edge of the material in the tray.

Do not load materials above the MAX line located on the rear Edge Guide.

6. Gently push in the tray until it comes to a stop.
If enabled by your System Administrator, the Paper Tray settings/Tray Properties
window displays on the UI.

7. From the Paper Tray settings/Tray Properties window, enter the correct paper
information, including size, type, weight and, if necessary, paper curl and/or alignment
option.

8. Select Confirm or OK to save the information and close the Paper Tray settings/Tray
Properties window.

Loading Pre-Drilled Stock into the Oversized High Capacity Feeder
(OHCF)
1. Select the appropriate paper stock for your print job.
2. Pull out the tray slowly until it stops.
3. Open the ream of paper with the seam side facing up.
4. Fan the sheets before loading them into the tray.
5. Load and register the paper against the right side of the tray for LEF direction.
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6. Load and register the paper against the right side of the tray as depicted below for
SEF direction.

7. Adjust the paper guides by pressing in the guide release and carefully moving the
Edge Guide until it lightly touches the edge of the stock in the tray.

Do not load materials above the MAX line located on the rear Edge Guide.

8. Gently push in the tray until it comes to a stop.
If enabled by your System Administrator, the Paper Tray settings/Tray Properties
window displays on the UI.

9. From the Paper Tray settings/Tray Properties window, enter the correct paper
information, including size, type, weight and, if necessary, paper curl and/or alignment
option.

10. Select Confirm or OK to save the information and close the Paper Tray settings/Tray
Properties window.

Skew Adjustment Levers
The skew adjustment levers are found in all paper trays. These levers are used to improve
paper feed accuracy and to reduce paper skew problems.

1. Rear Skew Adjustment Lever
2. Right Side Skew Adjustment Lever

Note
These levers should remain in their default position. The position of these levers should
be changed only if there is a skew problem when running a specific print job and/or
media type. Changing the levers may cause more skew problems when running certain
media types such as coated, label, transparency and film.

Use the following procedure to set the skew adjustment levers:
1. Pull out the tray slowly until it stops.
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The Stock Library Manager and Tray settings automatically display at the print server.

2. From the Tray Properties window at the print server, verify that the correct paper
information is being used including size, type, weight and paper curl or alignment
option for the tray. Select OK and close the Tray Properties window.

3. At the tray, slide the rear skew adjustment lever to the right.
4. Gently push in the tray until it comes to a stop.
5. Run your print job.

• The paper is fed accurately without skew and the printed output is satisfactory;
your task is complete.

• The paper is skewed and the printed output is unsatisfactory; proceed to the next
step.

6. Pull out the tray slowly until it stops.
7. Verify the tray and paper settings at the print server.
8. Return the rear skew adjustment lever to its left, default position.
9. Slide the right-side skew adjustment lever toward the front of the paper tray.

10. Gently push in the tray until it comes to a stop.
11. Run your print job.

• The paper is fed accurately without skew and the printed output is satisfactory;
your task is complete.

• The paper is skewed and the printed output is unsatisfactory; proceed to the next
step.

12. Pull out the tray slowly until it stops.
13. Return the right-side skew adjustment lever toward the rear of the paper tray; this is

its default position.
14. Gently push in the tray until it comes to a stop.
15. If you are still having skew adjustment problems, refer to the Advanced Stock Setup

information.

OHCF Maintenance

Consumable Supplies for the OHCF

Approximate Print Yield (Full
Color 8.5x11/A4 Prints)

Reorder QuantityCRUs (Supply Item)

500,0001 kitOHCF Feed Roll Kit
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Replacing the OHCF Bypass Tray Feed Rolls
Tip
The feed rolls for OHCF bypass tray should be replaced when experiencing frequent
multifeeds, single feeds, or blank prints in the stack of the output prints.

Use this procedure to replace the OHCF Bypass tray feed rolls, which includes:

• Feed Roll
• Nudger Roll
• Retard Roll

Note
After you replace all of the feed rolls, contact your system administrator who will reset
the HFSI usuage counter for these CRU components to zero (0).

1. Locate and access the Bypass Tray on top of the OHCF.
2. Lift up and open the Bypass Tray cover to access the feed roll components.

3. Remove and replace the feed roll by squeezing the metal shaft and lifting out.

18-9Xerox® Versant® 80 Press
User Guide

1- or 2-Tray Oversized High Capacity Feeder (OHCF / Trays 6 and 7)



4. Remove and replace the nudger roll using the same technique.

5. Remove and replace the retard roll using the same technique.

6. Close the bypass tray cover.
7. Verify that the tray is operating correctly by feeding paper from the bypass tray.
8. Either log in as the administrator or ask the administrator to perform the following

steps to reset the HFSI count to zero (0):
a) At the UI press the Machine Status button.
b) Select the Tools tab.
c) Select System Settings  > Common Service Settings  > Maintenance.
d) Use the up/down arrow buttons to access the next Maintenance screens.
e) Select the Technical Key Operator icon. The Technical Key Operator feature

displays.
f) Select the MSI rolls item that corresponds with the newly-replaced components.
g) Select Reset Current Value. The system resets the HFSI to 0.

9. Exit the administrator mode by pressing the Log In/Out button on the UI. When
prompted, select Logout.

Replacing the OHCF Feed Rolls
The OHCF feed rolls should be replaced every 300,000 prints or when experiencing
frequent multifeeds, single feeds, or blank prints in the stack of the output prints.

Use this procedure to replace the OHCF feed rolls, which includes:

• Feed Roll
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• Nudger Roll

• Retard Roll

Note
After you replace all of the feed rolls, contact your system administrator who will reset
the HFSI usuage counter for these CRU components to zero (0).

1. Pull open the top tray of the OHCF to access the feed components.

2. Notice the feed roll compartment on the right side panel of the drawer.

3. Remove the nudger roll by pushing down on the black tab with one hand (which raises
the roll upward) and then squeezing the metal shaft on both ends with your other
hand. Lift out the nudger roll.

4. Replace the new roll by squeezing both ends of the metal shaft, and pushing down
on the black tab, insert and release the roll ends into the notches.
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5. Next, remove the retard roll assembly at the side of the feeder tray to access the
retard roll. Unscrew the 3 thumbscrews.

6. Slide the retard assembly all the way to the left so it is out of the slots. Pull the
asssemly out towards you until completely removed from the tray. Set aside.

7. With the retard assembly out, access and remove the feed roll. To remove, squeeze
both ends of the metal shaft and lift out. To replace, squeeze both ends of the new
roll shaft, and insert and release the roll ends into the notches.

8. Finally, replace the retard roll. Squeeze the orange shafts of the retard roll and lift
out of the assembly.
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9. Replace a new retard roll into the black notches of the assembly using the same
technique.

10. Reinstall the retard assembly into the tray. Align the cutout holes of the assembly
with the frame of the tray so the pin holes match up. Insert the assembly into the
frame. Slide the assembly all the way to the right using the pin as a guideline. Ensure
the device is all the way into the slots and the 3 screw areas align.

11. Screw in the 3 thumbscrews to attach the assembly. Do not overtighten.
12. Close the tray and verify that the tray is operating successfully by feeding paper

using that tray.
13. Either log in as the administrator or ask the administrator to perform the following

steps to reset the HFSI count to zero (0).
a) At the UI press the Machine Status button.
b) Select the Tools tab.
c) Select System Settings  > Common Service Settings  > Maintenance.
d) Use the up/down arrow buttons to access the next Maintenance screens.
e) Select the Technical Key Operator icon.

The Technical Key Operator feature displays.

f) Select the item (HCF) that corresponds with the newly-replaced components.
g) Select Reset Current Value. The system resets the HFSI to 0.

14. Exit administrator mode by pressing the Log In/Out button on the UI.
When prompted, select Logout.
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OHCF Problem Solving

OHCF Fault Codes

Recommended SolutionPossible CauseFault CodeFault Area

Perform the following in this order:
1. Remove or clear any

jammed paper.
2. Replace and fan the paper

in tray.
3. Replace the OHCF Feed

Rolls.

Pre-registration sensor
jam; during paper trans-
portation, feed sensor is
not turned on within peri-
od of time paper is trans-
porting from tray

078-100,
078-101,
078-102,
078-103

Tray 6

Perform the following in this order:
1. Remove or clear any

jammed paper.
2. Replace and fan the paper

in tray.
3. Power Off / On the press.

Feed rolls timing error078-106Tray 6

Perform the following in this order:
1. Remove or clear any

jammed paper.
2. Replace and fan the paper

in tray.
3. Replace the OHCF Feed

Rolls.

Pre-registration sensor jam
during paper transporta-
tion from Bypass Tray

078-105,
078-120

Bypass Tray

Perform the following in this order:
1. Remove or clear any

jammed paper.
2. Replace and fan the paper

in tray.
3. Replace the OHCF Feed

Rolls.

Pre-registration or feed
sensor jam during paper
transportation from Tray
7

078-150,
078-151,
078-156

Tray 7
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Recommended SolutionPossible CauseFault CodeFault Area

Perform the following in this order:
1. Remove or clear any

jammed paper.
2. Replace and fan the paper

in tray.
3. Power Off / On the press.
4. If problem still persists,

contact the Customer Sup-
port Center

Pre-registration sensor jam
during paper transporta-
tion from Bypass Tray

078-110Bypass Tray

Gate sensor not turned on
fault during paper trans-
portation from Tray 6

078-112Tray 6

Gate sensor not turned on
fault during paper trans-
portation from Tray 7

078-113Tray 7

Gate sensor not turned on
fault during paper trans-
portation from Bypass
Tray

078-114Bypass Tray

Multiple feed of sheets078-125,
078-126,
078-127

Trays 6, 7 and
Bypass

General tray malfunction078-2xx,
078-3xx,
078-4xx,
078-6xx,
078-9xx

Trays 6 / 7

OHCF Jam Clearance

Clearing OHCF Jams

Nip Release levers inside of the Transport area of the Feeder hold back large size sheets
(such as A3, 11 x 17 inches, 12 x 18 inches) to reduce the chance of jamming as paper
enters the print engine.

Note
Follow the jam clearance instructions displayed on the touch screen. Always ensure that
all paper jams, including any small ripped pieces of paper, are cleared before proceeding
with your print jobs.
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Paper Jams Inside the OHCF Trays
1. Pull out the tray where the paper jam occurred.

2. Remove the jammed paper.

Note
If paper is torn, check inside the machine and remove it.

3. Gently push in the tray until it comes to a stop.

OHCF Paper Jams at Lever 1a and Knob 1c
1. Open the front cover of the OHCF.
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2. Move the lever 1a to the right and turn the knob 1c to the right. Remove the jammed
paper.

Note
If paper is torn, check inside the machine and remove it.

3. Return the lever 1a to the original position.

4. Close the front cover of the OHCF.

Note
If the front cover of the OHCF is not completely closed, a message will appear and
the machine will not operate.

OHCF Paper Jams at Lever 1b and Knob 1c
1. Open the front cover of the OHCF.
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2. Move the lever 1b to the right and turn the knob 1c to the right. Remove the jammed
paper.

Note
If paper is torn, check inside the machine and remove it.

3. Return the lever 1b to the original position.

4. Close the front cover of the OHCF.

Note
If the front cover of the OHCF is not completely closed, a message will appear and
the machine will not operate.

OHCF Paper Jams at Lever 1d and Knob 1c
1. Open the front cover of the OHCF.
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2. Move the lever 1d upward and remove the jammed paper.

Note
If paper is torn, check inside the machine and remove it.

3. If the paper cannot be removed, turn the knob 1c clockwise, and then remove the
jammed paper.

Note
If paper is torn, check inside the machine and remove it.

4. Return the lever 1d to the original position.

5. Close the front cover of the OHCF.
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Note
If the front cover of the OHCF is not completely closed, a message will appear and
the machine will not operate.

OHCF Specifications

SpecificationItem

1 Tray: 2,000 sheets plus top Storage Cabinet
2 Tray: 2,000 sheets per tray (total of 4,000 sheets)

Important
When using up to Xerox 24 lb. / 90 gsm paper.

Paper Capacity

1 Tray: 7.2 x 10 in. / 182 x 250 mm (B5) to 13 x 19.2 in. / 330 x 488 mm
(SRA3)
2 Tray: 4 x 6 in. / 102 x 152 mm to 13 x 19.2 in. / 330 x 488 mm (SRA3)

Sheet Sizes

18 lb. bond to 110 lb. cover / 64 to 300 gsm (uncoated and coated)Paper Weight
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19
Business Ready (BR)
Finisher and Optional
Booklet Maker

Business Ready (BR) Finisher Overview
Tip
The BR Finisher (with or without Booklet Maker) attaches directly to the press and does
not require the Interface Module/Interface Cooling Module.

The Business Ready (BR) Finisher adds several professional-level finishing options to the
press while requiring minimal additional space for the finisher. The finisher is available
with or without an optional booklet maker.

Business Ready (BR) Finisher without Booklet Maker

The BR Finisher supports hole punching and stapling. The Right Top Tray is used for
stacked output, and can receive up to 500 sheets of paper. The Stacker is used for
offset and/or stapled output, and can hold up to 3,000 sheets.
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Business Ready (BR) Finisher with the optional Booklet Maker

The BR Finisher with the optional Booklet Maker supports hole punching, stapling, and
booklet making. The Right Top Tray is used for stacked output, and can receive up to
500 sheets of paper. The Right Center Tray is used for offset and/or stapled output
and can hold up to 1,500 sheets. Both trays can be used for hole punched output
(optional). The Bottom Finisher Tray is used for receiving saddle-stapled booklets.

Identifying the BR Finisher Components

1. Finisher Front Cover
2. Right Top Tray
3. Right Middle Tray
4. Staple Cartridge
5. Booklet Maker Tray (optional)
6. Booklet Staple Unit (optional)
7. Booklet Maker Unit (optional)
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BR Finisher Maintenance

Consumable Supplies for the BR Finisher

Approximate Print Yield (Full
Color 8.5x11/A4 Prints)

Reorder QuantityCRUs (Supply Item)

5,000 staples per cartridge1 Staple CartridgeBusiness Ready (BR) Finisher Staple
Cartridge

5,000 staples per cartridge4 pack: 5,000 staple re-
fills each

Business Ready (BR) Finisher with
Booklet Maker Staple Cartridge

5,000 each refill for a total of
15,000

3 refills per cartonStaple Refills for the Business Ready
Finisher and Business Ready Finisher
with Booklet Maker

Replacing Staples in the Main Stapler Unit
1. Open the front door of the Business Ready Finisher.
2. Hold the stapler assembly by the orange lever R1 and push it to the right.

3. Grip the staple cartridge by the orange handle and pull it firmly toward you to remove
it.
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4. Pinch both sides of the staple refill (1)and remove it from the cartridge (2).

5. Insert the front side of the new staple refill into the staple cartridge (1), then push
the rear side into the cartridge (2).

6. Close the front door of the Business Ready Finisher.

Replacing Staples in the Booklet Maker
1. Open the front door of the Business Ready Finisher.
2. Grasp the booklet maker handle and pull the unit toward you until the staple cartridges

appear on the top edge of the device.

3. To remove the staple cartridge from the booklet maker, push down on the staple
cartridge handle as shown, then pull the cartridge out and up.
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4. Turn the staple cartridge over.
5. To permit the staple cartridge handle to open out and away from the staple refill,

press in the green tabs, then pull back the handle.

6. To remove the staple refill, press the rear of the refill container as shown.

7. Replace the staple refill, then return the staple cartridge to the booklet maker.
8. Close the front door of the Business Ready Finisher.

Emptying the Hole Punch Waste Container

A message appears on the press User Interface (UI) when the hole punch waste container
is full.

Warning
Do not perform this procedure while the printer is copying or printing.

1. Open the front door of the Business Ready Finisher.
2. Remove the hole punch waste container from its slot near the top left of the finisher.

• Wait 10 seconds before reinserting the container into the printer. The hole punch
counter resets after 10 seconds.

• If you remove the hole punch waste container before the device instructs you
to, empty the container before you reinsert it into the finisher.
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3. Empty the container.

4. Insert the container all the way into the finisher.

5. Close the front door of the Business Ready Finisher.

Problem Solving for the BR Finisher

Clearing Jams in the BR Finisher at Position 3a
1. If the paper is visible at the output tray exit, remove the paper by pulling it gently in

the direction shown.

2. Open the front door of the Business Ready Finisher.
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3. Lift green handle 3a.

4. Carefully remove the paper.

• If the paper is torn, remove all torn pieces from the finisher.
• If the paper is inaccessible, or if the press User Interface (UI) prompts you to

release the paper, turn green handle knob 3b in the direction shown.

5. Return green handle 3a to its original position.

6. Close the front door of the Business Ready Finisher.

Clearing Jams in the BR Finisher at Position 3c
1. Open the front door of the Business Ready Finisher.
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2. Move green lever 3c to the left.

3. Carefully remove the paper.

• If the paper is torn, remove all torn pieces from the finisher.
• If the paper is inaccessible, or if the press User Interface (UI) prompts you to

release the paper, turn green handle knob 3b in the direction shown.

4. Return green lever 3c to its original position.

5. Close the front door of the Business Ready Finisher.

Clearing Jams in the BR Finisher at Position 3d
1. Open the front door of the finisher, and locate green lever 3d.
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2. Move green lever 3d to the right.

3. Carefully remove the paper.

Note
If the paper is torn, remove all pieces from the finisher.

4. Return green lever 3d to its original position.

5. Close the front door of the Business Ready Finisher.

Clearing Jams in the BR Finisher at Position 4
1. Open the front door of the Business Ready Finisher.
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2. Using the green handle, pull out unit 4until it stops.

3. To remove the jammed paper, turn green knob 4 in either direction as shown.

Note
If the paper is torn, remove all torn pieces from the finisher.

4. Return unit 4 to its original position.

5. Close the front door of the Business Ready Finisher.

Clearing Jams in the Booklet Tray
1. Open the front door of the Business Ready Finisher.
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2. To release the jammed paper, turn green knob 4 in the direction shown.

3. To remove the paper, pull it in the direction shown.

Note
If the paper is torn, remove all torn pieces from the finisher.

4. Close the front door of the Business Ready Finisher.

BR Finisher Specifications
BR Finisher without Booklet Maker

SpecificationItem

Offset (Top) Tray: 500 sheets
Stacking / Stapling Tray:

• 3,000 sheets unstapled or
• 100 sets (dual or 4-position staple), 11 x 17 in., 8.5 x 14 in., A4 or
• 200 sets (single-position staple), 8.5 x 11 in. / A4

Tray Capacity

4 x 6 in. to 12 x 19 in. / A6 to SRA3 for stacking
7.25 x 10.5 in. to 11 x 17 in. / B5 to A3 for stapling

Sizes

16 lb. bond to 110 lb. cover / 64 to 300 gsm (uncoated and coated)Paper Weight

Single and multi-position stapling
Auto stapling (50 sheets maximum) – 24 lb / 90 gsm
Letter, Legal, Tabloid, A3, A4, B4, and B5 sizes supported

Stapling

North America: 2-3 Hole Punch
Europe: 2-4 Hole Punch; 4 Hole Swedish Punch (Optional)

Hole Punch
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BR Finisher with Booklet Maker

SpecificationItem

Offset (Top) Tray: 500 sheets of 8.5 x 11 in. / A4 unstapled
Stacking / Stapling Tray:

• 1,500 sheets of 8.5 x 11 in. / 11 x 17 in. / A4 / A3 / SRA3 unstapled or
• 200 stapled sets of 8.5 x 11 in. / A4 (single-position stapling or dual

or 4-position stapling) or
• 100 stapled sets of 11 x 17 in. / A3 / SRA3

Tray Capacity

4 x 6 in. to 12 x 19 in. / A6 to SRA3 for stacking
7.25 x 10.5 in. to 11 x 17 in. / B5 to A3 for stapling

Sizes

16 lb. bond to 110 lb. cover / 64 to 300 gsm (uncoated and coated)Paper Weight

Single and multi-position stapling
Auto stapling (50 sheets maximum) – 24 lb / 90 gsm
Letter, Legal, Tabloid, A3, A4, B4, and B5 sizes supported

Stapling

North America: 2-3 Hole Punch
Europe: 2-4 Hole Punch; 4 Hole Swedish Punch (Optional)

Hole Punch

Saddle-stitch 2 to 16 sheets (7 sheets at 106 to 176 gsm coated or 5
sheets at 177 to 220 gsm coated)
Bi-fold up to 5 sheets
Letter, Legal, Tabloid, A3, A4, 12 x 18 in., SRA3 supported

Booklet Maker

Xerox® Versant® 80 Press19-12
User Guide

Business Ready (BR) Finisher and Optional Booklet Maker



20
Interface Module /
Interface Cooling Module

Overview of the Interface Module /
Interface Cooling Module
The Interface Module or Interface Cooling Module is an optional finishing device that
is used in conjunction with other optional finishing devices.

What is the Difference Between the Two Modules?

Both modules enable communication and provide a paper path between the press and
any attached finishing device / devices. The Interface Cooling Module contains additional
fans and associated duct work. These fans and duct work aid in cooling the outgoing
printed media. The Interface Cooling Module is also equipped with an internal
spectrophotometer.
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Finishing Devices that Require Either Module

The following finishing devices require either the Interface Module or the Interface
Cooling Module:

• GBC AdvancedPunch
• High Capacity Stacker (HCS)
• Standard Finisher
• Booklet Maker Finisher
• Standard Finisher Plus

Module Overview

Module Control Panel

The Control Panel consists of the following:

1. Auto Curl button: This button selects the Auto Decurl function.
2. Manual Curl Up button: This button selects the three values of manual up curl.
3. Manual Curl Down button: This button selects the three values of manual down

curl.
4. Curl Up / Down indicators: These indicate the amount of manual curl (up or down)

that is selected.
5. Auto Curl indicator: This indicates that the Auto Curl Mode is selected.
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If you want to quickly and at the point-of-need adjust the paper curl on the printed
output, you may use the Manual Curl Up or Down buttons. If the printed output contains
too much curl after using these buttons, refer to the System Administration Guide for
information on adjusting the paper curl. The paper curl buttons are discussed in more
detail later in this section.

Paper Path through the Module

As media enters the module, it is fed to the module decurler for paper curl correction.
The module decurler has both upper and lower decurler rolls that apply pressure to the
media based upon the following:

• System default
• Manual selections made at the module control panel

Based on the paper curl (decurl) settings, the module decurler gate routes the paper to
either the up-curl (cupped) path, or the down-curl (bridged) path. The degree of pressure
is applied independently to the upward and downward decurler arms.

From the module decurler, the print media is cooled and routed from the module to the
optional finishing device(s) that is/are connected to your machine.

Paper Curl Settings on the Module

Auto Decurl Presettings

The module is designed with several automated presettings for controlling paper curl.
When using the Auto Decurl function, the amount of curl correction is automatically set
by the module decurler.

When the media passes through the module decurler, you are notified of the current
amount of curl correction through the various LEDs on the module Control Panel. If you
require more curl correction, you can manually select curl correction from the module
Control Panel.

Manual Decurl Buttons

The manual decurler mode has seven levels of curl correction that are available at the
module Control Panel: three levels of Up-curl correction and three levels of Down-curl
correction, and no correction level.
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The amount of curl correction is changed by selecting Up or Down button. The current
selected amount of curl correction is displayed by the Control Panel LEDs.

Internal Spectrophotometer (Interface Cooling Module)

The Interface Cooling Module is equipped with an internal spectrophotometer. This
internal spectrophotometer is sometimes referred to as an Inline Sensor (ILS). The
internal spectrophotometer provides the customer with an internal calibration tool that
works with your print server to provide unique calibration and profiling capabilities, which
include the following:

• The ability to calibrate the press from the print server without manually feeding
calibration charts (also known as calibration targets); this is a semi-automated process:

- It is initiated by the operator
- It scans and measures targets automatically without an external

spectrophotometer
- It resets color tables to original values to maintain consistent color

• Operators can create destination or output profiles without having to scan targets
with an external spectrophotometer:

- The digital press prints color targets while the internal spectrophotometer
measures them

- The system then develops a map so that output colors can be produced that
accurately replicate a known standard such as GRACoL or SWAP

- The mapping is written into the profile for the type of media and line screening
used

Tip
These calibration and profiling capabilities are applicable to any associated print server,
including the EX Print Server and FreeFlow Print Server.

Note
The Interface Cooling Module equipment complies with international safety standards
and is certified as a Class 1 Laser Product. With specific regard to lasers, the equipment
complies with laser product performance standards as set by governmental, national,
and international agencies as a Class 1 Laser Product. It does not emit hazardous light,
as the beams are totally enclosed during all phases of customer operation and
maintenance.
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Problem Solving for the Interface Module
/ Interface Cooling Module

Fault Codes for the Interface Module / Interface Cooling Module

Recommended SolutionPossible CauseFault Code

1. Open the Module front
door.

2. Remove all sheets or
pieces from the jam clear-
ance areas.

3. Close the front door.
4. Verify that the paper be-

ing used is within specifica-
tions.

Paper Jam during feeding048-100 to 048-107

Ensure door is fully closed.Module front door is open048-300

1. Power Off / On the press.
2. If error persists, contact

the Customer Support
Center.

Decurler Sensor or Belt issue048-310, 048-311, 048-
312, 048-313, 048-314,
048-315, 048-316

1. Power Off / On the press.
2. If error persists, contact

the Customer Support
Center.

Cooling fan failure048-317, 048-318, 048-
319

1. Ensure all jams are cleared.
2. Ensure all handles / levers

are returned to closed pos-
ition.

3. Power Off / On the press.
4. If error persists, contact

the Customer Support
Center.

Communication failure or connec-
tion failure

048-320 to 048-324
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Recommended SolutionPossible CauseFault Code

1. Open the Module front
door.

2. Remove all sheets or
pieces from the jam clear-
ance areas.

3. Close the front door.
4. Verify that the paper be-

ing used is within specifica-
tions.

Sheets remain in the paper path
area

048-900, 048-901, 048-
903

Jam Clearance on the Interface Module / Interface Cooling Module

Clearing Module Jams
Tip
Always ensure that all paper jams, including any small ripped pieces of paper, are cleared
before proceeding with your print jobs.

Note
Remedies differ according to the paper jam location. Follow the instructions displayed
to remove the jammed paper.

Paper Jams at Lever 1a
1. Open the front cover of the module.
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2. Move the lever 1a downward and remove the jammed paper.

3. Return the lever 1a to the original position.

4. Close the front cover of the module.
5. Follow the instructions on the press UI to clear other areas or to resume your print,

copy, or scan job.

Paper Jams at Lever 2a
1. Open the front cover of the module.

20-7Xerox® Versant® 80 Press
User Guide

Interface Module / Interface Cooling Module



2. Move the lever 2a upward, turn the knob 2c counterclockwise, and remove the jammed
paper.

3. Return the lever 2a to the original position.

4. Close the front cover of the module.
5. Follow the instructions on the press UI to clear other areas or to resume your print,

copy, or scan job.

Paper Jams at Lever 2b
1. Open the front cover of the module.
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2. Move the lever downward, turn the knob 2c counterclockwise, and remove the jammed
paper.

3. Return the lever 2b to the original position.

4. Close the front cover of the module.
5. Follow the instructions on the press UI to clear other areas or to resume your print,

copy, or scan job.
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21
GBC AdvancedPunch

GBC AdvancedPunch Overview
The GBC AdvancedPunch may be attached to a variety of optional finishing accessories.

The GBC AdvancedPunch provides another level of finishing options to your output by
allowing you to punch holes in 8.5 x 11 in. / A4 documents, which support a variety of
binding styles. Punch types include 19-hole to a maximum of 32-hole for 8.5 x 11 in.
media. A4 media supports punch types 21-hole to a maximum of 47-hole

Note
The GBC AdvancedPunch requires either the Interface Module or Interface Cooling
Module. It also requires another finishing device (for example, the High Capacity Stacker).

Detailed information, usage instructions, and jam clearance can be found on the customer
documentation CD that came with the accessory. The documentation also can be
downloaded from www.xerox.com.
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GBC AdvancedPunch Components

GBC AdvancedPunch Operation Controls

DescriptionNameItem

The on / off switch must be in the ON position at all times.On / Off Switch1

An easy-to-access tray for quick disposal of punch remnants.Punch Container:2

Die set changes are completed without tools and only take
seconds to perform.

Die Set Changes3

Storage holds up to 3 spare Die Sets.Die Set Storage4

Provides a short straight-through paper path for unpunched
documents.

Punch Bypass5

Wide radius turn support stocks up to 216 gsm, cover stock.Punch Mode Path6
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Status Indicators on the GBC AdvancedPunch

Located on the front of the AdvancedPunch is a panel that provides information relating
to the operational state of the punch unit. LED lights indicate when the AdvancedPunch
requires attention from the operator.

DescriptionNameItem

The green LED illuminates when the power switch on
the AdvancedPunch is set to the on position.

Note
The power cord for the AdvancedPunch must be
plugged into the appropriate power source prior to
setting the power switch to the on position.

Power On1

When the punch container becomes full of waste paper
remnants,the yellow LED illuminates.

Empty Punch Container2

When the punch container is removed or not fully in-
serted into the punch unit, the yellow LED illuminates.

Fully Insert Punch Contain-
er

3

When the punch die is removed or not fully inserted
into the unit, this LED illuminates.

Fully Insert Punch Die4

When the front door is open or not completely closed,
the yellow LED illuminates.

Close Front Door5

When a sheet of paper becomes jammed within the
punch unit,the yellow LED illuminates. Remove the
sheet that is jammed within the AdvancedPunch.

Clear Paper Jam6

Note
The LED indicators on the AdvancedPunch will glow dimly if the press is turned on while
the AdvancedPunch power switch is in the Off position. After switching on the
AdvancedPunch, the LED indicators illuminate to their full intensity.

Punch Dies

The GBC AdvancedPunch is capable of punching a variety of hole-punch patterns by
simply changing the punch die. Punch dies can be changed in seconds without tools.
Two punch dies are shown in the following illustrations.
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Letter (8.5 x 11 in.) Punch Dies

A4 Punch Dies
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GBC AdvancedPunch Procedures

Changing the Punch Die
Note
The interchangeable punch die is located on the left, front side of the unit.

1. Ensure that the press is in standby mode and is not in the process of running any
copy, scan, or print jobs.

2. Open the AdvancedPunch access door panel.
3. Securely grasp the handle and pull firmly.

This disengages the Automatic Latching Mechanism and allows the punch die to
slide out of the unit.

4. Continue to pull the handle until the Punch Die Set is fully removed, supporting it
with both hands.

5. Properly store the removed Punch Die Set in the Die Set storage area at the top of
the AdvancedPunch.
This keeps it away from dust, dirt, and accidental falls from the edge of counters.

6. Select the desired Punch Die Set for your new job and slide it into the Punch Die Set
slot. Push the die set in firmly until it latches.

Note
Possible pinch-point hazard. When installing the punch die set, always keep fingers
and other body parts out of the unit's die set slot and away from all areas of the
punch die set, except for the finger hole in the die set. Failure to follow these
precautions may result in injury.

7. Close the door panel.
8. Proceed with your printing and punching job.

Note
Please note that when using a new die, some oil will be present around the punched
holes on the sheet. After punching 25 to 50 sheets the die will no longer leave oil on
the sheets. It is recommended that a short test print job be run after installing a new
die or a die that has recently been oiled.

Pre-Punch Job Checkpoints

Prior to beginning a job in which the punching feature of the AdvancedPunch will be
used, perform the following checkpoints:
1. Ensure that no yellow LED indicators are illuminated on the front panel of the

AdvancedPunch.
2. If a yellow LED indicator is illuminated, then correct the fault prior to starting the

punch job.
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Note
The AdvancedPunch will not operate in punch mode if any yellow LED is illuminated.

3. Prior to starting the punch job, ensure that the punch die installed in the
AdvancedPunch is the correct die / hole pattern for the job.

4. If the die is not the correct die, then replace it at this time.
5. To enable the AdvancedPunch punching feature, use the press User Interface.

a) From the press User Interface, select to the Copy feature from the main home
screen.

b) Select Copy Output to enter the Hole Punch & More menu.
c) From the Hole Punch & More menu select the AdvancedPunch option from the

hole punch column.
d) Select Save.

The main Copy feature displays. The AdvancedPunch will now operate in the
punch mode.

Loading Tab Stock with the GBC AdvancedPunch

When this optional finishing device is attached to your press, tab stock is loaded
differently into paper trays. For detailed information on the GBC AdvancedPunch features
and functions, refer to the GBC AdvancedPunch customer documentation which came
with the device.

The AdvancedPunch punches the leading edge of a sheet. This means that tabs must
be fed with the tab on the trailing edge. The manner in which tabs are loaded into the
tray to cause the correct tab-trailing feeding varies depending upon the tray that is
utilized. The following illustration and related text shows the recommended way to load
tabs depending on which feeder is being used:

1. If using the optional HCF (letter-size/A4) or the OHCF (1- or 2-Trays), load the tabs
upside down and change the order one by one (as shown in the illustration).

2. If using the press Trays 1, 2, or 3, load the tabs upside down (as shown in the
illustration).

3. If using an optional finisher with a post-processor inserter (Tray 8/T1), load the tabs
upside down (as shown in the illustration).
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GBC AdvancedPunch Maintenance

Emptying the Punch Container

The Punch Container for your AdvancedPunch is located at the front of the unit base.

• The AdvancedPunch uses a sensor to determine when the punch container is full.
• Once the punch container becomes full, the LED light on the front panel of the

AdvancedPunch illuminates, and a message appears on the press User Interface
screen.

• When this message displays, pull out and empty the container of all paper remnants.

AdvancedPunch Problem Solving

AdvancedPunch Fault Codes

Fault codes for the AdvancedPunch are displayed on the press UI as an AdvancedPunch
fault code.

RemedyCauseFault Code

1. Open AdvancedPunch front door
and look for a paper jam.

2. Remove any paper jam.
3. Close front door.

Jam is detected in the Advanced-
Punch.

040-100
040-101
040-900
040-901

Close front door of the AdvancedPunch.Front door of the AdvancePunch
is not closed.

040-300

Install punch die set or fully insert it; close
front door.

The punch die set is missing or
not fully installed.

040-940

Install and / or fully insert punch container;
close front door.

Punch container is missing or
not fully installed.

040-941

Empty punch container and then reinstall
it.

Punch container is full.040-942

Empty punch container and then reinstall
it.

Punch container is near full.140-700

21-7Xerox® Versant® 80 Press
User Guide

GBC AdvancedPunch



AdvancedPunch General Problems

RemedyCause

1. Check that the power cord is attached to the
back of the unit.

2. Ensure that the power cord is plugged into the
wall outlet.

3. Ensure that the AdvancedPunch power is
switched on.

4. If the problem continues, contact the Custom-
er Support Center.

No power or will not punch

Turn the Punch Die Set knob (J3) to the Home position.
The Home position is when the arrows line up.
The Die Set should now slide out easily.

Punch Die Set will not come out when
using a moderate pull or the set is in
partial cycle
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AdvancedPunch Jam Clearance

Clearing Jams in the AdvancedPunch

This symbol indicates a paper jam. To assist in clearing paper jams in any
of the following areas, turn one or more of the small knobs to advance
the paper.

Jam Clearance SolutionJam Area

If paper is jammed in the Punch Bypass, lift the paper guide plate
located inside, and remove the jammed paper.

If paper is jammed in the downward paper path chute, move the door
to the right, remove the jammed paper.

If paper is jammed or the Punch Die Set is jammed, turn Knob J3 to
the HOME position, (arrows line up), slide the Die Set out, and remove
the jammed paper.

If paper is jammed in the bottom chute of the Punch Paper path,
press the bottom chute latch,and remove any jammed paper.
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Jam Clearance SolutionJam Area

If paper is jammed in the upward paper path chute, move the door
to the left, and remove the jammed paper.

GBC AdvancedPunch Specifications

Letter (8.5 x 11 in.), A4Punch Sheet Size

75-216 gsm, coated and uncoatedPaper Stock

Supports tab stock no wider than 9; oversized tabs may be
damaged

Tab Stock

11 in. (279.4 mm)Punch Edge

Same paper sizes and stocks as the pressPaper Bypass Mode Sheet Size
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22
High Capacity Stacker
(HCS)

High Capacity Stacker (HCS) Overview
The High Capacity Stacker (HCS) is an optional finishing device that provides large-
capacity stacking and offsetting capabilities for production output to a Stacker Tray.
Also provides a Top Tray convenient for short stack runs.

Tip
The HCS requires either the Interface Module or the Interface Cooling Module.

1. Interface Module or Interface Cooling Module
2. High Capacity Stacker (HCS)
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High Capacity Stacker (HCS) Components

Identifying the Main HCS Components

The HCS consists of the following components:

1. Control Panel: Provides manual control of the various HCS functions.
2. Top Tray: Holds a maximum of 500 sheets (13 x 19.2 in/330 x 488 mm).

Note
Labels must be delivered to the Top Tray.

3. Bypass: Used only when a second stacking/finishing device is installed. This path
transports media through the HCS to another connected finishing device.

4. Stacker Tray / Cart: Collated sets (up to a total of 5000 sheets) are transported to
the Stacker Tray, which is located on a movable Stacker Cart.

Note
The Stacker Tray / Cart capacity may be less than 5000 sheets if the media being
used is heavyweight or thicker sheets.
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HCS Control Panel

The HCS control panel consists of:

1. Top Tray jam: This indicator blinks when there is a jam in the top tray area (E7).
2. Sample indicator: This indicator blinks until a sample print is delivered to the top

tray.
3. Sample Print button: Press this button to have the HCS deliver a sample print of

the job to the Top Tray. A single-page sample is provided to the output area.
4. Unload button: Press once to lower the Stacker Tray and unlock the HCS front door.
5. Unload indicator: This indicator lights when the Stacker Tray has reached the down

position and the front door can be opened.
6. Identifying the Main HCS Components: This indicator blinks when there is a jam

in the exit area (E8).
7. Stacker Transport jam area: These indicators blink when there is a jam in Areas

E4, E5, and/or E6.
8. Stacker Entrance jam area: These indicators blink when there is a jam in Areas E1,

E2, and/or E3.

HCS Top Tray

The Top Tray offers the following:

• Convenience for short stack runs (up to 500 sheets) without offsetting.
• Delivery of purged sheets.
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Unloading the HCS Stacker Tray / Cart

The HCS has Unload While Run capability.
1. Press the Unload button on the HCS control panel.
2. After the Unload Indicator lights, open the HCS front door.
3. Position the securing bar on top of the stacked paper.
4. Pull the Stacker Tray / Cart straight out of the HCS.

5. Remove the securing bar.
6. Remove the paper from the Stacker Tray / Cart.
7. Push the empty Stacker Tray / Cart straight into the HCS.
8. Position the securing bar on the fixed area inside the HCS.
9. Close the front door; the tray will rise to the operate position.

HCS Problem Solving

HCS Fault Codes
Note
The press configuration can be installed with one or two stacker modules. If the press
includes two HCS modules, the prefix 049 identifies a fault in the first module, and the
prefix 149 identifies a fault in the second module.

This fault code table lists problems and suggested solutions that apply to the High
Capacity Stacker (HCS).

Recommended SolutionPossible CauseFault Code

Carefully remove all sheets and paper
scraps from the jam clearance areas.

jammed paper049-100 - 049-121

Power Off / On the machine. If the
problem persists, contact the Customer
Support Center.

HCS sensor faults049-200 - 049-299
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Recommended SolutionPossible CauseFault Code

Power Off / On the machine. If the
problem persists, contact the Customer
Support Center.

HCS communication fault049-300

Check the properties of the tabs job and
resend the job.

Tabbed sheet fault049-700

Check the paper path of the module
and carefully remove all sheets from
the paper path areas.

Sheets remain in the paper
path

049-900 - 049-908

Open the HCS front door and remove
all sheets and paper scraps from jam
clearance areas. Close the front door.

HCS open door fault049-940

Check the position of the Stacker Tray
/ Cart.

Stacker Tray / Cart fault049-941

Remove paper from the Top Tray.Stacker Top Tray fault049-945

Remove paper from the Stacker Tray /
Cart.

Stacker Tray / Cart fault049-960, 049-964

Open the HCS front door and remove
any paper from the Stacker cart. Close
the door to resume operation.

Stacker Full Detection fault049-965 to 049-972

Open the HCS front door and remove
any paper from the Stacker cart. Close
the door to resume operation.

HCS falsely detects that the
Paper Unload button is pressed

049-973

HCS General Problems

RemedyCauseProblem

Adjust the paper curl before printing the
job. Refer to the System Administration
Guide for specific information on paper curl
settings and adjustment.

Problem occurs when printing with
Clear dry ink/toner and using me-
dia that is 120 gsm, coated, and
large stock sizes (such as 12 x 18
in./304.8 x 457.2 mm).

HCS tampers
no longer in
contact with
paper

Loss of Power to the HCS

If power is interrupted to the High Capacity Stacker, perform the following:

1. Ensure that the power cord is plugged in to the proper wall receptacle.
2. Ensure that the press power is switched on.
3. Ensure that the Ground Fault Indicator is in the On position.
4. If the power has not been restored by checking the above items, then call for Service.
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HCS Jam Clearance

HCS Jam Clearance Overview
Tip
Always ensure that all paper jams, including any small ripped pieces of paper, are cleared
before proceeding with your print jobs.

Note
Remedies differ according to the paper jam location. Follow the instructions displayed
to remove the jammed paper.

HCS Entrance Jams (E1, E2, and E3)

Perform the following steps to clear the jam and resume printing:
1. Open the HCS Front Cover.

2. Lift the green handle(s) and/or rotate the green knob and remove all paper in the
entrance area.

3. Close the green handle(s).
4. Close the HCS Front Cover.
5. If the press UI indicates there is a jam in the print engine, follow the instructions on

the screen to remove any paper in the area indicated.
6. Follow the instructions displayed on the UI to resume printing.
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HCS Transport Jams (E4, E5, and E6)

Perform the following steps to clear the jam and resume printing:
1. Open the HCS Front Cover.

2. Lift the green handle(s) and/or rotate the green knob and remove all paper in the
entrance area.

3. Close the green handle(s).
4. Close the HCS Front Cover.
5. Press the Unload button on the HCS control panel.

Wait until the Unload indicator lights before opening the HCS front door.

6. Open the HCS front door.
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7. Pull out the Stacker Tray / Cart and gently remove the jammed paper.

8. Push the Stacker Tray / Cart straight into the HCS.
9. Close the front door.

10. If the press UI indicates there is a jam in the print engine, follow the instructions on
the screen to remove any paper in the area indicated.

11. Follow the instructions displayed on the UI to resume printing.

HCS Top Tray Jam (E7)

Perform the following steps to clear the jam and resume printing:
1. Remove any output delivered to the Top Tray.

2. Open the HCS Front Cover.
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3. Lift the green handle(s) and/or rotate the green knob and remove all paper in the
entrance area.

4. Close the green handle(s).
5. Close the HCS Front Cover.
6. If the press UI indicates there is a jam in the print engine, follow the instructions on

the screen to remove any paper in the area indicated.
7. Follow the instructions displayed on the UI to resume printing.

HCS Exit Jam (E8)

Perform the following steps to clear the jam and resume printing:
1. Open the HCS Front Cover.

2. Lift the green handle and/or rotate the green knob and remove all paper in the
entrance area.

3. Close the green handle(s).
4. Close the HCS Front Cover.
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5. If the press UI indicates there is a jam in the print engine, follow the instructions on
the screen to remove any paper in the area indicated.

6. Follow the instructions displayed on the UI to resume printing.

Information about Paper Curl and the HCS

Check the output in the Stacker Tray / Cart for paper curl and choose one of the following

• There is no curl present and the output is acceptable (meets customer satisfaction);
you are finished.

• There is no curl present; however, the output is not acceptable: Call for service.
• There is curl present; perform the following:

1. Adjust the paper curl by using the decurler controls on the top of the Interface
Module or Interface Cooling Module.

2. If the output has not improved, adjust the paper curl again.
3. If the output still has not improved, call the Customer Support Center.

HCS Specifications
The High Capacity Stacker (HCS) is available in Single or Dual combinations with
unload-while-run capability. The HCS includes one removable cart for offline finishing;
additional carts available.

HCS Stacker Tray / CartHCS Top Tray

5,000 sheet offset stacking; 7.2 x 8.3 in. up to 13 x 19.2
in. (B5 LEF to SRA3). 52–350 gsm coated / uncoated

500 sheet top tray up to 13 x 19.2 in.
(330 x 488 mm)

HCS Media Guidelines

• Stacker Tray / Cart will accept 52-350 gsm (either coated or uncoated stock) with
the possibility of degraded stock quality and increased jam rate for stocks that are
heavier than 300 gsm.

• Transparencies may be run to either the Top Tray or the Stacker Tray / Cart. Stack
height should be limited to 100 transparencies.

• Coated paper lighter than 100 gsm may not run as reliably as coated paper heavier
than 100 gsm.

• Non-standard papers longer than 305 mm (12 in.) in the feed direction require 210
mm (8.3 in.) minimum measurement across the feed direction.

• Non-standard papers shorter than 254 mm (10 in.) in the cross-feed direction require
330 mm (13 in.) minimum measurement in the feed direction.
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Standard / Booklet Maker
Finisher

Standard / Booklet Maker Finisher
Overview
These two finishers provide the following capabilities:

• The Standard Finisher provides high capacity stacking (up to 3,000 sheets),
bidirectional decurling, along with finishing capabilities such as preprinted inserts,
hole punching and folding.

• The Booklet Maker provides all of the same features of the Standard Finisher plus
automatically creates saddle-stitched booklets of up to 25 sheets. This device offers
hole punching, stapling and bifold options.
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1. Interface Module or Interface Cooling Module: Both finishers require one of these
modules. The module acts as a communication device and as a paper path between
the press and the Standard Finisher or the Booklet Maker Finisher.

2. Standard Finisher or Booklet Maker Finisher: The Booklet Maker Finisher is shown
in the above illustration. For the remainder of this chapter, both the Standard Finisher
or Booklet Maker Finisher are referred by the generic term of "finisher."

Standard / Booklet Maker Finisher Main Components

The Standard / Booklet Maker Finisher is comprised of the following components:

Note
Unless otherwise indicated, components apply to both finishers.

1 Standard Staple Cartridge

Remove this cartridge to replace staples and clear staple jams.

2 Staple Waste Container

Remove this container when it is full.

3 Top Tray

The Top Tray is used for stacked output, and can receive up to 500 sheets of 20 lb. /
80 gsm paper. Output is delivered here when specific output features are selected, such
as Automatic sorting, Collated, Uncollated, or Normal.

4 Stacker (middle) Tray

The Stacker Tray is used for offset and/or stapled output, and can hold up to 2000
sheets of 20 lb. / 80 gsm paper. This tray also receives sheets when you punch and
Z-fold. Both the Top and Stacker Trays can be used for hole punched output (optional).

5 Booklet Output Tray

This is available only with the Booklet Maker Finisher. The Booklet Tray receives
saddle-stitched booklets when you select Single Fold or Single Fold + Stapling.
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6 Booklet Output Tray Button

This is available only with the Booklet Maker Finisher. When you press this button, the
Booklet Output Tray is raised so you can retrieve booklets from the output area.

7 Right Cover

Open to clear paper jams, replace staples, clear jammed staples, or remove the scraps
from the puncher.

8 Staple Cartridges for Booklet Maker

This second stapler is available only with the Booklet Maker Finisher. There are two
staple cartridges for the booklet. Remove this cartridge to replace staples and clear
staple jams.

9 Punch Scrap Container

Collects the scraps from the puncher. Open to remove the scraps.

10 C / Z Fold Output Tray (optional)

The optional C / Z Folder tray receives sheets when you select C-folding or Z-folding of
8.5 x 11 in. / A4 output and 11 x 17 in. / A3 media.

11 Left Cover

Open this cover to access the press and to clear paper jams.

12 Post-Process Inserter (Interposer) Tray

Use this tray to load preprinted stock that serves as separators and covers inserted into
the printed output. Paper loaded in this tray is not printed on. The tray holds up to 200
sheets of 20 lb. / 75 gsm paper and can be loaded either LEF or SEF direction. The press
UI refers to this tray as Tray 8 or Tray T1 depending on your product.

13 C / Z Fold Output Tray Button

Press this button to open the C / Z Folder Output Tray.

14 Manual Decurl Button

When pressed, this button activates a decurling feature for the output. This applies
especially to lighter weight paper.
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Manual Decurling Feature on the Finisher
The finisher provides a manual decurling feature, which allows you to adjust the curl of
the print output at point of need.

Pressing the Decurler button on the finisher switches the decurl feature between the
Auto, On, and Off modes.

1. Auto button: When this indicator is lit, the appropriate curl correction is automatically
performed depending on the sizes and orientation of the printed output. The button
should be set to Auto for most situations. The button automatically switches to the
Auto mode when:

• The press is switched on
• The press exits the Power Saver mode

2. When this button is pressed and the downward curl indicator is lit, downward curl
correction is performed on all printed output. If your output is curled downward,
press this button to prevent downward curls.

3. When this button is pressed and the upward curl indicator is lit, upward curl correction
is performed on all printed output. If your output is curled upward, press this button
to prevent upward curls.

Note
When no indicator is lit, the press does not perform any curl correction to the printed
output.
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Folding Feature on the Finisher

Folding Overview

If your press is equipped with the Booklet Maker Finisher and / or the C / Z Folder, you
can make prints using the folding option. The option folds your prints in half (single or
bi-folding) or in thirds (C-fold or Z-fold types). The folding option is selected from the
print driver.

Note
In order to use the folding option, the orientation of documents must be short-edge
feed (SEF). You must select a paper tray that contains SEF stock.

Fold Types
Important
The Single Fold (Bi-Fold) option is available only with the Booklet Maker Finisher. The
C-Fold and Z-Fold options are available only with the C / Z Folder.

These fold types are available:

Single Fold (Bi-Fold)

A Bi-Fold has one fold which creates two panels to the output.

C-Fold

A C-Fold has two folds which creates a three-panel output.
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Z-Fold

A Z-Fold has two folds that are folded in opposite directions, resulting in a type of fan
fold.

Z-Fold Half Sheet (shown here with 3-hole punch)

As with a regular Z-Fold, it has two folds that are folded in the opposite directions. The
difference between a regular Z-Fold and a Z-Fold Half Sheet is that the Z-Fold Half
Sheet is not folded in two equal folds. The two folds are unequal which allows one edge
of the Z-Fold Half Sheet to have a longer edge, and the longer edge allows for stapling
or hole punching.

Loading Paper / Tabs in the Post-Process
Inserter (Tray 8 / T1)
Note
Depending on your product and system configuration, the Post-Process Inserter is called
either Tray 8 or Tray T1.

Note
This tray is available only on the following finishers:

• Standard Finisher (with our without optional C / Z Folder)
• Booklet Maker Finisher (with our without optional C / Z Folder)
• Standard Finisher Plus (with our without optional C / Z Folder)

1. If necessary, remove any remaining media that is currently loaded in the tray.
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2. Hold the center of the paper guides and slide them to their desired paper size.

3. Load the paper or tabs, aligning it to the front side of the tray.

a) If the paper is preprinted, load the paper with the printed side facing up.
b) If the media is tab stock, load the tab side to be fed first (in the direction of the

arrow as shown in the above illustration).

4. From the Paper Tray settings / Tray Properties window, enter the correct paper
information, including size, type, weight, and if needed, decurler and/or alignment
option.

5. Select Confirm or OK to save the information and close the Paper Tray settings /
Tray Properties window.

Standard / Booklet Maker Finisher
Maintenance

Standard / Booklet Maker Consumable Supplies

Xerox supplies, including staples, staple cartridges, and staple waste containers can be
ordered from Xerox by going to www.xerox.com and clicking on either the Contact Us
link for specific contact information/telephone numbers in your area or by clicking on
the Supplies and entering/selecting your specific machine information (product family
and model type).

Note
Always refer to www.xerox.com for the latest Customer Replaceable Units (CRUs) part
numbers.

Store supply items and Xerox parts in their original packages in a convenient location.
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Supply Unit Shipped with finisher/Reorder QuantitySupply Item

4 staple cartridges (5000 staples per cartridge) and 1
staple waste container per carton

Staple Cartridge and Staple Waste
Container (for both the Standard Fin-
isher and the Booklet Maker Finisher)

4 pack: 5000 staple refills eachBooklet Maker Finisher Staple Cart-
ridge

Replacing the Standard Staple Cartridge

A message displays on the screen when it is time to replace a staple cartridge.
1. Make sure that the machine has stopped printing.
2. Open the right cover on the finisher.

3. Grasp the Staple Cartridge handle located at R1, and pull out the staple cartridge
from the finisher.
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4. Hold the positions as indicated by the arrow and remove the staple cartridge from
the unit.

5. Push a new staple cartridge into the unit.

6. Reinstall the cartridge unit to its original position in the finisher.

7. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Replacing the Booklet Staple Cartridge

In addition to the standard stapler, the Booklet Maker Finisher is equipped with a booklet
stapler. When this booklet stapler needs to be replaced, a message appears on the UI.
1. Make sure that the machine has stopped printing.
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2. Open the right cover on the finisher.

3. While pressing the lever to the right, pull out the booklet staple cartridge unit.

4. Hold the tabs of the staple cartridge unit by the tabs and lift to remove it.

5. While holding the tabs of a new staple cartridge, push it into the unit.
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6. Push the staple cartridge unit to its original position in the machine.

7. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Replacing the Staple Waste Container

The press displays a message indicating that the Staple Waste Container is full. To
replace the container:
1. Make sure that the machine has stopped printing.
2. Open the right cover on the finisher.

3. Locate the Staple Waste Container ( R5) in the finisher, and move the lock lever to
the unlock position.
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4. Hold R5 as shown in the figure and remove the staple waste container from the press.

5. Place the used staple waste container into a supplied plastic bag.

Note
Do not return a disassembled (used) container to the Customer Support Center.

6. Hold the new staple waste container by the R5 handle area and push it into the
press.

Note
To prevent injury, do not put your fingers on top of the container.
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7. Push R5 until the lock lever moves to the locked position.

8. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Emptying the Punch Waste Container

The screen displays a message indicating when it is time to empty the Punch Waste
Container.

Caution
Only remove the Punch Waste Container while the system is powered ON. If you switch
off the power when emptying the container, the press cannot detect that the container
was emptied.

1. Make sure that the machine has stopped printing.
2. Open the right cover on the finisher.
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3. Pull the container out of the finisher ( R4).

4. Discard all the punch scraps in an appropriate container.

5. Reinsert the empty container into the machine.

6. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.
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Standard / Booklet Maker Finisher
Problem Solving

Problem Solving Information
Tip
Always ensure that all paper jams, including any small ripped pieces of paper, are cleared
before proceeding with your print jobs.

Note
Remedies differ according to the paper jam location. Follow the instructions displayed
to remove the jammed paper.

Fault Codes for the Standard Finisher / Booklet Maker Finisher

If an error caused the printing to end abnormally, or a malfunction occurred in either
the Standard Finisher or the Booklet Maker Finisher, then an error code is displayed.

If an error persists after following the listed solution, then contact your Xerox Customer
Support Center.

Recommended solutionPossible causeFault code

Check for any paper jams in the paper
path and remove all sheets.

Paper Jam along booklet
and/or folder paths

012-100 to 012-104,
012-108 to 012-115,
012-117 to 012-120

Check for any paper jams in the paper
path and remove all sheets. Power Off/On
the press and, if needed, resend the print
job. If fault persists, call for service.

The finisher malfunctioned012-125, 012-132,
012-211 to 012-265,
012-282 to 012-296

Make sure the module door is fully closed.
Power Off / On the press if fault persists.

Interlock Fail012-302

Remove and replace the staple waste
container in the finisher.

Staple Waste Container near
full

012-400

Check that the Punch Waste Container is
installed in the finisher and inserted cor-
rectly.

Punch Waste Container is not
attached

012-949

Remove the Staple Waste Container and
install a new one.

The Staple Waste Container
is full or near full

024-931

Check that the Staple Waste Container
is installed in the finisher and inserted
correctly.

The Staple Waste Container
is not attached

024-932

23-15Xerox® Versant® 80 Press
User Guide

Standard / Booklet Maker Finisher



Recommended solutionPossible causeFault code

Check the staple cartridge and reset cor-
rectly. If needed, replace with a new
cartridge. Resume job.

The booklet staple cartridge
is empty or stapling error oc-
curred

024-943

Add paper to the paper tray.Post-Process Inserter Tray is
empty or out of paper

024-957

Reset/change the paper or cancel the job.When feeding paper from the
Post-Process Inserter Tray, the
designated paper size and the
actual size of paper in the
tray differ.

024-974

Check staples and reset correctly.Finisher staple fault024-976

Check staples and reset correctly.Finisher staple feeding is not
ready

024-977

Check staples and reset correctly.Booklet Maker Finisher staple
operation is not ready

024-978, 024-989

Check staples. Remove and replace the
staple cartridge.

The staple cartridge is empty024-979

Remove all paper from the stacker tray.The stacker tay is full024-980

Remove all paper from the Finisher top
tray.

The top tray is full024-981

Remove all paper from the stacker tray
and remove any other obstructions.

The Finisher stacker tray
lower safety warning is on

024-982

Remove all paper from the Booklet tray.The Finisher Booklet tray is
full

024-983

Remove all paper from the Booklet tray.The Booklet stapler low staple
signal is on

024-984, 024-985

Remove all paper fromthe tray. Set the
output tray for three-fold. Check that the
folder tray is correctly attached and set.

The Booklet folder tray is full024-987, 024-988

Power Off/On the press. Resend the print
job if needed. If fault persists, contact
Customer Support Center.

A communication error has
occurred with the Finisher

047-320

Remove and empty the waste container
and then reinstall it completely.

The Punch Waste Container
is full or near full

112-700

Confirm the staple position and try to
print again.

The settings for stapling are
canceled and prints the data

116-790

Confirm the punching position and try to
print again.

The settings for punching are
canceled

124-705

Confirm the folding settings and try to
print again.

The settings for folding are
canceled

124-706
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Recommended solutionPossible causeFault code

Decrease the number of pages, or cancel
the stapling settings. Resend the print job.

The number of pages exceeds
the number of pages that can
be stapled

124-709

Jam Clearance in the Standard / Booklet Maker Finisher

Paper Jams in the Post-Process Inserter (Tray 8 / T1)
1. Press the Cover button.

2. Open cover 1e and then remove the jammed paper and all paper loaded in the tray.

Note
If paper is torn, check inside the machine and remove it.

3. Fan the paper you removed, making sure that all four corners are neatly aligned, and
then load them again.

4. Push cover 1e until you hear it click into place.
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Note
A message is displayed and the machine does not operate if the cover is open even
slightly.

Paper Jams at Finisher Top Tray
1. Make sure that the machine has stopped printing.
2. Remove jammed paper from the finisher top tray.

Note
If paper is torn, check inside the machine and remove it.

3. Open and close the finisher right cover.

Note
The machine will not operate if the cover is open even slightly.

Paper Jams at Finisher Stacker Tray
1. Make sure that the machine has stopped printing.
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2. Remove jammed paper from the finisher stacker tray.

Note
If paper is torn, check inside the machine and remove it.

3. Open and close the finisher right cover.

Note
The machine will not operate if the cover is open even slightly.

Paper Jams at the Optional Booklet Maker Tray
1. Make sure that the machine has stopped printing.
2. Open the right cover on the finisher.
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3. Turn knob 4a and remove any jammed paper from the optional booklet maker tray.

Note
If paper is torn, check inside the machine and remove it.

4. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Paper Jams at Lever 1a and Knob 1c
1. Make sure that the machine has stopped printing.
2. Open the finisher left cover.

3. Move lever 1a downward and turn knob 1c left. Remove the jammed paper.
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Note
If paper is torn, check inside the machine and remove it.

4. Return lever 1a to the original position.

5. Close the finisher left cover completely.

Note
The machine will not operate if the cover is open even slightly.

Paper Jams at Lever 1d
1. Make sure that the machine has stopped printing.
2. Open the finisher left cover.

3. Move lever 1d upwards and remove the jammed paper.
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Note
If paper is torn, check inside the machine and remove it.

4. Move the lever 1d to the original position.

5. Close the finisher left cover completely.

Note
The machine will not operate if the cover is open even slightly.

Paper Jams at Lever 1b
1. Make sure that the machine has stopped printing.
2. Open the finisher left cover.

3. Move the lever 1b to the right and remove the jammed paper.
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Note
If paper is torn, check inside the machine and remove it.

4. Move the lever 1b to the original position.

5. Close the finisher left cover completely.

Note
The machine will not operate if the cover is open even slightly.

Paper Jams at Lever 3b and 3d
1. Make sure that the machine has stopped printing.
2. Open the right cover on the finisher.

3. Move the levers 3b and 3d; remove the jammed paper.
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Note
If paper is torn, check inside the machine and remove it.

4. Return the levers 3b and 3d to their original positions.

5. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Paper Jams at Lever 3e and Knob 3c
1. Make sure that the machine has stopped printing.
2. Open the right cover on the finisher.

3. Move the lever 3e and turn the knob 3c; remove the jammed paper.
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Note
If paper is torn, check inside the machine and remove it.

4. Return the lever 3e its original position.

5. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Paper Jams at Lever 3g and Knob 3f
1. Make sure that the machine has stopped printing.
2. Open the right cover on the finisher.

3. Move the lever 3g and turn the knob 3f and remove the jammed paper.
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Note
If paper is torn, check inside the machine and remove it.

4. Return the lever 3g to its original position.

5. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Paper Jams at Lever 4b and Knob 3a
1. Make sure that the machine has stopped printing.
2. Open the right cover on the finisher.

3. Move the lever 4b and turn the knob 3a; remove the jammed paper.
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Note
If paper is torn, check inside the machine and remove it.

4. Return the lever 4b to its original position.

5. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Paper Jams at the Optional C / Z Folder

Paper Jams at Lever 2a and Knob 3a
1. Make sure that the machine has stopped printing.
2. Open the right cover on the finisher.

3. Move the lever 2a and turn the knob 3a; remove the jammed paper.
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Note
If paper is torn, check inside the machine and remove it.

4. Return the lever 2a to its original position.

5. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Paper Jams at Lever 2b and Knob 2c
1. Make sure that the machine has stopped printing.
2. Open the right cover on the finisher.

3. Move the lever 2b and turn the knob 2c; remove the jammed paper.
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Note
If paper is torn, check inside the machine and remove it.

4. Return the lever 2b to its original position.

5. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Paper Jams at 2c, 2e, 2f, and 2d
1. Make sure that the machine has stopped printing.
2. Open the right cover on the finisher.

3. Pull out the folder output tray ( 2d), swing lever 2e/2f to the right, and remove the
jammed paper.
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Note
If paper is torn, check inside the machine and remove it.

4. If you cannot remove the paper, return the lever 2e/2f to its original position. Swing
the lever 2e/2f, turn the knob 2c to the right, and remove the jammed paper.

Note
If paper is torn, check inside the machine and remove it.

5. Return the opened lever ( 2f) or ( 2e) to its original position, and close the output
tray ( 2d).

6. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Paper Jams at 2d and Lever 2g
1. Make sure that the machine has stopped printing.
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2. Open the right cover on the finisher.

3. Pull out the folder output tray ( 2d), swing lever the 2g, and remove the jammed
paper.

Note
If paper is torn, check inside the machine and remove it.

4. Return the opened lever ( 2g) to its original position, and close the output tray ( 2d).

5. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Paper Jams at Unit 4 and Knob 4a
1. Make sure that the machine has stopped printing.
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2. Open the right cover on the finisher.

3. Pull out unit 4.

4. Turn the knob 4a to remove the jammed paper from the left side of unit 4.

Note
If paper is torn, check inside the machine and remove it.

5. Return unit 4 to its original position.
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6. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Stapler Faults

Stapler Faults Overview

Follow the procedures provided when the output is not stapled or the staples are bent.
Contact our Customer Support Center if the problem persists after you have tried the
following solutions. Stapler faults on output may look similar to the ones shown in the
following illustration.

1. No staple

2. Bent staple

3. One side of staple rising up

4. Staple bent in reverse direction

5. Flattened staple

6. Entire staple rising up

7. Staple rising up with the center pressed in

If the output is stapled as shown in the figure above, contact our Customer Support
Center.

Note
Depending on the type of paper that is being stapled, the stapled nails may be bent. If
the bent nails are stuck inside the machine, they may eventually cause paper jams.
Remove the bent staple when opening the staple cartridge cover. If you do not remove
the bent staple, a staple jam may occur as a result. Use the staple cartridge cover only
when removing the bent staple.
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Staple Jams in the Standard Staple Cartridge
Note
Always check inside the finisher for any individual staples or staple remnants.

1. Make sure that the machine has stopped printing.
2. Open the right cover on the finisher.

3. Grasp the Staple Cartridge handle located at R1, and pull out the staple cartridge
from the finisher.

4. Check the inside of the finisher for any remaining staples, and if necessary, remove
them.

5. Open the staple cartridge unit as shown and remove the jammed staple.

Warning
To avoid injury to your fingers, carefully remove the jammed staples from the
cartridge.
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6. Reinstall the cartridge unit to its original position in the finisher.

7. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Staple Jams in the Booklet Maker Cartridge
Note
Always check inside the finisher for any individual staples or staple remnants.

1. Make sure that the machine has stopped printing.
2. Open the right cover on the finisher.
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3. While pressing the lever to the right, pull out the booklet staple cartridge unit.

4. Hold the tabs of the staple cartridge unit by the tabs and lift to remove it.

5. Remove the jammed staples from the cartridge.

Warning
To avoid injury to your fingers, carefully remove the jammed staples from the
cartridge.

6. While holding the tabs of a new staple cartridge, push it into the unit.
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7. Push the staple cartridge unit to its original position in the machine.

8. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Reinserting the Standard Staple Cartridge

Use this procedure if the standard staple cartridge is inserted incorrectly into the machine.

Note
Always check inside the finisher for any individual staples or staple remnants.

1. Make sure that the machine has stopped printing.
2. Open the right cover on the finisher.
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3. Grasp the Staple Cartridge handle located at R1, and pull out the staple cartridge
from the finisher.

4. If necessary, open the staple cartridge unit as shown and remove the jammed staple.

5. Move the lever on the rear of the staple cartridge unit in the downward direction.

6. While holding the lever down, turn over the unit and remove the staple cartridge from
the unit.
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7. Detach the outside staples along the line.

8. Push a new staple cartridge into the unit.

9. Reinstall the cartridge unit to its original position in the finisher.

10. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.
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Specifications for the Standard Finisher /
Booklet Maker Finisher

Standard / Booklet Maker Finisher Specifications

SpecificationItem

• Top Tray: Collated / Uncollated

Note
Transparencies can be sent to the TOP tray of the finisher ONLY.
Transparencies cannot be sent to the stacker (middle) tray.

• Stacker (middle) Tray: Collated / Uncollated (Offset available)

Tray Type

Top Tray:

• Maximum: SRA3, 13 x19 in., 12.6 x19.2 in., 330 x 488 mm (custom
size)

• Minimum: 100 x 148 mm (SEF), 4 x 6 in. (SEF), A6 (SEF) postcards

Stacker (middle) Tray:

• Maximum: 13 x 19 in. (330 x 488 mm), SRA3
• Minimum: B5, Executive (7.25 x 10.5 in.)

Optional C / Z Folder tray: Supports A4 (SEF) and 8.5 x 11 in. (SEF)
Delivery to a supported third-party, DFA device:

• Maximum: 13 x 19 in., SRA3
• Minimum: B5, Executive (7.25 x 10.5 in.)

Supported Paper Size

Trays:

• Top Tray: 55-350 gsm coated and uncoated
• Stacker (middle) Tray: 55-300 gsm
• Optional C / Z Folder tray: 64-90 gsm

Delivery to a supported third-party, DFA device: 55-350 gsm

Supported Paper Weight

• Top Tray: 500 sheets
• Stacker (middle) Tray: 2,000 sheets, 200 sets*
• Optional C / Z Folder tray: Minimum 30 sheets

*When using A4 LEF, B5 LEF, 8.5 x 11 in. LEF, 8 x 10 in. LEF, 7.5 x 10.5
in. LEF only. When using paper of other sizes, tray capacity is 1,500
sheets and 100 sets.
**Tray may not support some paper types.

Tray Capacity
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SpecificationItem

Maximum staple sheets: 100 sheets

• When using paper of size larger than A4 or 8.5 x 11 in., the max-
imum number of sheets that can be stapled is 65.

• Staple nails may bend when using certain paper types.

Paper size:

• Maximum: A3 / 11 x 17 in.
• Minimum: B5, Executive (7.25 x 10.5 in.)

Staple position:

• 1 location: (front: angled stapling, center: parallel stapling, back:
parallel stapling*)

• 2 locations: (parallel stapling)
• 4 locations: A4 (LEF) and 8.5 x 11 in. (LEF) parallel stapling

*: Angled stapling for A3 and A4

Stapling (variable length)

Supported paper size:

• Maximum: A3 / 11 x 17 in.
• Minimum: B5 LEF (2 holes), A4 LEF (4 holes)

Number of holes: 2 and 3 (NA), 2 and 4 (Europe)
Paper type: 55-220 gsm

Hole Punching
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SpecificationItem

Maximum number of sheets:

• Fold and Staple: 25 sheets
• Fold only: 5 sheets

When using Xerox 20 lb. / 75 gsm paper, only 14 sheets can be
stapled if adding a cover.
Paper size:

• Maximum: A3, 13 x 18 in.
• Minimum: A4 SEF, 8.5 x 11 in. SEF

Note
When using light-weight stocks, media jams may occur with Booklet
Creation, Single Fold, and stapling for output that is 25 sheets or
more. If media jams do occur, it is recommended that a different
media type is selected for the job.

Paper type: Fold only or Fold and Staple: 55-350gsm uncoated, 106-
300gsm coated
Paper Weights / Booklet Capacity:

• 64-80 gsm, Uncoated: 25 sheets
• 81-90 gsm, Uncoated: 20 sheets
• 91-105 gsm, Uncoated: 10 sheets
• 106-128 gsm, Uncoated: 10 sheets, Coated: 10 sheets
• 129-150 gsm, Uncoated: 10 sheets, Coated: 10 sheets
• 151-176 gsm, Uncoated: 10 sheets, Coated: 10 sheets
• 177-220 gsm, Uncoated: 5 sheets, Coated: 5 sheets
• 221-256 gsm, 4 sheets max. coated or uncoated
• 257-350 gsm, 3 sheets max, coated or uncoated

Booklet Creation / Single
Fold

Note
Non-stapled fold sets are limited to 5 sheets of paper.

Folding

Paper size:

• Maximum: A3 / 11 x 17 in.
• Minimum: B5, Executive (7.25 x 10.5 in.)

The press does not print on paper loaded in Tray 8 / T1.
Capacity: 200 sheets when using Xerox 20 lb. / 75 gsm paper.
Paper type: 64-220 gsm

Tray 8 / T1 (Post-Process
Inserter; also called Inter-
poser)
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C / Z Folder Specifications

SpecificationItem

• Z-paper size: 11 x 17 in. / A3, 10 x 14 in. / B4, 8K
• Capacity:

- Maximum: 80 sheets (A3 / 11 x 17 in. Xerox 20 lb. / 75 gsm
paper Z folding)

- 20 sheets for 8K and 10 x 14 in./B4

• Paper type: 16-24 lb. / 64-90 gsm
• Output tray: Stacker (middle) tray

Z-Fold Half Sheet

• Paper size: A4 / 8.5 x 11 in.
• Number of sheets to be folded: 1 sheet
• Capacity: Minimum 30 sheets (When using Xerox 20 lb. / 75 gsm

paper.)
• Paper type: 16-24 lb. / 64-90 gsm
• Output tray: C / Z Folder tray

C-Fold
Z-Fold

Refer to Booklet Creation / Single Fold specifications for more inform-
ation

Single Fold
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24
Standard Finisher Plus

Standard Finisher Plus Introduction
The Standard Finisher Plus acts as a communication device and provides a paper path
between the press and any third-party, Document Finishing Architecture (DFA) device
that is attached to the press.

Note
The Standard Finisher Plus requires either Interface Module or the Interface Cooling
Module.

The Standard Finisher Plus provides the same features as the Standard Finisher with up
to 2,000 sheet stacking capacity and includes a Finishing Transport Module. The Transport
Module enables connectivity to third-party, Document Finishing Architecture (DFA)
in-line finishing options.

Standard Finisher Plus Components

Standard Finisher Plus Main Components
Note
The Standard Finisher Plus requires either the Interface Module or the Interface Cooling
Module.

The Standard Finisher Plus consists of these two modules:

1 Finisher Module

Output prints are fed from the press through the output path to the Finisher Module.
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2 Finishing Transport

The Finishing Transport serves as an interface to transfer paper from the Finisher
Module to the attached third-party output device. The Finishing Transport moves the
paper from the Finisher Module to one of the three Finishing Transport exits. The height
of the paper entry on the third-party, DFA device must align with the Finishing Transport
Exit 1 or Exit 2.

Finisher Module

Finisher Module Main Components

The Finisher Module includes the following components:

1 Finisher Module

Output prints are fed from the press through the required Interface Module or Interface
Cooling Module to the Finisher Module which then feeds the prints to the Finishing
Transport for delivery to a third-party output device.

The optional C / Z Folder is also shown in the illustration.

2 Post-process Inserter (Tray 8 / T1)

This tray is standard on the finisher and is used to load preprinted stock (SEF or LEF)
as separators and covers that will be inserted into the printed output. Paper loaded in
this tray is not printed on. The tray holds up to 200 sheets when using 20 lb. / 75 gsm
paper.

3 Punch Scrap Container

Collects the scraps from the puncher. Open to remove the scraps.

4 Standard Staple Cartridge

Contains staples. Remove this cartridge to replace staples and clear staple jams.

5 Staple Waste Container

Container for staple waste. Remove this container when full.
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6 Top Tray

The Top Tray is used for stacked output and can receive up to 500 sheets of 20 lb. /
80 gsm paper. Prints are delivered here when specific output features are selected,
such as Automatic sorting, Collated, Uncollated or Normal.

7 Stacker (middle) Tray

The Stacker Tray is used for offset and/or stapled output. It holds up to 2,000 sheets
of 20 lb. / 80 gsm paper. This tray also receives prints when you punch and Z fold. As
an option, both the Top Tray and Stacker Tray can be used for hole punched output.

8 Right Cover

Open to clear paper jams, replace staples, clear jammed staples or remove the scraps
from the puncher.

9 C / Z Fold Output Tray (optional)

The optional Folder Tray receives prints when you select C folding or Z folding of 8.5
x 11 in. / A4 output and 11 x 17 in. / A3 media.

10 Left Cover

Open this cover to access the machine and to clear paper jams.

Folding Feature and Types

For information on the Folding refer to Folding Feature and Fold Types.

Post-Process Inserter (Tray 8 / T1)

For information on the loading media in the Post-Process Inserter (Tray 8 / T1), refer to
Loading Paper / Tabs in the Post-Process Inserter (Tray 8 / T1).

Finishing Transport

Finishing Transport Main Components

The Finishing Transport is comprised of the following components:
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FunctionComponentNo.

The Finishing Transport serves as an interface to
transfer paper from the Finisher Module and the at-
tached third-party output device.

Finishing Transport1

This display indicates the status of the Finishing
Transport and shows the locations of any paper jams.

Finishing Transport status display2

Open to clear paper jams and clean the paper path
areas.

Finishing Transport front door3
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Finishing Transport Status Indicators

The mimic display indicates the status of the Finishing Transport and the location of
the paper jams.

ReasonStatusLED ColorLocation

The Finishing Transport power is on and
functioning properly.

ONGreenPower indicator

The Finishing Transport power is off.OFF

May be one of the following:

• Paper jam indication
• Open front door

ONRedFault indicator

Paper jam in Area 1ONRedArea 1

Paper jam in Area 2ONRedArea 2

Paper jam in Area 3ONRedArea 3

Paper jam in Area 4ONRedArea 4

Standard Finisher Plus Maintenance

Consumable Supplies for the Standard Finisher Plus

Xerox supplies, paper, and throughput material can be ordered from Xerox by going to
www.xerox.com.
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Store supply items and Xerox parts in their original packages in a convenient location.

Supply Unit Shipped with finisher/Reorder QuantitySupply Item

4 staple cartridges (5000 staples per cartridge) and 1 staple
waste container per carton

Standard Staple Cartridge and
Staple Waste Container

Finisher Module Maintenance Procedures

For detailed instructions on maintaining the Finisher Module, refer to the following
procedures:

• Replacing the Standard Staple Cartridge
• Replacing the Staple Waste Container
• Emptying the Punch Waste Container

Standard Finisher Plus Problem Solving

Standard Finisher Plus Fault Codes

Recommended SolutionPossible CauseFault Code

1. Check for any obstructions or
paper jams in the Finishing
Module and Finishing Transport
paper paths and clear them.

2. If necessary, power Off / On the
press and rescan or resend your
job.

3. If the fault persists, contact the
Customer Support Center.

The sensor or exit sensor in the
Finishing Transport did not
switch ON or did not switch OFF
within a specified amount of
time

013-108 to 013-110

1. Check for any obstructions or
paper jams in the Finishing
Module and Finishing Transport
paper paths and clear them.

2. If necessary, power Off / On the
press and rescan or resend your
job.

3. If the fault persists, contact the
Customer Support Center.

Paper jam at the transport
sensor or exit sensor (Finishing
Transport)

013-910, 013-911
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Recommended SolutionPossible CauseFault Code

1. Check for any obstructions or
paper jams in the Finishing
Module and Finishing Transport
paper paths and clear them.

2. If necessary, power Off / On the
press and rescan or resend your
job.

3. If the fault persists, contact the
Customer Support Center.

Paper jam051-100 to 051-111,
051-900

Power Off / On the press and resend /
rescan the job. If the fault persists, con-
tact the Customer Support Center.

Registration clutch solenoid
fault

051-210

Power Off / On the press and resend /
rescan the job. If the fault persists, con-
tact the Customer Support Center.

Diverter solenoid fault051-211

Close the front door of the Finishing
Transport.

Finishing Transport front door
is open

051-300

Power Off / On the press and resend /
rescan the job. If the fault persists, con-
tact the Customer Support Center.

Finishing Transport firmware
fault upgrade

051-310

1. Refer to the DFA device user
documentation and follow in-
structions to bring the device
back online.

2. Power Off / On the press and re-
send / rescan the job.

3. If the fault persists, contact the
Customer Support Center.

Either the DFA device is not
ready or another fault has oc-
curred with it

051-910, 051-911

Refer to the DFA device user document-
ation and follow instructions on how to
clear the fault and replenish the supplies.

The DFA device is either full or
out of supplies

051-912

1. Refer to the DFA device user
documentation and follow in-
structions on how to clear the
fault.

2. Set or change the profile value
(refer to the DFA user document-
ation).

3. Power Off / On the press and re-
send / rescan the job.

4. If the fault persists, contact the
Customer Support Center.

Paper jam in the DFA device051-913, 051-914,
051-915
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Paper Jam Procedures for the Finisher Module

Paper Jams in the Finisher Module

For detailed instructions on clearing paper jams in the Finisher Module, refer to the
following procedures:

• Paper Jams in the Post-Process Inserter (Tray 8 / T1)
• Paper Jams at Finisher Top Tray
• Paper Jams at Finisher Stacker Tray
• For paper jams inside the Finisher Left Cover, refer to the following procedures:

- Paper Jams at Lever 1a and Knob 1c
- Paper Jams at Lever 1d
- Paper Jams at Lever 1b

• For paper jams inside the Finisher Right Cover, refer to the following procedures:

- Paper Jams at Lever 3b and 3d
- Paper Jams at Lever 3e and Knob 3c
- Paper Jams at Lever 3g and Knob 3f
- Paper Jams at Lever 4b and Knob 3a

• For paper jams at the optional C / Z Folder, refer to the following procedures:

- Paper Jams at Lever 2a and Knob 3a
- Paper Jams at Lever 2b and Knob 2c
- Paper Jams at 2c, 2e, 2f, and 2d
- Paper Jams in Areas 4b and 4c

• For Standard Stapler jams and faults, refer to the following procedures:

- Stapler Faults Overview
- Staple Jams in the Standard Staple Cartridge

Paper Jams in Areas 4b and 4c
Tip
Always ensure that all paper jams, including any small ripped pieces of paper, are cleared
before proceeding with your print jobs.

1. Make sure that the machine has stopped printing.
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2. Open the right cover on the finisher.

3. Move the levers 4b and 4c; remove the jammed paper.

Note
If paper is torn, check inside the machine and remove it.

4. Return the opened levers (4b and 4c) their original positions.
5. Close the right cover on the finisher.

Note
A message will display and the machine will not operate if the right cover is open
even slightly.

Paper Jams in the Finishing Transport

Paper Jams in Area 1

Remedies differ according to the paper jam location. Follow the instructions displayed
to remove the jammed paper.
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Tip
Always ensure that all paper jams, including any small ripped pieces of paper, are cleared
before proceeding with your print jobs. If paper is torn, check inside the Finishing
Transport and remove it.

1. Open the Finishing Transport front door.

2. Grasp the green handle 1 and gently pull downwards.

3. Remove the jammed paper.

For a paper jam at the exit of the Finisher Module and the entry of the Finishing
Transport, remove it by pulling the paper towards the Finishing Transport.

4. Return the green handle 1 to its original position.
5. Close the Finishing Transport front door.
6. Ensure that the paper jam indication is cleared from the Finishing Transport status

display.
7. Follow the instructions on the UI to restart your print job.
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Paper Jams in Area 2

Remedies differ according to the paper jam location. Follow the instructions displayed
to remove the jammed paper.

Tip
Always ensure that all paper jams, including any small ripped pieces of paper, are cleared
before proceeding with your print jobs. If paper is torn, check inside the Finishing
Transport and remove it.

1. Open the Finishing Transport front door.

2. Grasp the green handle 2 and gently pull down and toward the right.

3. Remove the jammed paper.
4. If necessary, rotate the green knob in the direction shown to remove any jammed

paper in this area.
5. Return the green handle 2 to its original position.
6. Close the Finishing Transport front door.
7. Ensure that the paper jam indication is cleared from the Finishing Transport status

display.
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8. Follow the instructions on the UI to restart your print job.

Paper Jams in Area 3

Remedies differ according to the paper jam location. Follow the instructions displayed
to remove the jammed paper.

Tip
Always ensure that all paper jams, including any small ripped pieces of paper, are cleared
before proceeding with your print jobs. If paper is torn, check inside the Finishing
Transport and remove it.

1. Open the Finishing Transport front door.

2. Grasp the green handle 3 and gently pull toward the left.

3. Remove the jammed paper.
4. Return the green handle 3 to its original position.
5. Close the Finishing Transport front door.
6. Ensure that the paper jam indication is cleared from the Finishing Transport status

display.
7. Follow the instructions on the UI to restart your print job.
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Paper Jams in Area 4

Remedies differ according to the paper jam location. Follow the instructions displayed
to remove the jammed paper.

Tip
Always ensure that all paper jams, including any small ripped pieces of paper, are cleared
before proceeding with your print jobs. If paper is torn, check inside the Finishing
Transport and remove it.

1. Open the Finishing Transport front door.

2. Grasp the green handle 4 and gently pull toward the right.

3. Remove the jammed paper.
4. Check for and remove any jammed paper between the Finishing Transport exit and

the entrance to the attached third-party device.
5. Return the green handle 4 to its original position.
6. Close the Finishing Transport front door.
7. Ensure that the paper jam indication is cleared from the Finishing Transport status

display.
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8. Follow the instructions on the UI to restart your print job.

Standard Finisher Plus Specifications

Finisher Module Specifications

SpecificationItem

• Top Tray: Collated / Uncollated
• Stacker (middle) Tray: Collated / Uncollated (Offset available)

Tray Type

Top Tray:

• Maximum: SRA3, 13 x19 in., 12.6 x19.2 in., 330 x 488 mm (custom
size)

• Minimum: 100 x 148 mm (SEF), 4 x 6 in. (SEF), A6 (SEF) postcards

Stacker (middle) Tray:

• Maximum: 13 x 19 in. (330 x 488 mm), SRA3
• Minimum: B5, Executive (7.25 x 10.5 in.)

Optional C / Z Folder tray: Supports A4 (SEF) and 8.5 x 11 in. (SEF)
Delivery to a supported third-party, DFA device:

• Maximum: 13 x 19 in., SRA3
• Minimum: B5, Executive (7.25 x 10.5 in.)

Supported Paper Size

Trays:

• Top Tray: 55-350 gsm
• Stacker (middle) Tray: 55-300 gsm
• Optional C / Z Folder tray: 64-90 gsm

Delivery to a supported third-party, DFA device: 55-350 gsm

Supported Paper Weight

• Top Tray: 500 sheets
• Stacker (middle) Tray: 2,000 sheets, 200 sets*
• Optional C / Z Folder tray: Minimum 30 sheets

*When using A4 LEF, B5 LEF, 8.5 x 11 in. LEF, 8 x 10 in. LEF, 7.5 x 10.5
in. LEF only. When using paper of other sizes, tray capacity is 1,500
sheets and 100 sets.
**Tray may not support some paper types.

Tray Capacity
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SpecificationItem

Maximum staple sheets: 100 sheets

• When using paper of size larger than A4 or 8.5 x 11 in., the max-
imum number of sheets that can be stapled is 65.

• Staple nails may bend when using certain paper types.

Paper size:

• Maximum: A3 / 11 x 17 in.
• Minimum: B5, Executive (7.25 x 10.5 in.)

Staple position:

• 1 location: (front: angled stapling, center: parallel stapling, back:
parallel stapling*)

• 2 locations: (parallel stapling)
• 4 locations: A4 (LEF) and 8.5 x 11 in. (LEF) parallel stapling

*: Angled stapling for A3 and A4

Stapling (variable length)

Supported paper size:

• Maximum: A3 / 11 x 17 in.
• Minimum: B5 LEF (2 holes), A4 LEF (4 holes)

Number of holes: 2, 4, 3 (optional)
Paper type: 55-220 gsm

Hole Punching
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SpecificationItem

Maximum number of sheets:

• Fold and Staple: 25 sheets
• Fold only: 5 sheets

When using Xerox 20 lb. / 75 gsm paper, only 14 sheets can be
stapled if adding a cover.
Paper size:

• Maximum: A3, 13 x 18 in.
• Minimum: A4 SEF, 8.5 x 11 in. SEF

Note
When using light-weight stocks, media jams may occur with Booklet
Creation, Single Fold, and stapling for output that is 25 sheets or
more. If media jams do occur, it is recommended that a different
media type is selected for the job.

Paper type: Fold only or Fold and Staple: 55-350gsm uncoated, 106-
300gsm coated
Paper Weights / Booklet Capacity:

• 64-80 gsm, Uncoated: 25 sheets
• 81-90 gsm, Uncoated: 20 sheets
• 91-105 gsm, Uncoated: 10 sheets
• 106-128 gsm, Uncoated: 10 sheets, Coated: 10 sheets
• 129-150 gsm, Uncoated: 10 sheets, Coated: 10 sheets
• 151-176 gsm, Uncoated: 10 sheets, Coated: 10 sheets
• 177-220 gsm, Uncoated: 5 sheets, Coated: 5 sheets
• 221-256gsm, 4 sheets max. coated or uncoated
• 257-350gsm, 3 sheets max, coated or uncoated

Booklet Creation/Single
Fold

Note
Non-stapled fold sets are limited to 5 sheets of paper.

Folding

Paper size:

• Maximum: A3 / 11 x 17 in.
• Minimum: B5, Executive (7.25 x 10.5 in.)

The machine does not print on paper loaded in Tray 8 / T1.
Capacity: 200 sheets when using Xerox 20 lb. / 75 gsm paper.
Paper type: 64-220 gsm

Tray 8 / T1 (Post-Process
Inserter; also called Inter-
poser)
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C / Z Folder Specifications

SpecificationItem

• Z-paper size: 11 x 17 in. / A3, 10 x 14 in. / B4, 8K
• Capacity:

- Maximum: 80 sheets (A3 / 11 x 17 in. Xerox 20 lb. / 75 gsm
paper Z folding)

- 20 sheets for 8K and 10 x 14 in. / B4

• Paper type: 16-24 lb. / 64-90 gsm
• Output tray: Stacker (middle) tray

Z-Fold Half Sheet

• Paper size: A4 / 8.5 x 11 in.
• Number of sheets to be folded: 1 sheet
• Capacity: Minimum 30 sheets (When using Xerox 20 lb. / 75 gsm

paper.)
• Paper type: 16-24 lb. / 64-90 gsm
• Output tray: C / Z Folder tray

C-Fold
Z-Fold

Finishing Transport Specifications

SpecificationItem

7.16 x 19.2 in. / 182 x 488 mm, Process direction. Center Registered:
7.16 x 13 in. / 182 x 330.2 mm, Process direction

Paper size

52-350 gsmPaper weight

Transparencies / Coated Paper Stock can be usedTransparencies / Coated
paper

50 to 155 prints per minute (ppm)Speed
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